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Chapter 1 EX ROVR Overview

1.1 Introducing EX ROVR

The EX ROVR Robotic System for Autonomous Plant Inspection is designed to monitor the interior of plants 
and factories where there is a risk of fire due to handling of flammable materials, such as in oil and gas 
plants. Inspections are performed by the ASCENT autonomous patrol robot, and the resulting data is stored 
in a cloud system for viewing.

GAS

GAS

Cloud System

Factories/Plants
(Zone 1 hazardous areas) 4G/LTE

4G/LTE

Management application

Autonomous patrol robot 
ASCENT

Teleop terminal

z	 Patrol schedule 
management

z	View inspection data

z	View inspection data

z	Teleoperation of ASCENT
z	Patrol area map preparation
z	Patrol action (scenario) preparation

Dashboard

Charging Station

Internet

Non-hazardous areas

EX ROVR is designed to comply with Japanese guidelines for explosion protection and ATEX/IECEx, the 
explosion protection certification widely adopted in Europe and other parts of the world.
	z The system can be used in Zone 1 and Zone 2 hazardous areas where there may be an atmosphere of 
explosive gas or vapor. It cannot be used in Zone 0 hazardous areas.
	z It cannot be used in areas where there may be an explosive atmosphere of combustible or explosive dust 
(e.g., mines).
	z It cannot be used in Group II C explosive gas atmospheres, except for hydrogen gas.
	z In places where radiation levels are extremely high (e.g., disaster sites), there is a risk of malfunction or 
operational failure.
Also, the system is not intended for use in the following locations.
	z Public places where people gather, such as stores, lodging facilities, and parks
	z Hospitals and other medical facilities
	z Residences
	z On board ships or aircraft
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Reference: Classification of Hazardous Areas
Category Description
Zone 0 Places of normal use where a hazardous atmosphere is continuously present, present 

for long periods of time, or frequently present. Applicable locations include places where 
flammable gases are constantly present, such as inside a flammable liquid container or above 
a flammable liquid surface.

Zone 1 Places where a hazardous atmosphere may occur under normal conditions of use. This 
indicates places where flammable gases are not constantly present, but are released under 
certain conditions. This includes places such as the openings of flammable liquid containers, 
where flammable gases are released only during inspection or other work.

Zone 2 Places where hazardous atmospheres are unlikely to be generated under normal conditions 
of use or, if generated, are present for only a short period of time, or where explosive 
atmospheres are only generated under abnormal conditions due to malfunction.
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1.2 System Components and Their Functions

	■ ASCENT patrol robot
Robot that autonomously patrols inside a factory or 
plant to collect internal information. The system provides 
explosion-proof performance so that it cannot cause 
ignition in factories and plants where ignition is a hazard.

	■ Charging Station
Purges, pressurizes and recharges ASCENT.
As with ASCENT, it provides explosion-proof 
performance, and can be installed together with 
ASCENT inside factories and plants.

	■ Teleop terminal
Terminal used to operate ASCENT. Does not have 
explosion-proof construction, and should be used in a 
non-hazardous area separate from the hazardous area 
where the ASCENT and Charging Station are installed.
The terminal provides the following applications.
Teleop software: Used to operate ASCENT remotely.
Scenario Maker: Used to prepare scenarios that define 
patrol routes and inspection actions.

	■ Web application
This application is used to access a cloud system from 
a web browser on a PC or tablet (not included with EX 
ROVR).
Management application: Allows system users to 
make ASCENT autonomous patrol schedules and view 
inspection data.
Dashboard: Used for checking the current position and 
status of ASCENT.
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1.3 Inspection Targets

ASCENT is equipped with multiple optical and thermal imaging cameras, microphones, and gas 
detectors.
The following information can be obtained from each device

Target Device Information obtained
Instruments, etc. Optical 

surveillance 
camera

Video (displays images captured by the 
camera during teleoperation)
Still images (acquired manually or by scenario)

Entire area to be inspected (360°) 360° optical 
camera

Video (displays images captured by the 
camera during teleoperation)
Still images (acquired manually or by scenario)

Any heat source Thermal 
imaging 
camera

Video (displays images captured by the 
camera during teleoperation)
Still images (acquired manually or by scenario)

Sounds Microphone Audio (acquired manually or by scenario)
Gases of the following types in the 
vicinity of ASCENT:
Combustible gases (carbon 
monoxide), hydrogen sulfide, oxygen

Gas detector Measured gas concentrations (always 
displayed on the teleop screen of the teleop 
terminal)

Front

Optical surveillance 
camera

360° optical camera
Thermal imaging camera 
(left)

Front

Thermal imaging camera 
(right)

Gas detector  
(internally housed)Microphone
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	■ Notes on the on-board gas detection function
ASCENT detects four types of gases: oxygen (O2), combustible gas (COMB), hydrogen sulfide (H2S), 
and carbon monoxide (CO).
	z Gas detection results do not guarantee safety within the patrol area.
	z Gases other than those targeted and solvent vapor may also be detected, so please take the 
measurement environment into account.
	z Avoid using the system in the vicinity of silicone sealants, etc., or in a silicone gas atmosphere, as 
this may impair the performance of the equipment.
	z Detection of high concentrations of sulfur dioxide, chlorine, or other gases may shorten sensor life 
and increase errors.
	z Prolonged detection of hydrogen sulfide may shorten sensor life or reduce sensitivity.
	z In locations where variance from the standard atmospheric pressure is great (for example, at 
elevations greater than 1000 m above sea level), gas detector’s oxygen sensor may become unable 
to display accurate values.
	z Because it is calibrated with isobutane, there is reduced sensitivity with respect to other combustible 
gases.
	z Since the gas detector automatically performs AIR adjustment (zero adjustment) upon ASCENT 
startup, the concentration displayed may be incorrect if ASCENT is started up in the presence of 
combustible gas.
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1.4 ASCENT Driving Performance

Driving speed: Max. 1.2 km/h during horizontal travel
Driving time: 1 to 2 hours when fully charged (varies according to operation)
 Time required for full charge: 2 hours

	■ Driving performance on slopes, steps, stairs and ditches

 WARNING

	z Do not drive on steps or slopes that exceed its performance limits.
Accident or damage may result due to tipping or slipping and falling.

During autonomous patrol During teleoperation
Slope Depends on the nature of the inclination (such as the coefficient of friction)

Slope See A on the next page Inclination of 46° or less
Bank Water runoff slope or less (slope 

1/50 to 1/100, or 0.57° to 1.15° in 
angular terms)

Slope for running without tipping 
over is 20° or less.

Stairs Step height: 130 to 220 mm
Step depth: 210 to 310 mm
Step width: 900 mm or greater
For slope, see B on the next page.

Step height: 130 to 220 mm
Step depth: 210 to 310 mm
Step width: 900 mm or greater
Inclination of 46° or less

Landing Capable of navigating landings of the following shapes and dimensions.
U-shaped: Minimum dimensions of 1800 mm (W) x 1000 mm (D)
L-shaped: Minimum dimensions of 1000 mm (W) x 1000 mm (D)
I-shaped: Minimum dimensions of 900 mm (W) x 900 mm (D)

Difference in level Height: 20 cm or less (must have a 
rectangular cross section)

Height: 40 cm or less (depending on 
form)

Ditches Width: Within 15 cm Width: Within 30 cm (depending on 
form)
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15°

46°

22.1°

Slope: Up to 15°

A: Slope that can be navigated during automatic patrol

B: Inclination of stairway that can be navigated during automatic patrol

Step height (mm)

Stairs EX ROVR 
can ascend or 

descend

Stairs 
conforming with 
the Japanese 
Building 
Standards Law

210

220

1 m

130

330
Step depth (mm)

Ramps: Up to 1 m high

	■ Places where driving is not possible
Driving is not possible on ice, sand, fine gravel (less than 5 mm in diameter).
In addition, puddles (2 cm or more deep), snow, weeds that were not present at time of map or route 
setting, and heavy rain or snowfall may make determinination of position difficult, although driving is 
possible.
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1.4.1 Driving route conditions
ASCENT cannot travel through aisles that are narrower than its own external dimensions. Allow 
enough space around ASCENT for a person to stand (approx. 900 mm).

540 mm

1485.2 mm

700 mm
1200 mm

450 mm
900 mm

When turning in an aisle, available area must exceed the total 
length of ASCENT. Allow approximately 900 mm of space as 
shown in the figure on the right.

Approx. 900 mm

800 mm
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Also, be aware of the range of motion of the manipulator. When moving the manipulator, be careful not 
to hit nearby people or objects.

 CAUTION

	z Do not move ASCENT with the manipulator extended.
There is a risk of causing injury to people or damage to objects by hitting them.
Also, vibration may cause the manipulator to malfunction.

Unit: mm

Φ1626

Φ2104

14
58

.2

43
1.

2
43

5
23

9
38

0

11
41

.5
10

4.
7

13
3.

8

1115.3
876.8

977
738

75

1284.1
7004
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1.5 Introduction Sequence and Manual Composition

The EX ROVR introduction sequence is as follows. Refer to the appropriate manuals for tasks and operations 
required for introduction.

 Transportation of the Charging Station 
to the installation place

 Make power and compressed air connections
 Adjust pressure

 Transportation of ASCENT to the 
Charging Station

 Purge, pressurize, and charge 
(putting ASCENT on standby)

 Patrol route considerations
 Floor maintenance
 Stair/step measurement
 Installation of markers

 Teleoperation of ASCENT to 
prepare a map

 Registration of inspection targets
 Registration of stairs and steps

 Patrol route determination
 Determination of inspection target 

actions

 Specification of scenario execution 
schedule

 Patrol result verification from history

 Daily inspection
 Initial inspection
 Semi-annual inspection
 Bi-annual inspection

Charging Station
Installation

Preparing ASCENT

Planning and
maintenance

Map creation

Scenario creation

Patrol schedule
management

Verification of
patrol results

Care and
maintenance

Installation and Setup Manual

Robotic System for Autonomous Plant Inspection

Operation Manual

Robotic System for Autonomous Plant Inspection

Maintenance Manual

Robotic System for Autonomous Plant Inspection

Refer to “Installation and 
Setup Manual”

Refer to “Operation Manual” 
(This Manual)

Refer to “Maintenance 
Manual”
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1.5.1 Intended user
This product has been designed and developed for use by personnel who possess knowledge of 
explosion protection; that is, the knowledge required to work properly in Zone 1 hazardous areas. 
Work should be carried out under the supervision of a safety administrator with whom work details 
have been discussed in advance.

The individual operations and tasks described in the manuals for this product should be undertaken by 
the following users.

	■ Installation and Setup Manual

Installation and Setup Manual

Robotic System for Autonomous Plant Inspection

	z Electrical engineers or workers trained in safety who are familiar with 
the rules, regulations, and standards of the place of installation and 
IEC 60079-17*, if applicable.
	z Workers who have knowledge of explosion protection and are qualified 
to work properly in Zone 1 hazardous areas.

*  One of the standards set by the International Electrotechnical 
Commission, an international standardization organization that 
prepares international standards in the fields of electrical and 
electronic technology. Sets forth the requirements for maintenance and 
inspection of explosion-proof electrical equipment.

	■ Operation Manual

Operation Manual

Robotic System for Autonomous Plant Inspection

Users of ASCENT teleoperation and cloud systems:
	z Workers who can perform basic computer operations.
	z Workers who manage the company network.

On-site workers:
	z Electrical engineers or safety-trained operators who are familiar with 
rules, regulations, and standards of the installation site and IEC 60079-
17, if applicable.
	z Workers who have knowledge of explosion protection and are qualified 
to work properly in Zone 1 hazardous areas.

	■ Maintenance Manual

Maintenance Manual

Robotic System for Autonomous Plant Inspection

	z Electrical engineers or safety-trained operators who are familiar with 
rules, regulations, and standards of the installation site and IEC 60079-
17, if applicable.
	z Workers who have knowledge of explosion protection and are qualified 
to work properly in Zone 1 hazardous areas.
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The precautions presented here are intended to ensure safe and correct use of the equipment and to prevent 
injury to people and damage to property.
These precautions are marked “DANGER”, “WARNING”, “CAUTION”, or “NOTE”, and must be observed.

 DANGER Indicates a hazardous situation which, if handled improperly, presents immediate risk of 
death or serious injury.

 WARNING Indicates a potentially hazardous situation which, if handled improperly, could result in 
death or serious injury.

 CAUTION Indicates a potentially hazardous situation which, if handled improperly, could result in 
injury.

NOTE Indicates a situation which, if handled improperly, could result in equipment failure or 
property damage.

Icon examples
The following symbols are used to denote content that requires your attention (including warnings).

Indicates cautionary information regarding safety.

The following symbols indicate prohibited actions.

Indicates a prohibited action.

Indicates that disassembly is prohibited.

The following symbol indicates a required action.

Indicates a required action.

Chapter 2 Safety Precautions
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 WARNING

Wear protective equipment while doing work near ASCENT or Charging Station, such as 
installation, preparation, and maintenance.
- Helmet
- Appropriate clothing that fits your body
- Safety shoes
- Non-slip gloves
- Protective goggles/glasses (for example, when purging ASCENT or accompanying it)

Do not modify or make repairs yourself.
Failure to maintain safety may lead to accidents.
If repairs are required, contact the manufacturer or a maintenance partner.
This company will not be responsible for any malfunction, damage, or accident caused by 
modification of the software.

Use where ambient temperature is in the range of 0 to 40°C.
Extremely high temperatures may cause the battery to overheat and malfunction. Furthermore, 
battery performance may deteriorate at temperatures below 0 °C.

Do not use replacement parts or accessories other than those recommended by Mitsubishi 
Heavy Industries, Ltd.
Doing so may result in accidents or malfunctions.

Those who use a pacemaker or defibrillator should note the following.
	z Do not allow body parts containing implanted devices to come within 15 cm from the 
ASCENT radio module or teleop terminal.
	z Keep body parts containing implanted devices at least 30 cm away from the contactless 
charging unit while charging is in progress.
	z Keep body parts containing implanted devices away from the magnet-operated power 
switch key.

Radio waves and magnets may adversely affect the operation of electronic medical devices.

In situations where condensation is expected, stop use until it dries out.
Condensation may occur in locations that are subject to rapid changes in temperature, possibly 
causing ASCENT or its Charging Station to malfunction or run out of control. It can also cause gas 
detectors and cameras to malfunction.
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	■ Regarding ASCENT

 DANGER

When ASCENT is traversing stairs, stay away from the bottom of the stairs.
If ASCENT slips and hits you, there is a danger of serious injury, such as broken bones.

 WARNING

Do not disassemble ASCENT.
ASCENT has a pressurized explosion-proof structure. Disassembly or opening of covers may 
compromise the explosion-proof rating, resulting in ignition of flammable gases.

Do not drive ASCENT in areas or during times when there are people or vehicles are being 
operated.
Collision may result in injury or damage.
When creation of a map or scenario is required, have someone accompany ASCENT.

Do not ride ASCENT.
There is a risk of injury from falling or getting your limbs trapped. It may also result in malfunctions.

Do not insert fingers or foreign objects (especially conductive foreign objects or flammable 
foreign objects such as oil) in the crevices of ASCENT (for example, at the base of 
manipulator).
Doing so may result in malfunction or fire.

If you discover that control over ASCENT has been interrupted (if the status LED is flashing 
red), immediately stop and retrieve ASCENT.
If the 3D-LiDAR malfunctions or a software error occurs, control over ASCENT may be lost, 
causing it to go astray.
If a software error is the cause, you may not be able to stop ASCENT from the teleop terminal. In 
this case, taking care with regard to safety, press the emergency stop button on ASCENT.

When transporting ASCENT in the presence of combustible gases without purging (when 
internal pressure is not maintained), lift the tracks so that they do not rotate.
The track generates electricity when turning which may cause a spark and ignite flammable 
gases.

Do not perform the following operations in hazardous areas.
	z Do not power on ASCENT before purging (when internal pressure is not maintained).
	z Do not turn on the power in maintenance mode.
	z When ASCENT is stopped outside the Charging Station (e.g., by pressing the emergency 
stop button), do not power on ASCENT on the spot.

Flammable gases may ignite.

 CAUTION

When ASCENT is powered on (with the status LED lit or flashing), do not touch or approach 
it (except for the purpose of executing an emergency stop).
When the status LED is lit or flashing, there is a possibility that the unit may start moving suddenly 
even though it is stopped. There is risk of injury from being hit or getting one’s hands caught in 
moving parts of the manipulator.

Do not look directly at the laser beam emitted by the 3D-LiDAR and rear obstacle proximity 
sensor or magnify it by a lens or other means.
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NOTE

Avoid exposing the optical surveillance camera or the truck camera to direct sunlight for 
an extended period of time.
Such exposure may cause damage to the photoreceptors.

Keep electrical devices away from the area of ASCENT’s antenna.
There is a risk of electromagnetic interference.

	■ Regarding the Charging Station

 WARNING

Do not disassemble the Charging Station.
If disassembled, the explosion-proof rating may not be maintained, and flammable gases may 
ignite.

Make sure that the flanged flameproof joint plane surface between the Charging Station’s 
control panel lid and the enclosure is not subjected to impact or insertion of foreign matter.
The contact area of the joint surface between the lid and the enclosure is an integral part that 
ensures the performance of the explosion-proof structure. If foreign matter gets inside or the joint 
surface is damaged or distorted, do not operate the system.

Joint surface between lid and enclosure

Make sure to shut off power at the source before opening the control panel lid.
If the lid is opened, explosion-proof performance cannot be maintained, and there is a risk of 
igniting flammable gases if the unit is powered on.
When closing the lid, follow the instructions in “Chapter 5 Charging Station Installation” of 
“Installation and Setup Manual”

Do not touch the Charging Station if it becomes submerged.
There is a risk of electric shock. Turn off the source of electrical supply before touching.

Do not apply excessive force, pull or step on, or excessively bend the power cable.
Doing so may result in damage, heat generation, or fire.

When stepping inside the Charging Station, be careful of the rollers.
There is a risk of injury from falling.

The control panel contains intrinsically safe circuits, so the wiring should not be replaced 
or removed.
Explosion-proof performance may be impaired, possibly leading to ignition of combustible gases.
For information on the explosion-proof construction of the Charging Station, see “Installation and 
Setup Manual”.
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	■ About the teleop terminal

 WARNING

Do not carry the teleop terminal into hazardous areas.
The teleop terminal is not explosion-proof. Carrying it into a hazardous area would present a risk 
of ignition of flammable gases.

Do not disassemble the teleop terminal.
Doing so may result in fire, electric shock, or malfunction.
The notebook computer cannot be removed from the case and used for other purposes.

Do not place containers of water or other liquids or metal objects on the teleop terminal.
If liquid or foreign matter gets inside, turn off the power and unplug the power plug from the outlet.

Do not expose the device to high temperature for a long period of time.
Prolonged exposure to extremely high temperature, such as near a fire or under the hot sun, may 
cause deformation, malfunction or deterioration of internal parts. Using the device in that condition 
may result in a short circuit or insulation failure, which could lead to fire or electric shock.

Do not place the device in any location where there is a lot of water, moisture, steam, dust, 
or oily smoke.
Doing so may result in fire or electric shock.

NOTE
Keep electrical devices away from the area of the teleop terminal’s antenna.
There is a risk of electromagnetic interference.

	■ Regarding the internal batteries of ASCENT and the teleop terminal

 WARNING

Do not remove the battery except for disposal.
Removing the battery in the presence of flammable gases may result in ignition. Further, improper 
battery installation may result in loss of explosion proofing.

If the battery requires replacement, please contact the seller of the product.
Replacing the battery by yourself or using anything other than the designated battery may result in 
malfunction or accident.
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2.1 Warning Labels

Warning labels are attached to the following parts of the system to indicate hazards or warnings.

Charging Station
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ASCENT

Warning labels Description
This symbol indicates that there is a burn hazard due to high-temperature parts. Be 
sure to confirm that all parts are at a safe temperature.

This symbol indicates electrical danger, such as risk of electrical shock or burns. The 
power supply must be disconnected.
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3.1 ASCENT

	■ Top left front view (with sub track lowered)

LED lighting

Optical surveillance 
camera

360° optical camera

3D-LiDAR
(laser range finder)

Sub track (front)

Manipulator hand

6 degree-of-freedom 
manipulator

Thermal imaging camera 
(left)

Power-on section

	■ Top left front view (with sub track raised)

Main track

Truck camera 
(front)
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	■ Top right rear view

Sub track (rear)

Truck camera 
(rear)

Microphone and speaker

Rear obstacle proximity 
sensor

Thermal imaging 
camera (right)

Relief valve
(Inside enclosure)

Wireless 
antennas
(Wi-Fi, LTE)

Protective gas 
filler port

Contactless 
power reception 
unit

Mode selector switch
(Maintenance mode/Run mode)

Regulator

Exhaust port

Gas detector

Torque off button

Emergency stop button

Status LED
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	■ Status LED indications and their meanings

Status LED color Status LED state Description
Red Lit ASCENT powered on in one of the following 

states.
	y Standby mode
	y Self-check in progress
	y Preparing for power shut-down

Flashing An anomaly has occurred, and one of the 
following conditions is present.
	y Uncontrolled state (fatal anomaly)
	y Standby (not controlled)

Green Flashing Operating under control of teleop terminal.
Blue Flashing Scenario running.
Yellow Flashing Charging.

Lit Charging stopped (fully charged).
Or, entering/exiting Charging Station.

Extinguished ASCENT power is off.

	■ Explosion-proof structure of ASCENT
ASCENT has explosion-proof construction in its main body and individual parts. For details on 
explosion proofing, see “Installation and Setup Manual”.

LED lighting:
Ex d (Flameproof enclosure)

Optical surveillance camera:
Ex d (Flameproof enclosure)

Enclosure:
Ex p (Pressurized enclosure)

Gas detector:
Ex i (Intrinsically safe)

Lithium-ion battery:
Ex d (Flameproof 
enclosure)

Microphone and speaker:
Ex d (Flameproof 
enclosure)
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	■ Information regarding ASCENT’s Class 1 laser
Lasers are emitted from ASCENT’s 3D-LiDAR and rear obstacle proximity sensor.

3D-LiDAR Rear 
obstacle 
proximity 
sensor

The laser complies with 21CFR1040.10 and 1040.11 and IEC 60825-1.
Caution: Use of the product in any manner other than that described in the instruction manual or repair 
or disassembly by yourself may result in exposure to hazardous laser radiation.
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3.2 Charging Station

	■ View from front upper right

RUNNING lamp
PURGING lamp

POWER switch 
(ON/OFF)

MODE switch  
(RUN/PURGE)

CHARGING lamp

PRESSURIZING 
lamp

3PI1/Exhaust pressure

2V5/Purge flow rate control valve

3V1/Exhaust pressure regulator

2V2/Purge pressure regulator

3V2/Exhaust open valve
Close/Open

2V4/Supply valve
Normal operation/Purge

2PI2/Purge supply pressure

1PI1/Supply pressure

1V2/Supply flow control valve

1V1/Supply pressure regulator

Air supply port

5PI1/Operation check jig 
pressure

5V1/Pressure supply valve for 
operation check jig

Supply/Close
5V2/Supply pressure regulator for 
operation check jig

Control panel

Pneumatics panel
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	■ View from front upper left

Stopper

Auto oiler

Exhaust hose

Entry/Exit guide plate

Cylinder

Protective gas supply 
port

Contactless power 
transmission section

	■ Lamp indications and their meanings

Lamp State Description
CHARGING lamp Flashing (0.5 sec. lit, 0.5 sec. off) Charging

Lit Charging completed
Rapid flashing (0.2 sec. lit, 0.2 sec. off) Charging error

PRESSURIZING lamp Flashing (0.5 sec. lit, 0.5 sec. off) Pressurizing
Lit Pressurization completed
Rapid flashing (0.2 sec. lit, 0.2 sec. off) Pressurization error

PURGING lamp Flashing (0.5 sec. lit, 0.5 sec. off) Purging in progress in purging mode
Lit Standby with purging completed
Rapid flashing (0.2 sec. lit, 0.2 sec. off) Standing by for purging initiation 

(error)
Slow flashing (1 sec. lit, 1 sec. off) Purging completed

RUNNING lamp Lit Normal
Rapid flashing (0.2 sec. lit, 0.2 sec. off) Cylinder positioning error
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	■ Explosion-proof structure of the Charging Station
The Charging Station has explosion-proof construction in its main body and individual parts. For 
details on explosion proofing, see “Installation and Setup Manual”.

Pressure switch barrier
Ex i (Intrinsically safe)

Control panel:
Ex d (Flameproof enclosure)

Limit switch
Ex d (Flameproof enclosure)

Pressure switch

Solenoid:
Ex e m (Increased safety, 
Encapsulation)

Power feed coil case:
Ex d (Flameproof enclosure)

Auto oiler:
Ex i (Intrinsically safe)
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3.3 Teleop Terminal

The teleop terminal is housed in a dedicated case.

Notebook computerExternal monitor (optional) 4G/LTE antennas

Indicators

Power 
jack

Gamepad Power 
switch

	■ Case
The pockets on the cover of the case can be used for storage of a mouse and cables.
Remove the cover from the case when using the teleop terminal. See page 6-2 for details.
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Wireless 
mouse

HDMI cable 
(optional)

USB cable 
(optional)

Power supply 
cable

	■ External monitor (optional)
The following cables are provided when the optional external monitor is included at the time of 
purchase.
	z HDMI cable: Connects to the notebook PC.
	z USB cable: Used as a power cable for the external monitor.

	■ Items contained in the case
The following items are contained in the case. These can all be used without removing them from the 
case.
	z AC adapter for notebook computer
	z LTE router
	z AC adapter for LTE router
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3.4 Bundled Accessories and Options

3.4.1 Bundled accessories
	z Magnet-operated power switch key (1) 	z Mode selector key (2)

	z Positioning marker (10) 	z Heat source teaching marker (1)

	z Tool for checking internal pressure monitoring interlock (1)
	z 2S-V socket (1)
	z Installation and Setup Manual (1)
	z Operation Manual (This Manual) (1)
	z Maintenance Manual (1)

 WARNING

	z Do not carry the magnet-operated power switch key or place it near electrical 
equipment.
Its magnetic field may cause malfunction or failure of electrical equipment. When not in use, 
be sure to return it to its stowage position.
	z The mode selector keys should be properly stored by the administrator so that they 
cannot be taken without permission.
Improper key management can result in unavailability of the keys at the time they are needed 
and may lead to accidents.
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When not in use, the magnet-operated power switch key can be mounted on the side of the Charging 
Station in the position shown below.

3.4.2 Options
The following are available as options. Please contact your distributor for information on obtaining or 
installing these after purchase.
	z Marker
	z Teleop terminal external monitor

3.4.3 Consumables
Please contact your distributor for information on obtaining or installing these.

Target Consumables
Charging Station Grease for auto oiler

Element for air filter
ASCENT Battery

Filter for gas detector
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4.1 Driving and Inspection Flow

With ASCENT in standby state, it can be ready to run for factory/plant inspection.
A map is first created by ASCENT, to which inspection targets and a driving route are then added to create 
a “scenario”. Once an execution schedule is set for the scenario, ASCENT automatically patrols the factory/
plant and checks the inspection targets.

C
reating a Scenario

 Checking the inspection floor and inspection targets
 Determining the patrol area, inspection targets, and patrol 

route

 Stairs and floor maintenance
 Stairs and step measurements
 Stair marker installation

 Teleop terminal preparation
 Launch Scenario Maker

 Drive the patrol area by teleoperating ASCENT
(An attendant accompanies ASCENT)

 Create a map with ASCENT's 3D-LiDAR

 Open the created map with Scenario Maker
 Register the inspection targets and stairs/steps
 Register the driving route between the inspection targets by 

teleoperating ASCENT (An attendant accompanies ASCENT)
 Specify inspection operations

 Set the scenario execution date and time in the cloud

 Patrol result verification from history

 Check on the dashboard

Planning

Floor maintenance

Launch Scenario
Maker

Map creation

Scenario creation

Schedule settings

Automatic patrol

Verification of
patrol results

 “Chapter 5 Planning and Maintenance” (page 5-1)

 “Chapter 5 Planning and Maintenance” (page 5-1)

 “Chapter 6 Teleop Terminals” (page 6-1)

 “Chapter 8 Creating a Map” (page 8-1)

 “Chapter 9 Creating a Scenario” (page 9-1)

 “Chapter 10 Registering a Schedule” (page 10-1)

 “Chapter 7 Creating a Simple Scenario” (page 7-1)

 “Chapter 11 Auto Patrol” (page 11-1)

 “Chapter 12 Checking Inspection Results” (page 12-1)
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4.1.1 What is a scenario?
Based on the map of the inside the factory/plant created by ASCENT under teleoperation using its 
on-board 3D LiDAR, inspection targets, stairs, and steps are registered, and the patrol route and 
inspection operations are specified while the ASCENT is teleoperated in the same way as when 
creating the map.

GAS

GAS

GAS

GAS

GAS

GAS

Scenario

Patrol Route

Inspection Targets and 
Stairs/Steps

Map*

* Created with ASCENT’s 3D LiDAR
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4.1.2 Software Used

	■ When creating a scenario
Run Scenario Maker installed on the teleop terminal. The Teleop screen for manually operating 
ASCENT is launched at the same time.

Teleop terminal Scenario Maker

Scenario Maker Teleop screen

	■ When viewing inspection data
Access the cloud using a Web browser.

PC or tablet Web browser Management application Dashboard
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4.2 ASCENT Teleoperator And Attendants

ASCENT teleoperation requires personnel in the following roles:
	z One person (teleoperator) to manually control ASCENT using the Teleop terminal
	z Persons (attendants) who accompany ASCENT at the site during teleoperation

When creating the map of the patrol area with ASCENT and registering the patrol route in the 
scenario, the teleoperator manually controls ASCENT using the Teleop terminal, while attendants 
continually accompany ASCENT during teleoperation. The attendants have the role of informing the 
teleoperator of ASCENT’s situation at the site and stopping ASCENT in the event of an emergency or 
potential emergency.

In accordance with the national industrial safety and health regulations of each country, the employer 
should give appropriate instructions and training to personnel (teleoperators and attendants).
ASCENT should always be accompanied by an attendant when creating the map of the patrol area 
and when registering the patrol route in the scenario.
Attendants should stay away from ASCENT as much as possible. When necessary to work near 
ASCENT, establish and comply with work rules to avoid danger from unexpected or erroneous 
operation of ASCENT. These work rules should include the following items:
	z ASCENT operating methods and procedures (personnel identification, suspension of obstacle 
detection functions, and etc.)
	z Operating ASCENT and manipulator speed
	z How to signal when starting operations with multiple personnel (attendants and teleoperator, etc.)
	z Abnormality countermeasures
	z ASCENT restarting measures after stopping due to an abnormality
	z Measures to prevent danger due to erroneous operation
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4.2.1 Attendants’ tasks and precautions

 WARNING

	z Attendants accompanying ASCENT shall wear protective equipment (helmet, safety 
shoes, non-slip gloves, protective goggles, etc.).
Injury could result if ASCENT is bumped and tips over, or if fingers are caught in moving parts. 
Also be aware of the range of motion of the manipulator.
	z Attendants should not wear reflective clothing or other reflective materials.
ASCENT may falsely detect them as stairs or obstacles.

	■ Points to be confirmed by an on-site attendant
An attendant confirms the situation of ASCENT and the site while paying attention to the following 
points, and informs the teleoperator of the situation.
	z When driving ASCENT on floor grating, do the grousers on the main tracks or sub tracks get caught 
in the grating?
	z Is slippage occurring while going up and down stairs, and is motion perpendicular to the stairs (or 
going up or down diagonally)?
	z Driving floor condition
	z The presence or absence of driving route obstructions, if any, and their shapes
	z Stair conditions (not slippery, unstable, etc.)
	z Manipulator’s position when moving the ASCENT manipulator.

	■ Emergencies and emergency attendant response
Depending on the site situation, ASCENT operation may need to be stopped immediately, in which 
case an attendant must press the emergency stop button (or torque off button) on the rear of ASCENT 
to stop its operation on the spot.

	■ Number of attendants
As a general rule, at least one attendant must be present.
Whenever work requires an attendant to enter ASCENT’s manipulator range of motion, two attendants 
should be present. One attendant immediately stops ASCENT if the other is struck by the manipulator.
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4.2.2 Appropriate distance between attendants and ASCENT

 WARNING

	z Attendants accompanying ASCENT should keep a constant distance from it and not 
touch it except to press the emergency stop button or torque off button.
Injury could result if ASCENT is bumped and tips over, or if fingers are caught in moving parts. 
Also be aware of the range of motion of the manipulator.

	■ Driving ASCENT on a level surface
An attendant should stand directly or diagonally behind ASCENT so as not to interfere with driving. 
From this position one can press the emergency stop button (or torque off button) on the back of 
ASCENT to stop it immediately when an emergency occurs.
Be careful to avoid standing in front of ASCENT while creating the map. An attendant standing in front 
of ASCENT while creating a map will be scanned by 3D-LiDAR as part of the map data, preventing an 
accurate map. Note that if an attendant stands diagonally forward of ASCENT’s center, they may come 
within the laser scanning area when ASCENT turns while driving.
Also consider cases where the manipulator may be moved by teleoperation, and be careful that 
attendants avoid entering the manipulator’s range of motion. For manipulator range of motion, see “1.4 
ASCENT Driving Performance” (page 1-6).

Do not stand in this 240° range 
in front of ASCENT.

As much as possible, avoid 
this area inside of ASCENT’s 
manipulator range of motion 
(about 1.2-m diameter).

When standing in this 120° range, be careful to 
back away from ASCENT whenever it turns.

Attendant normally stands in this area
(The emergency stop button on ASCENT can 
be pressed immediately)
(Range: 60°)

Direction 
of travel

Torque off button (left side)
Emergency stop button (right side)
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	■ ASCENT climbing and descending stairs
If ASCENT approaches stairs at an angle, it may tip over and fall while ascending or descending 
the stairs (see page 14-13). An attendant should closely monitor ASCENT when ascending and 
descending stairs.

OK:
Ascending straight up

NG:
Ascending skewed

OK:
Descending straight down

NG:
Descending skewed

When ASCENT is ascending stairs, do not stand below the stairs or behind ASCENT. Conversely, 
when ASCENT is descending stairs, stand behind and above it. Do not stand below the stairs or in 
front of ASCENT. In either case, ASCENT could slip down, collide and cause a serious accident.

When testing a scenario, an attendant should monitor ASCENT at a distance or in a hidden position so 
that they are not improperly detected by the 3D-LiDAR.
Since the 3D-LiDAR does not misdetect during teleoperation, the attendant may monitor from the top 
of the stairs (in front of ASCENT). When climbing a railed staircase, ASCENT can be monitored from 
the side through the railing.

4.2.3 Teleoperating ASCENT without attendants
In some cases, ASCENT may need to be teleoperated unattended because of a dangerous 
atmosphere at the site when there is no scheduled automatic patrol scenario, or when manual 
operation is required to monitor the site for some reason outside of the normal schedule. In this case, 
teleoperation should be performed by an operator who is experienced with teleoperating ASCENT.



4-8L5-59EU024 R00

Chapter 4 Operation Overview

MEMO



5-1 L5-59EU024 R00

Chapter 5 Planning and Maintenance

This chapter describes the planning of ASCENT patrols in a factory/plant.
In planning, the person in charge actually walks the factory, identifies inspection targets, and considers the 
patrol area and route. An estimate of the patrol time is determined.
Maintenance procedures are also described to protect the floor and allow ASCENT to patrol without 
problems.

5.1 Planning

The factory/plant patrol planning process determines how to proceed using the following example 
areas.

Equipment, partitions, etc.

Stairs/steps

Stair landings and upstairs passages

ASCENT Charging Station
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5.1.1 Specification of inspection targets
ASCENT can perform the following operations on an inspection target.
	z Still image capture
	z Temperature measurement using a thermal imaging camera
	z Audio recording
	z Gas concentration measurement (continuously during automatic patrol)

Use these features to determine how to inspect the various inspection targets on the factory/plant 
floor. For example, the following inspections are possible.
	z Capture a still image of an instrument to check the meter needle indication at that time.
	z Capture still images of pipes and cables to check for damage.
	z Measure gas concentrations in a specific area.
	z For equipment that emits heat, such as a boiler, temperature is measured with a thermal imaging 
camera.
	z Record audio where abnormal noise may occur.

Check gas 
concentrations

Check for 
cable damage

Check for 
damage to piping

Check instruments

Check for 
abnormal noise

Check heat source 
temperature
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5.1.2 Patrol route considerations
Consider the order of inspection based on the positional relationship of the inspection targets to 
determine the patrol route.
When deciding on a route, make sure that there is enough space for ASCENT to pass. Refer to “1.4 
ASCENT Driving Performance” (page 1-6) to select a route with adequate margins.

5.1.3 Dealing with stairs and steps on the patrol route
If there are stairs or steps on the patrol route, determine whether ASCENT can drive on them. Refer to 
“1.4 ASCENT Driving Performance” (page 1-6) to determine whether ASCENT can drive on them. If 
not possible, consider a route that avoids the steps or stairs.
To drive ASCENT on stairs or steps, perform the maintenance procedures described later in “5.1.4 
Floor maintenance” (page 5-4).

Difference 
in level

Stairs
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5.1.4 Floor maintenance
Maintenance must be performed on the patrol route where ASCENT cannot run smoothly. See “5.2 
Floor Maintenance” (page 5-7) for details.

Slip prevention on each stair step
Rope or perforated metal fencing to prevent slipping into handrail gaps

Slip prevention on slippery floors 
(recommended)

5.1.5 Stair/step measurement
Where there are stairs or steps on the patrol route, measure the height and depth of the steps. See 
“5.3 Stairs and Steps Measurement” (page 5-11) for details. These measurement results will be 
entered into Scenario Maker later.

Measure the height (up/down) and depth of the step

Measure the height and depth of the first, middle and last steps
Measure the step width
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5.1.6 Marker installation
Where there are stairs are on the patrol route, install markers to indicate the location of the stairs to 
ASCENT. See “5.4 Stair Marker Installation” (page 5-15) for details.

When capturing a thermal image of a heat source, it is necessary to install markers in two places, 
which will be installed when creating a scenario. See “7.12 Measuring the Pinpoint Temperature of a 
Heat Source Object” (page 7-86) for details.
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5.1.7 Plan adjustment
Create an automatic patrol scenario based on the results of planning obtained so far. After creating the 
scenario, perform a test run, and according to the results, repeat the planning flow and reconsider the 
automatic patrol plan.

	■ Estimated patrol time
ASCENT runs for 1 to 2 hours when the battery is fully charged. To determine whether patrol route 
travel and inspections are possible within this time, the patrol time is estimated based on the distance 
between each inspection target, stairs/steps, and the patrol route; and the time required for each 
operation.
A guide to the time required for each inspection operation is shown below. The table below shows the 
estimated time of each operation (in units of one quarter (0.25) minute). The actual time required for 
an inspection operation depends on the inspection target.

Estimated inspection time

Operation Time required
Still image capture for inspection 0.75 minutes
Heat source image capture 0.25 minutes
Stair climbing (3-m height, with one landing) 2.5 minutes
Audio recording 0.25 minutes
Traversing steps 0.75 minutes
Station departure 3 minutes
Station docking 3 minutes
Traversing level floor (at 1.2 km/h) 1 minute for 20 m (3 seconds for 1 m)

If a created patrol route scenario would take more than two hours to complete, it must be edited to fit 
within two hours by removing some inspection operations or editing the route so that the patrol can 
be completed more quickly. Although a scenario must fit within two hours, it’s better to keep the patrol 
time within one hour, considering that the battery life will decrease over time.
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5.2 Floor Maintenance

The patrol route must be maintained so that ASCENT can run without problems and avoid damage 
from collision with surrounding objects due to erroneous operation or self-position estimation errors.
Important equipment along the patrol route on the floor or stairs should be protected with cushioning 
material.
Consult with factory/plant management and supervision to obtain the necessary maintenance items 
(non-slip boards, fall prevention rope, perforated metal fencing, and cushioning material).

5.2.1 Floor maintenance
If the floor has a grating, grousers (non-slip protrusions) on the main tracks may get caught. Grousers 
are most likely to catch in areas where a sharp turn is made on the grating. It is recommended to lay 
a non-slip board or material on such floors. By laying non-slip material, ASCENT should be able to run 
stably. In this case, secure the board or non-slip material so that it does not move.
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5.2.2 Stairs maintenance
	■ Gaps in the railing

Tie a rope or affix fencing material such as a perforated metal sheet to the railing. This prevents 
ASCENT from getting stuck in or falling through the gaps in the stair railings.

Tie a rope on the railing

Attach perforated metal fencing to the railing
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	■ Each stair step
Attach a non-slip nosing material so that ASCENT can climb and descend stairs in a stable manner.
Non-slip nosing strip (tape)

Non-slip metal stair nosing

Reference: Types and characteristics of non-slip nosing materials

Type Advantages Disadvantages
Non-slip nosing strip (tape) High anti-slip effect and less 

likely to skid.
Requires regular maintenance 
(replacement).

Non-slip metal stair nosing Excellent durability and does 
not need to be replaced 
regularly.

Prone to skidding (especially 
when exposed to rain or water).
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	■ Maintenance for descending stairs 
If the floor of the upstairs landing is made of a grating material, use a flat non-slip plate to prevent the 
main and sub track grousers from getting stuck in the grooves. Prepare a non-slip plate that is large 
enough to fit ASCENT when the sub tracks are stowed (approximately 1 m square).

1 m

1 m

1 m

1 m

Place a 1 m square plate on the 
floor at the bottom of the stairs.

To descend the stairs, lay a 1 m square 
plate on the floor just above the stairs.

ASCENT’s 
direction of 
travel
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5.3 Stairs and Steps Measurement

ASCENT can go up and down stairs and climb over steps on the patrol route. Measure the width and 
depth of stairs and steps in advance.

Ascend/
Descend target

Type Things to measure Note

Stairs Two to four steps 	y Stair width
	y Height and depth of each 
step, number of steps
	y Landing width and depth 
(only if there is a landing)

–
Five or more 
steps

A marker must be installed 
at the end of the stairs. On 
stairs with a landing, a marker 
is installed at the landing 
as well. See page 5-15 for 
details.

Difference in 
level

Barrier
(Straddle step)

	y Depth, and heights of the 
front and back of the step

–

Ordinary step 	y Step height

5.3.1 Stairs measurement
Measure the width, height, and depth of the stairs that ASCENT will go up and down.
For stairs with a mid landing, measure the stairs to the mid landing and the stairs from the mid landing 
to the next floor separately.
Also measure the width and depth of the landing.
The measured values are used by Scenario Maker when creating the automatic patrol scenario. See 
“8.5.5 Stairs registration” (page 8-12) for details.

	■ Step width measurement
Measuring the step width (inner dimension, a in the figure) with a tape measure.

a (inner dimension)
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	■ Step height and depth measurement
Measure the height and depth in the first, middle, and last step. Take the case of the stairs shown 
below as an example. Count the number of steps.

Stairs with no protrusions (noses) on the steps
Final Step 
Height

Middle 
Steps

Initial Step 
Height

Stairs with protrusions (noses) on the steps
Final Step 
Height

Middle 
Steps

Initial Step 
Height

Measurement target Corresponding dimension 
in the above figure

Initial Step Height b

Initial Step Depth c

Height (middle step height) d

Depth (Middle step height) e

Final Step Height f

Final Step Depth g

Number of Steps 7

The depth of each step is measured as the distance from the front edge of that step to the front edge 
of the next step. If there is a protruding part (step nose) on each step, the depth (kick) of the step nose 
is not included in the measurement.
Since the height of the middle steps is generally constant, enter the height and depth of the middle 
steps by measuring the dimensions of any step other than the first or last step. Note that ASCENT 
cannot go up and down stairs where the height and depth of the middle steps (those between the first 
step and the last step) is not uniform.
If there are only two steps in the stairs, there is no middle step, so only the first step and the last step 
are measured.
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We recommend measuring the height of the steps as accurately as possible using two metal rulers 
(straight edges) as shown in the photo below.

Step height measurement

Step depth measurement
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	■ Landing measurement
If there is a landing on the stairs, measure the width and depth of the landing.

U-shaped landing L-shaped landing I-shaped landing

Width Width Width

Depth
Depth

Depth

5.3.2 Step measurement
Measure the height and depth of steps that ASCENT must climb over. In the case of a straddle step 
such as a barrier, measure the depth, and heights of the step on the front and back sides with respect 
to the direction of travel. In the case of an ordinary step that is not a straddle step, only the height is 
measured.
We recommend measuring the height of the step as accurately as possible using two metal rulers 
(straight edges) as shown in the photo below.

Depth

HeightHeight

Barrier (Straddle step)

Ordinary step

Height

The measured values are used by Scenario Maker when creating the automatic patrol scenario. See 
“8.5.6 Step registration” (page 8-17) for details.
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5.4 Stair Marker Installation

 WARNING

	z Use only the provided markers.
Markers other than those provided may not be recognized by ASCENT and may result in 
malfunctions, causing collisions, tipping over, or slipping.
If more markers are needed, contact the manufacturer or distributor.
	z If a marker-like reflector or other marker is near a stairs marker, it will need to be 
removed.
When another marker or reflector is nearby, ASCENT may incorrectly detect its marker and 
collide, fall, or slip.

Markers are used to indicate the location of stairs and landings to ASCENT during automatic patrol. 
ASCENT detects the markers to determine the position and shape of stairs and landings in order to 
climb and descend stairs accurately.

Marker size: 100 mm width x 600 mm length x 0.3 mm thick
Three reflectors in the center of an aluminum plate (50 mm width x 
160 mm length)
Includes stainless steel bands for attachment (4.3 mm width x 
300 mm length)

Markers need to be installed when ASCENT climbs stairs with five or more steps. Markers are not 
needed on stairs with two to four steps.
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5.4.1 Number of markers required
One marker at the end of the stairs (final step).
On stairs with a landing, a marker is installed at the landing as well. The installation location depends 
on the shape of the landing.

	■ U-shaped landing
Install markers at four locations on the landing. Install two markers 1000 mm apart in the direction 
of travel as ASCENT climbs the stairs. If not possible to install 1000 mm apart, install at a distance 
farther than 1000 mm, and record the distance.
Also install one marker on the final step of the stairs.

Marker

Reflector

d = 1000 mm or more

Downstairs Upstairs

	■ L-shaped landing
Install markers at three locations in the outer corners of the landing.
Also install one marker on the final step of the stairs.

Marker

Reflector

Downstairs

Upstairs
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	■ I-shaped landing
Install markers at the four corners of the landing.
Also install one marker on the final step of the stairs.

Marker

Reflector Install facing sideways and 
as straight as possible

Downstairs Upstairs
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5.4.2 How to install markers

 WARNING

	z Be careful not to remove, allow to fall, or obscure installed markers.
If ASCENT fails to recognize a marker, it may malfunction, causing a collision, tipping over, or 
slipping.

Install markers with straight vertical orientation. Do not install sideways.
Markers are installed parallel to ASCENT’s direction of travel. Install reflectors facing the center of the 
passage so that the running ASCENT 3D-LiDAR can catch the markers’ reflectors.
Install markers with the bottom edge as close as possible to the floor (or landing).
Pass the provided stainless steel band (or commercially available cable tie) through the holes in the 
marker periphery and around the support, or attach to the wall with double-sided tape. Make sure that 
the markers cannot move from where they are installed.

Install as straight and 
vertical as possible

The bottom edge of the marker 
should be close to the floor

Marker

Reflector

Install so that the marker’s reflector 
faces the center of the passage
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The Teleop terminal provides LTE communication with ASCENT, to remotely control ASCENT when creating 
maps and scenarios.
The Teleop terminal’s case includes storage space for necessary equipment such as the PC and gamepad.

 WARNING

	z Avoid teleoperation where radio connections are difficult or unstable.
ASCENT may behave unexpectedly or be unable to stop by teleoperation.
	z Avoid teleoperation when visibility is poor.
There is risk of collision or slipping.
If visibility is poor due to insufficient light, such as in the rain, turn on surrounding lights so that the 
surroundings are clearly visible before teleoperating.

6.1 Equipment Configuration

The Teleop Terminal consists of the following devices.
	z Notebook computer
	z Gamepad
	z Wireless mouse
	z LTE antenna: For communication between the Teleop terminal and ASCENT.
	z LTE router: Stored in the case.
	z Expansion monitor (optional)
	z USB cable (Type-C) (optional)
	z HDMI cable (optional)

The following two software applications are installed on the notebook PC.
	z Teleop screen: Remotely controls ASCENT.
	z Scenario Maker: Creates scenarios and maps.
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6.2 Teleop Terminal Preparation

This section describes the steps required to operate the Teleop terminal.

USB terminal Notebook computer

Gamepad
The LTE antenna is underneath

(Side)
Power jack
POWER switch

1 Place the case on a stable surface.

2 Slide the knobs as shown by the arrows to release the lid, then lift and remove it.

3 Remove the gamepad.
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4 Raise the LTE antenna.

5 When using an optional expansion monitor, connect its USB terminal to the USB terminal 
on the case with a USB cable.
Connect the HDMI terminal of the expansion monitor to the HDMI terminal on the PC with an 
HDMI cable.

6 Connect the AC terminal on the case to an outlet with the power cable.

7 6

7 Turn on the case.

8 Turn on the wireless mouse.

9 Turn on the PC.
Turn on the power switch on the front of the PC.
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	■ Gamepad confirmation items
Ensure that the changeover switch on the back of the gamepad is set to the X side.
If it is on the D side, switch it to the X side. Always use with the changeover switch on the X side.

 WARNING

	z When the switch is set to the D side, the behavior differs from that described in the 
instruction manual.

Do not press the MODE button on the gamepad during operation.
When you press the MODE button, the indicator lights up. Press the MODE button again to turn it off.

MODE button/indicator

 WARNING

	z If you teleoperate while the indicator is lit, the behavior differs from that described in 
the instruction manual.
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6.2.1 Lamp
The case of the Teleop terminal has the following lamps, which indicate the operating status of the 
router inside the case.

Lamp Color Function
RUN Green Flashing fast: The router is powered on and the system is initializing.

Flashing slowly: The router is running.
Off: The router is turned off.

PPP Green Lit: The link is established.
Off: The link has not been established.

USR Green Flashing: A backup SIM card is being used.
Off: The main SIM card is being used.

Green Three lit: The signal strength is strong (21-31). 
Two lit: The signal strength is medium (11-20).
One lit: The signal strength is weak (1-10).
Off: No radio signal received.
Flashing: Unable to connect to the network. The flashing pattern of the 
lamps indicates the error. See the table below for errors.

	■ Router error list

Flashing lamp(s) Error
— — Flashing AT command failed.
— Flashing — No SIM card detected.
— Flashing Flashing Enter your PIN code.

Flashing — — Enter your PUK code.
Flashing — Flashing Registration failed.
Flashing Flashing — Module error.
Flashing Flashing Flashing Module is not supported.
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6.3 Application Startup And End

Launch Scenario Maker and the Teleop Screen application.

6.3.1 Launching

1 Double-click the Scenario Maker icon.
The Startup screen appears.

2 Enter your user ID and password.
Both administrator users and general users can log in.
See “13.4 User Registration” (page 13-9) for user IDs and passwords.

2
3

4

5

3 Click the [Login & Robot Info Acquisition] button.
Upon login, ASCENT information is acquired and displayed.
The status can be as follows.
	z Online
	z Locked
	z Offline

4 Select the ASCENT to use.
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5 Click the [Launch] button.
The Scenario Maker screen and Teleop screen appear.

Scenario Maker Teleop screen

Scenario Maker is used when creating maps and scenarios. For more information, see “Chapter 8 
Creating a Map” (page 8-1) “Chapter 9 Creating a Scenario” (page 9-1).
The Teleop screen is used when operating ASCENT.
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6.3.2 Teleop screen configuration
This section describes the Teleop screen configuration.

ASCENT 
status Error message

Pause button
Stop button

Images 
from truck 
cameras

Tab

ASCENT attitude

	■ ASCENT status
Shows the operating status of ASCENT. This appears in the same color as the ASCENT status LED.

	■ Error message
Displays the most critical error when errors occur in ASCENT.

	■ Pause button
Suspends entry or exit to or from the Charging Station, manipulator attitude change, and sub track 
attitude change. Resume the operation by clicking the button again.
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	■ Stop button
Click to stop the executing operation of ASCENT. The operation cannot be resumed.
While the operation will stop, control of ASCENT will continue. ASCENT maintains its position when 
stopped on stairs or slopes. The sub tracks stop at the set angle. The manipulator stops braking when 
ASCENT is stopped.
Clicking the Stop button puts ASCENT into standby mode.
To cancel the stop, check the situation, then click the [Error Clear] button. ASCENT returns to the state 
where teleoperation is possible.
When using the gamepad, you can also stop by pushing the left and right joysticks at the same time.

	■ Tab
The screen switches according to the operation.
- Blue when communicating, red when not.

	■ Images from truck cameras
Images are displayed from the truck cameras mounted on the front and back of ASCENT. Used to see 
the status before and after a teleoperation.

	■ ASCENT attitude
The current attitude of ASCENT and the angles of the sub tracks and manipulator are displayed in CG. 
The sub track angles are also displayed numerically.

6.3.3 Ending
When exiting the software, terminate Scenario Maker and the Teleop software separately.

Scenario Maker:
Select [End] on the [Project] tab.

Teleop software:
Click the [x] button at the top right of the screen.
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MEMO
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This section describes how to create a basic scenario. Learn the basics of scenario creation by following the 
instructions to create a scenario.

In this basic scenario, the following inspection contents are assumed.
	z One inspection target
	z Capture a still image for inspection
	z Climb over one step
	z Exit the Charging Station → Climb over the step → Move to the inspection target → Extend the 
manipulator and capture a still image → Return to the Charging Station → Enter the Charging Station

Step

Inspection 
target

To create this scenario, perform the following procedures:
	z Map creation
	z Object registration
	z Motion definition

In addition to the basic scenario, we also describe how to drive on stairs and capture a thermal image.

The instructions in this chapter assume that the user already understands how to teleoperate ASCENT. To 
understand teleoperation, first read “Chapter 14 Basic ASCENT Operation” (page 14-1).
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 WARNING

	z When creating a map/scenario, be sure that an attendant accompanies ASCENT and 
maintains contact with the teleoperator.
The attendant should confirm the precautions noted in “4.2 ASCENT Teleoperator And Attendants” 
(page 4-4) while accompanying ASCENT.
The Obstacle Detection function is disabled during teleoperation, so be attentive to the situation 
around ASCENT.

	z Avoid teleoperation where radio connections are difficult or unstable.
ASCENT may behave unexpectedly or be unable to stop by teleoperation.
	z Avoid teleoperation when visibility is poor.
There is risk of collision or slipping.
If visibility is poor due to insufficient light, such as in the rain, turn on surrounding lights so that the 
surroundings are clearly visible before teleoperating.
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	■ Creating and executing scenarios
Scenarios are created by teleoperating ASCENT.
The created scenarios are saved in the cloud.
To edit a scenario, download it from the cloud to the Teleop Terminal.
According to the schedule, the scenario is downloaded from the cloud to ASCENT for execution.

Cloud system

Teleop terminal

ASCENT

The scenario executes 
on schedule

Upload the created 
scenario

Download a 
scenario for 
editing

Create a scenario by teleoperation

Check camera images
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7.1 Starting the Teleop Terminal

The Teleop Terminal is used to create scenarios and maps.
Follow the procedure below to start the Teleop Terminal.

1 Turn on the Teleop Terminal PC.

2 Double-click the Scenario Maker icon.
The Startup screen appears.

3 Enter your user ID and password.
Both administrator users and general users can log in.
See “13.4 User Registration” (page 13-9) for user IDs and passwords.

3
4
5

6

4 Click the [Login & Robot Info Acquisition] button.
The robot information is displayed.

5 Select the robot name to use.
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6 Click the [Launch] button.
The Scenario Maker screen and Teleop screen appear.
Arrange the Scenario Maker and Teleop screens so they are easy to see.
With only a notebook PC screen, we recommend displaying the Scenario Maker and Teleop 
screens side by side.
Single Screen Case

Scenario Maker screen Teleop screen

With a notebook PC and an external monitor, we recommend displaying Scenario Maker on one 
screen and the Teleop screen on the other.
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Dual Screen Case

Notebook computer

Scenario Maker screen

Expansion monitor

Teleop screen
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7.2 Creating a Map

Maps are created using the Teleop Terminal’s Teleop screen and Scenario Maker.

Note
Before moving ASCENT, check its battery level and internal pressure.
On the Teleop screen, [Battery] shows the remaining battery level, and [Differential Pressure] shows 
the internal pressure.

Battery level checking
Color Value State

Blue 29V or more Sufficient battery power remains for normal operation.
Yellow 27 to 29V The battery is running low.

It should be charged before exiting the Charging Station.
If away from the Charging Station, consider returning.

Red Below 27V The battery is low.
Be sure to charge the battery before exiting the Charging Station.
If away from the Charging Station, return immediately to recharge.

Differential pressure checking
Value State

Less than -6 kPa Sufficient for normal operation.
-6 kPa or more Do not exit the Charging Station until pressure is restored. (To 

restore sufficient pressure, refer to the installation preparation 
section.)
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7.2.1 Exit the Charging Station
First move (undock) ASCENT from the Charging Station. Have an attendant stand near ASCENT to 
check its status.

1 They should confirm that ASCENT is in the Charging Station and the status LED is lit or 
flashing yellow.

2 Open the [Predefined Motions (Navi)] tab on the Teleop screen.

2

3
4

3 Select [Exit Charging Station] on the [Predefined Motions] panel.
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4 Click [Execute].

5 Click [Yes] when the message is displayed.
The exit (undocking) process starts.
ASCENT starts working after performing initial processing such as self-checking.
ASCENT stops when it exits the Charging Station, and the status LED flashes green (teleoperation 
mode).
The attendant should confirm ASCENT’s status LED.
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7.2.2 Creating a map
From the Teleop screen, drive ASCENT to create a map for Scenario Maker. When creating a map, 
set the sub-track angle to 110 degrees both front and back so that the sub tracks are not in the LiDAR 
field of view.
Driving ASCENT in a plant like the one on the left below produces a map like that on the right.
In the figures below, lines connect those points on the map with their corresponding points in the plant.
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Start creating a map with Scenario Maker.

1 Open the [Project] tab in Scenario Maker.

1
2
3

2 Click [Create New Scenario].

3 Select [Clear Scenario] and click [OK].
Scenario creation starts.

4 Click [Create New Map].
The Map Creation Mode screen appears.
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ASCENT is now operated from the Teleop screen.

5 Open the [Truck] tab on the Teleop screen.

4

6 Use the gamepad to drive ASCENT.
To move ASCENT, press and hold the A button (or X or Y button) while operating the left joystick. 
The button determines the speed, and the left joystick determines the direction of movement.

High Speed

Medium Speed

Low Speed

ASCENT stops when you release either the button or the joystick.
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Drive completely around the patrol area as shown in the example below.

As ASCENT moves, the map is created on the Scenario Maker screen.
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Map creation points
While creating the map, along with the camera images on the Teleop screen, you can easily 
determine the position and status of ASCENT by watching the map screen being created in 
Scenario Maker.
On the Scenario Maker map screen, ASCENT’s position is displayed in the map being created, 
and locations irradiated by the laser are indicated as series’ of white dots. These white dots 
indicate the locations of walls and obstacles, so you can observe ASCENT and the white dots on 
the map to confirm the distances between them while driving.

ASCENT

Walls and obstacles appear 
as rows of white dots

When a step is present
Although ASCENT may need to climb over a step in the scenario, when creating the map, drive on 
both sides of the step without climbing over. If it is difficult to create a map without crossing a step, 
adjust the angles of the sub tracks so that the front sub tracks do not come into the LiDAR field of 
view, then drive ASCENT.
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7 After driving around the patrol area completely, stop ASCENT in front of the Charging 
Station.
If the walls around the area are clearly delineated on the map, map creation has succeeded. 
Proceed to the next step to save the map.
If walls appear on the map as multiple or distorted lines, map creation has failed. Click [Clear Map] 
and try creating the map again.

Successful map example Failed map example

* The above screens are images of created maps opened with Scenario Maker.

8 Click [Store Map].

9 Enter the name of the map and click the [Save] button.

The map is saved in the Teleop Terminal.

10 Click [OK] when the message is displayed.
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11 Click [End] on the map creation screen.

11

12 Click [Yes] when the message is displayed.
The Map Creation Mode ends.
If you specify the same name as an already saved map, the saved map will be overwritten.
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7.2.3 Entering the Charging Station (docking)
Use the Teleop screen to dock ASCENT in the Charging Station.

NOTE
	z Enter along the dotted line of the guide plate.
If the entry angle is incorrect, ASCENT may crash into the Charging Station.

1 Open the [Truck] tab on the Teleop screen.

2 Move ASCENT to the front of the Charging Station, aiming at the dotted line on the 
Charging Station’s docking/undocking (entry/exit) guide plate. (Figure A)

3 Continue to advance, and stop when ASCENT is entirely over the guide plate. (Figure B)

4 Rotate ASCENT 180° to face away from the Charging Station. (Figure C)
To turn, hold down the A button on the gamepad and tilt the left joystick to the left or right.
When stopped in the correct position, ASCENT’s laser is reflected in the Charging Station’s 
reflector.
An attendant should make sure that ASCENT is stopped centered over the dotted line on the guide 
plate.

(A) (B) (C)

5 Open the [Predefined Motions (Navi)] tab on the Teleop screen.
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6 Select [Enter Charging Station] on the [Predefined Motions] panel, and click [Execute].

7 Click [Yes] when the message is displayed.
ASCENT will automatically enter the Charging Station.
Soon after docking, the status changes to battery charging mode.
Confirm that the Teleop screen status indicates [Battery charging mode].

6

Status
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7.3 Registering Objects

This procedure registers the locations of objects such as the Charging Station and targets on the map.
To register an object, place an object icon from the [Object] tab in Scenario Maker onto the map.
An object icon on the map is a guide to the location of the object, so it is not necessary to specify the 
exact position.

7.3.1 Registering the Charging Station
Specify the location of the Charging Station on the map.

1 Open the previously created map.
1 Open the [Project] tab in Scenario Maker.
2 Click [Open Map].
3 Select the previously created map from the [Add Map] screen, and click the [OK] button.

The map is displayed.

2 Open the [Object] tab.

3 Click [Charging Station].

4 Click the location of the Charging Station on the map.

The Charging Station icon is placed at the clicked location.
There are no setting items for the Charging Station, so registration is complete.
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7.3.2 Registering a target
Place the target icon on the map and enter the name of the target.

Note
	z It doesn’t matter if the target icon is placed in the exact location.
	z You can change the location and name of the target later.
	z To see the target information later, right-click the target icon and select “edit”.

1 In the [Object] tab, click [Target].

2 Click the target location on the map.

A target icon is placed at the clicked location.

3 Right-click the target icon on the map and select [edit].
The [Target Setting] screen appears.

4 Select [New Registration] in the [Target Name] list and enter a name in the text box below.

5 Click the [OK] button.
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6 Click [Yes] when the message is displayed.
A Target ID is assigned, and the target information is saved in the cloud.

7.3.3 Step registration
Register a step as an object, and specify the height and depth of the step.
Also read “8.5.6 Step registration” (page 8-17) for details about step registration.

Note
When registering a step, consider ASCENT’s direction of travel. If the front and back heights are 
different, the side ASCENT will climb must be specified when registering.
To cross the step in the opposite direction to that registered, you can swap the heights when defining 
the motion.

1 Measure the heights and depth of the step.
Measure the height on the front side in the direction of travel (1), depth (2), and the height (3) 
on the back side in the direction of travel.

2

1
3

Direction  
of travel

2 In the [Object] tab of Scenario Maker, click [Steps].
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3 Click the location of a step on the map.

A step icon is placed at the clicked location.

4 Right-click the step icon on the map and select [edit].
The [Step Setting] screen appears.

5 Enter the measured values for [Height A], [Height B], and [Depth].
[Height A] is the height of the front side in the direction of travel, and [Height B] is the height of the 
back side.

6 Click the [OK] button.
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7.4 Defining Motions

Create a scenario based on the created map.
Like a map, a scenario is created using the Teleop Terminal’s Teleop screen and Scenario Maker.

A scenario defines the order of movements and inspection behavior of ASCENT in terms of “motions”.
Here, we will create the following scenario.

Line No. Motion ASCENT behavior
1 charging-station Exit the Charging Station

2 load-map Load a map

3 path Move to a step

4 rotate-to-point Face the step

5 obstacle Drive over a step

6 path Move to a target

7 arm-joint Extend the manipulator

8 record-image Capture a still image

9 arm-joint Restore the manipulator

10 path Move to the Charging Station

11 rotate-to-point Turn around for docking

12 charging-station Dock in the Charging Station

Motions are defined on the [Scenario] tab of Scenario Maker.
Also read “9.3 Basic Motion Operations” (page 9-6) for details about how to work with motion 
definitions.
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7.4.1 Defining an undocking (Exit) motion
Charging Station undocking (Exit) and docking (Entry) are predefined charging-station motions.
They are predefined for use whenever a new scenario is created.

	■ When creating a new scenario

A newly created scenario contains two motions: charging-station undocking (Exit) and docking (Entry).
All other motions will be defined between these two charging-station motions.
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7.4.2 Defining a map-loading motion
A floor map must be loaded before traveling on a floor.
Map loading is defined by the load-map motion.

1 Click the [+] button below the first charging-station motion.

A new motion is added.

2 Click ▼ to display the list of motions, and select “load-map”.

The load-map motion’s property screen appears.
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3 Select the map to load from the [Map Name] list.

3
4

The list shows the currently open maps.

4 Specify the initial position and attitude (heading) of ASCENT for the load-map motion.
ASCENT’s initial position and attitude are indicated by an arrow on the map.

ASCENT’s initial position and attitude Arrow’s heading on the map

1 Click the [Select from Map] button for [Initial Position Attitude].
2 Move the mouse to the front of the Charging Station icon on the map (the location of ASCENT).
3 Click the mouse button and drag the mouse on the spot.

An arrow is displayed on the map, and the heading of the arrow changes as you drag the 
mouse. Move the arrow so that its heading matches ASCENT’s heading, then release the 
mouse button.

Releasing the mouse button enters the [Initial Position Attitude] motion values.
If the arrow operation does not work, click the [Select from Map] button again and retry the 
operation.
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5 Click the [OK] button.

7.4.3 Defining the motion from the Charging Station to the step
Create a motion to move to the step after loading the map. Movement is defined by a “path” motion. 
Here, you actually drive ASCENT to the step by teleoperation, then save the traversed path.

Before defining the motion, direct ASCENT to exit the Charging Station.
Read “7.2.1 Exit the Charging Station” (page 7-8) for details about exiting the Charging Station.

1 Open the [Predefined Motions (Navi)] tab on the Teleop screen.

2 Select [Exit Charging Station] on the [Predefined Motions] panel.

3 Click [Execute].

4 Click [Yes] when the message is displayed.

 CAUTION

	z This operation involves actually moving ASCENT.

ASCENT exits the Charging Station. After exiting, confirm that the ASCENT status LED is flashing 
green.

Next load the scenario into ASCENT.
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1 Click [Scenario Load] on the [Execute] tab of Scenario Maker.

2 Click [Yes] when the message is displayed.
Confirm that the scenario status has changed from [Waiting for scenario to load] to [Waiting for 
start].

Scenario status13

3 Place ASCENT on the map.
1 Click [Robot Positions].
2 Move the mouse to the ASCENT location on the map.
3 Click the mouse button and drag the mouse on the spot.

An arrow is displayed on the map, and the heading of the arrow changes as you drag the 
mouse. Move the arrow so that its heading matches ASCENT’s heading, then release the 
mouse button.
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Next, drive ASCENT to create a path from the Charging Station to the step.
Starting from the front of the Charging Station, stop at a position about 50 cm in front of and facing 
the step. In order to climb over a step safely, ASCENT must be facing the step.

50cm

Drive ASCENT to the step by teleoperation while recording the path.

Note
When creating a path, all ASCENT motion is recorded. Note that any overshooting of the intended 
path and returning to or correcting direction is all recorded as it occurs.

1 Click [Begin/end path recording].

2 Open the [Truck] tab on the Teleop screen.
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3 Use the gamepad to drive ASCENT to the step.
Press the A, X and Y buttons on the gamepad while moving the left joystick as when creating a 
map.
Stop when ASCENT reaches the front of the step. At this point, ASCENT does not have to be 
facing the step.

4 Click [Begin/end path recording] again.

5 When the path name entry dialog box appears, enter a path name and click the [Save] 
button.
Note
Provide a descriptive name that clearly indicates the path destination.

If you need to reroute the path, click [Abort] in the above dialog. Use the gamepad to return 
ASCENT to the beginning of the path, click [Begin/end path recording], and record again.

Next, define the route just recorded as a “path” motion.

1 On the [Scenario] tab, click the [+] button below the load-map motion to add the new 
motion.

2 Select “path” from the list of motions.
The Path Settings screen appears.
Only the main path motion settings are described here. For details on path motions, see “path 
motion properties” (page 9-17).
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3 Select the name of the path saved earlier in [Reference Path].

3

4

In order to climb over a step safely, ASCENT must be facing the step. To do this, use [Stopped 
Heading] to specify ASCENT’s heading when stopped.

4 Specify the stopped heading at which ASCENT faces the step
1 Under [Stopped Heading], click the [select from map] button.
2 Move the mouse to the ASCENT location on the map.
3 Click the mouse button and drag the mouse on the spot.

An arrow is displayed on the map, and the heading of the arrow changes as you drag the 
mouse. Drag the arrow so that its heading is perpendicular to the step.

As a result, when the scenario executes, ASCENT will move, rotate and stop with the specified 
heading.
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5 Click the [OK] button.
The new path motion is added. Also, by specifying the [Stopped Heading], a rotate-to-point motion 
is inserted below the path motion. For details on the rotate-to-point motion, see “rotate-to-point 
motion” (page 9-19).
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7.4.4 Defining motion over a step
An “obstacle” motion is created to drive over a step.

1 Add the motion after the rotate-to-point motion.

2 Select “obstacle” from the list.
The motion property screen appears.

3 Click the [Object Selection] button, then click the step icon on the map.
The measured value of [Height A] of the step object is entered as the [Mounted Height], and the 
measured value of [Height B] is entered as the [Lowered Height].

Mounted height
Height A

Lowered height
Height B
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If the [Mounted Height] and [Lowered Height] values are opposite to ASCENT’s actual direction of 
travel, click the [Swap] button.

4 Click the [OK] button.

	■ Execute the motions to climb over the step
Next, execute the rotate-to-point and obstacle motions just created to have ASCENT actually climb 
over the step.

1 Click [Scenario Load] on the [Execute] tab of Scenario Maker.

2 Click [Yes] when the message is displayed.
Confirm that the scenario status has changed to [Waiting for start].

3 Select the rotate-to-point line on the [Scenario] tab.

4 Click [Executed selected lines] on the [Execute] tab.

5 Click [Yes] when the message is displayed.

 CAUTION

	z This operation involves actually moving ASCENT.
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4, 6

3

6

The rotate-to-point motion is executed and ASCENT turns to the specified heading.

6 Confirm that the obstacle motion is now selected, and click [Executed selected lines].

7 Click [Yes] when the message is displayed.

 CAUTION

	z This operation involves actually moving ASCENT.

ASCENT climbs over step according to the defined motions.

	■ To interrupt scenario creation
To interrupt the scenario creation process, save the scenario to the cloud (even while it is being 
created). To save, click [Save Scenario] on the [Project] tab of Scenario Maker. (See “7.5 Saving a 
Scenario” (page 7-55))

	■ To resume creating an interrupted scenario

1 Click [Open Scenario] on the [Project] tab to open the saved scenario.
(See “7.6 Opening a Saved Scenario” (page 7-56))

2 Click [Scenario Load] on the [Execute] tab.

3 On the [Scenario] tab, select the load-map motion and click [Executed selected lines].

4 Remotely drive ASCENT to the location where you want to resume creation.

5 On the [Scenario] tab, resume creating the scenario.
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7.4.5 Defining the movement to the target
Next, define the movement to the inspection target as a path motion in the scenario.
Perform the same operation as in “7.4.3 Defining the motion from the Charging Station to the step” 
(page 7-27).

1 Remotely drive to the target and save the path.
1 Click [Begin/end path recording].
2 Open the [Truck] tab on the Teleop screen, and remotely drive ASCENT to the target.

Press the A, X and Y buttons on the gamepad while moving the left joystick as when creating a 
map.
Stop ASCENT when close to the target.

3 Click [Begin/end path recording] again.
4 When the path name entry dialog box appears, enter a path name and click the [Save] button.

Next, define the path just recorded as a motion.

2 Click the [+] button under the obstacle motion on the [Scenario] tab to add a motion.

3 Select “path” from the list of motions.
The Path Settings screen appears.

4 Select the name of the path saved earlier in [Reference Path].

5 Click the [OK] button.
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7.4.6 Define a motion to change the attitude of the manipulator
Create a motion to point the manipulator toward the location to be inspected. Manipulator attitude 
changes are defined by arm-joint motions.

1 Open the [Predefined Motions (Navi)] tab on the Teleop screen.

2 Click the [Video] button under [Surveillance Camera] on the [Predefined Motions] panel.

The surveillance camera image appears on the Teleop screen.

3 Open the [Manip.] tab on the Teleop screen.
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4 Click [Attitude Change] on the [ManiInfo] panel.

5 Click [[B] Confirm].
The Attitude Change screen appears.

6 Click one of the attitudes on the Attitude Change screen so that the manipulator faces the 
target location.
Note
When you select an attitude, the target attitude is displayed in red, so you can confirm it.
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7 Click [[B] Confirm].

8 Click [Yes] when the message is displayed.

 CAUTION

	z This operation involves actually moving ASCENT.

The manipulator moves and the angle changes.
Check whether the target is in the camera’s field of view by looking at the surveillance camera 
image on the [Manip.] tab.

If out of view, use the gamepad to adjust the manipulator angle as follows:

9 Select [Gamepad Operation] on the [ManiInfo] panel, and click [[B] Confirm].
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Note
Press the gamepad’s help button to display the Gamepad Operation Guide.

Help button

10 Adjust the angle of the manipulator with the gamepad.

 CAUTION

	z This operation involves actually moving ASCENT.

The main operations of the manipulator are shown below. For details on manipulator operation, 
see “14.8 Manipulator Operation” (page 14-21).

Manipulator movement Gamepad operation
Move the tip back and forth, 
and left and right

A button (position manipulation) + left joystick front, back, left, 
and right

Move the tip up and down A button (position manipulation) + R2 button (up) or R1 button 
(down)

Point the tip to the left or right Y button (attitude manipulation) + left joystick left and right

Point the tip up or down Y button (attitude manipulation) + left joystick up and down

Rotate the tip Y button (attitude manipulation) + L2 button (left rotation) or R2 
button (right rotation)

Once the manipulator’s surveillance camera captures the target, register the motion with the current 
angle.

Note
The final angle of the manipulator joint is recorded in the motion. Other movements while operating the 
gamepad are not recorded. When you execute the motion, the manipulator moves to the recorded joint 
angle.
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11 Click the [+] button on Scenario Maker’s [Scenario] tab to add the motion.

12 Select “arm-joint” from the list of motions.
The property screen appears.

13 Click the [Acquiring Current Angle] button.
The angle of the current manipulator is registered with the motion.
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14 Click the [OK] button.
The arm-joint motion is added.
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7.4.7 Defining a still image capture motion
Create a motion to capture a still image with the manipulator’s camera. Still image capture is defined 
as a record-image motion.

1 Click the [+] button below the arm-joint motion to add the motion.

2 From the list of motions, add “record-image”.
The property screen appears.
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3 Click the [Object Selection] button, then click the target’s icon on the map.
The ID of the selected target is set as the Target ID and the target name is displayed.
Note
The captured image can be confirmed by its target ID in the cloud. For more details, see “12.2 
Checking Inspection Results of Each Target (Inspection History)” (page 12-4).

4 Select the camera and image format to use for shooting.

Item Description
[Camera] To use the manipulator camera, select [Surveillance Camera].

Otherwise, [360° Optical Camera], [Right Thermal Imaging Camera], or [Left 
Thermal Imaging Camera] can be selected.

[Image Format] Select [JPEG] or [BMP].

[Surveillance Camera Settings] can be confirmed by taking a test shot.

5 Capture a test shot on the Teleop screen.
1 Open the [Predefined Motions (Navi)] tab on the Teleop screen.

1

2

2 Select [Surveillance Camera Information] on the [Predefined Motions] panel, and click 
[Execute].
The surveillance camera setting screen appears.
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3 For [Mode], select an exposure setting.

Item Description
Auto Shoot with the auto exposure setting.

Dark Area Setting Shoot with the exposure setting for dark areas.

Bright Area Setting Shoot with the exposure setting for bright areas.

Auto Exposure 
Zone Setting

Measure and shoot within the area specified by [Auto Exposure Zone 
Setting].

Area setting Specify the metering area when [Auto Exposure Zone Setting] is selected.
When [Auto Exposure Zone Setting] is selected, a rectangle indicating 
the metering range appears in the surveillance camera image. Use the 
D-pad keys on the gamepad to move the rectangle to the location you 
want to measure, and change the values of u1, u2, v1, and v2 to resize 
the rectangle.

4 Click [Settings].
5 Click the [x] button at the top right of the setting screen to close it.
6 Click the [Still Image] button under [Surveillance Camera] on the [Predefined Motions] panel to 

capture a test shot.
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The exposure settings selected in step 3 are applied to capture the image, which is displayed 
on the Teleop terminal.

The displayed image can be closed by clicking the [x] button at the top right.
If the captured image is too dark or too light, follow the steps below to change the settings and 
try again.

7 Select [Surveillance Camera Information] and click [Execute].
8 Change the [Mode] setting on the setting screen and click the [Settings] button.
9 As in step 6, click the [Still Image] button under [Surveillance Camera] to capture another test 

shot.
Change the settings and shoot again as needed to determine the appropriate settings. Note the 
settings determined here, and apply them to the record-image motion settings.
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6 Return to Scenario Maker’s record-image property screen, and set the shooting mode that 
you determined from the test shot in [Surveillance Camera Settings].
If you specified a metering range for the test shot, click the [Get Area] button to set that metering 
range.

7 Click the [OK] button.
The record-image motion is added.
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7.4.8 Defining a motion to recover (stow) the manipulator
After capturing a still image and before moving to the next target, define a motion to retract the 
manipulator to its stowed attitude.
An arm-joint motion is again used to define the manipulator’s attitude.

 CAUTION

	z Do not move ASCENT with the manipulator extended.
There is a risk of causing injury to people or damage to objects by hitting them.
Also, vibration may cause the manipulator to malfunction.

1 Click the [+] button below the record-image motion to add another motion.

2 Select “arm-joint” from the list of motions.
The property screen appears.
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3 Click the [Stowed Attitude] button.

4 Click the [OK] button.
The arm-joint motion is added.

5 Retract the actual manipulator on the Teleop screen.
ASCENT’s manipulator is in an extended state, so retract it before creating the next motion.

 CAUTION

	z This operation involves actually moving ASCENT.

1 Open the [Manip.] tab on the Teleop screen.
2 Click [Attitude Change] on the [ManiInfo] panel, and click [[B] Confirm].
3 Select Stowed Attitude on the Attitude Change screen, and click [[B] Confirm].
4 Click [Yes] when the message is displayed.

The manipulator returns to its stowed position.
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7.4.9 Defining a motion to return to the Charging Station and dock
At the end of the scenario, return to the Charging Station for docking.
Drive to the Charging Station and save the path as a path motion, just like driving to a target.

1 Drive to the Charging Station by teleoperation and save the path.
1 Click [Begin/end path recording].
2 Click the [Truck] tab on the Teleop screen, and teleoperate ASCENT to drive to the Charging 

Station.
3 Move ASCENT to the front of the Charging Station, aiming at the dotted line on the Charging 

Station’s docking/undocking (entry/exit) guide plate.
4 Continue to advance, and stop when ASCENT is entirely over the guide plate.
5 Click [Begin/end path recording] again.
6 When the path name entry dialog box appears, enter a path name and click the [Save] button.

Next, define the recorded path as a motion. In addition, since ASCENT must enter the Charging 
Station backwards when docking, add another motion to change its heading when stopped.

2 Click the [+] button under the arm-joint motion on the [Scenario] tab to add the motion.

3 Select “path” from the list of motions.
The Path Settings screen appears.
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4 Select the name of the path saved earlier in [Reference Path].

4

5

Note
The path selected in [Reference Path] changes color and flashes.

5 Specify the Stopped Heading so that ASCENT can enter the Charging Station.
The following illustrations show ASCENT’s heading and the corresponding heading of the arrow on 
the map.

ASCENT’s heading when docked Arrow’s heading on the map

1 Under [Stopped Heading], click the [select from map] button.
2 Move the mouse to the ASCENT location on the map.
3 Click the mouse button and drag the mouse on the spot.

An arrow is displayed on the map, and the heading of the arrow changes as you drag the 
mouse. Move the arrow so that it heads in the correct direction, and then release the mouse 
button.
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6 Click the [OK] button.
For the Stopped Heading setting, a rotate-to-point motion is automatically added under the path 
motion.

The scenario ends with a charging-station entry (docking) motion. The charging-station entry 
motion was automatically registered when the scenario was created, so it does not need to be 
added here.
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	■ Charging Station entry (docking)
As ASCENT has not yet been docked, it must be docked by teleoperation.
For details of the docking (Entry) operation, see “7.2.3 Entering the Charging Station (docking)” (page 
7-17).

1 Open the [Truck] tab on the Teleop screen, and turn ASCENT so that it is headed as follows.

2 Open the [Predefined Motions (Navi)] tab.

3 On the [Predefined Motions] panel, select [Enter Charging Station] and click [Execute].
ASCENT will move and automatically enter the Charging Station.
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7.4.10 Completed scenario
The following scenarios can be made from the work so far.

Line No. Motion Major parameter settings
1 charging-station Exit

2 load-map Map Name
X, Y, Yaw

3 path Reference Path
Speed
Stopped Heading

4 rotate-to-point

5 obstacle Mounted Height
Lowered Height
Depth

6 path Reference Path
Speed
Stopped Heading

7 arm-joint Reference Number
S1 axis angle, S2 axis angle, E1 axis angle,
E2 axis angle, W1 axis angle, W2 axis angle

8 record-image Target ID
Camera: Surveillance Camera
Image Format
Surveillance Camera Settings

9 arm-joint Reference Number
S1 axis angle, S2 axis angle, E1 axis angle,
E2 axis angle, W1 axis angle, W2 axis angle

10 path Reference Path
Speed
Stopped Heading

11 rotate-to-point

12 charging-station Entry
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7.5 Saving a Scenario

Save the created scenario in the cloud.
The scenario is saved in association with the plant name. Scenarios are not saved in the Teleop 
Terminal.

1 Click [Save Scenario] on the [Project] tab.

2 Select [Overwrite Scenario] or [Register as New Scenario] and click the [OK] button.

3 Click [Yes] when the message is displayed.

4 If creating a new scenario, enter its name and click the [OK] button.
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7.6 Opening a Saved Scenario

To edit a saved scenario, follow the steps below to open it.

1 Click [Open Scenario] on the [Project] tab.

2 For [Plant Name], select the plant for which the scenario was saved.

3 Select the scenario in [Select Scenario] and click the [OK] button.

4 When the download confirmation message appears, click [Yes].
The scenario will be downloaded from the cloud.
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7.7 Test Run the Scenario

Execute the scenario to see if it was created correctly.
After creating a scenario, test it to ensure that it works.

 WARNING

	z When testing a scenario, be sure that an attendant accompanies ASCENT to monitor its 
status.

Start with ASCENT docked. If ASCENT has not been docked, have it do so first. For the docking 
(Entry) operation, see “7.2.3 Entering the Charging Station (docking)” (page 7-17).

1 Open the [Execute] tab in Scenario Maker.
Make sure that the scenario status on the toolbar is [Waiting for scenario to load].

2 Click [Scenario Load].

3 Click [Yes] when the message is displayed.
The scenario is loaded into ASCENT.
The scenario status changes from [Waiting for scenario to load] to [Waiting for start].
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4 Select the first line of the scenario.

5 Click [Execute to end].

6 Click [Yes] when the message is displayed.

 CAUTION

	z This operation involves actually moving ASCENT.

ASCENT patrols according to the scenario.

If the scenario doesn’t execute correctly or stops in the middle, check for the offending motion and 
modify it. If ASCENT does not move to the proper position, modify the path motion settings and path. 
To modify the path, see “9.4.5 Editing a path” (page 9-22).
The obstacle detection function may stop ASCENT while moving. In that case, open the path motion 
properties screen and disable the obstacle detection option.
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7.8 Registering a Schedule

To execute the scenario automatically, register an execution date and time for the scenario in the 
cloud.
Here, specify a time close to the current time to ensure that the scenario executes on schedule.

1 Enter the URL of the cloud (https://ex-rovr.com) in your PC’s Web browser (Chrome 
recommended).
The login screen appears.

2 Enter your User ID (email address) and password.
For user ID and password details, see “13.1 Logging Into the Cloud” (page 13-1).

3 Click the [Sign In] button.
The cloud management screen appears.
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4 Select [Schedules] from the menu on the left.

5 Click the [Add] button.
The [Schedule Registration] screen appears.

6 Select the plant name for execution in [Plant].
A list of scenarios registered for the selected plant is displayed on the right side of the screen.
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7 Enter the schedule name.

6
7

11

12

9
10

8 Select the scenario for execution in [Scenario].
Click on the scenario name column to pop up its map and patrol route.

9 Select ASCENT as the [Robot] to execute the scenario.

10 Set the [Start Date].
Click the [Start Date] and [Start Time] fields, and specify the execution starting date and time.

11 Set the [Cycle].
Select the unit (year, month, week, day, hour) in the first list.
	z [Year], [Week], [Day], [Time]: Enter the cycle (frequency) numerically.
	z [Month]:  In addition to specifying a numerical value for once every few months, you can also 

specify the 10th of every month, the third Friday of every month, and the like.
	z [Week]: Specify the execution day of the week.

12 Specify when to end the scheduled executions with [End].
	z [No Expiration]: No expiration date is set.
	z [Expiration Date]: The schedule will not be executed after the specified date.
	z [Execution Count]:  The schedule will no longer execute after the specified number of 

executions.

13 Click the [OK] button.
The schedule is registered.

	■ Start the scenario
At the scheduled operation start time, ASCENT will automatically start patrol.
At the start time, ASCENT first reboots its devices and loads the scenario. Therefore, it takes about 
five minutes for ASCENT to actually start moving.
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7.9 Checking Inspection Results

Check the results of an automatic patrol.
Whenever automatic patrol executes, the execution results and captured images are uploaded to the 
cloud. Check the results on the management screen.

1 Log in to the cloud.

2 Select [Inspection Summaries] from the menu.
The [Inspection Summaries] screen appears.

3 4 4

3 Select the plant from the [Plant] list.

4 Select the name of the scenario you want to check in [Scenario], and click the [Search] 
button.
The patrol results that match the search conditions are displayed in order from the most recent.

5
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5 Click the [Detail] button in the row of the patrol results you want to display.
Patrol results are displayed as a form.

A map is displayed on the right side of the screen, with the patrol route and shooting locations 
displayed on the map.
Acquired images are displayed at the bottom of the screen. Click an image to enlarge it.

In the cloud, you can also check past inspection results for each target in [Inspection History].
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7.10 Particular Cases

	z Narrow passages
The obstacle detection function may stop ASCENT from passing through narrow spaces on a path 
motion route.
In that case, open the path motion properties screen and disable the obstacle detection option.

	z Ascending and descending slopes
Differences in elevation up to 100 cm and inclinations of up to about 15 degrees can be traversed 
on one map as if on a flat surface.
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7.11 Adding Stairs

Add stair ascending and descending to the basic scenario. Climb stairs to a 2nd floor, drive on the 2nd 
floor, measure the gas concentration in one place, and add a motion to return to the 1st floor.

7.11.1 Install markers
Install markers to drive on stairs.
For details, see “5.4 Stair Marker Installation” (page 5-15).

7.11.2 Measure the stairs
Measure the height and width of the stairs that ASCENT will travel on. If there is a landing, measure its 
size in mm.
Measure the following dimensions.
	z Stair width
	z First step height and depth
	z Last step height and depth
	z Middle step height and depth

If there is a landing, measure the above items for the stairs to the landing and again for the stairs after 
the landing. Also measure the following landing dimensions.
	z Landing width
	z Landing depth

Also note the shape of the staircase (I-type, L-type, U-type) and the direction of a turn (left or right).
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7.11.3 Open the created scenario
Open the basic scenario you have created. Add stair ascending and descending to this scenario.

1 Open the [Project] tab in Scenario Maker.

2 Click [Open Scenario].

3 Select the previously created basic scenario and click the [OK] button.

7.11.4 Create a map of the 2nd floor
To travel on multiple floors, a map of each floor is necessary.
Drive ASCENT to the 2nd floor to create a map there. Create a map by teleoperating ASCENT in the 
same way as “7.2 Creating a Map” (page 7-7).
See “Chapter 14 Basic ASCENT Operation” (page 14-1) for instructions on how to climb stairs by 
teleoperation.

Start creating a map with Scenario Maker.

1 Position ASCENT at the point immediately after climbing the stairs.

2 Open the [Project] tab in Scenario Maker.

3 Click [Create New Map].

The Map Creation Mode screen appears.

4 Open the [Truck] tab on the Teleop screen.
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5 Use the gamepad to drive ASCENT.

6 Drive all around the 2nd floor, return to the previous staircase position, and stop ASCENT.

7 Click [Store Map].

8 Enter the name of the map and click the [Save] button.

The map is saved in the Teleop Terminal.

9 Click [End] to exit the Map Creation Mode.
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7.11.5 Registering a stairs object
Register the stairs (staircase) object on the map.

1 Open the 2nd floor map.
Open the [Layer] tab and make sure both 1st and 2nd floor maps are open.

2nd floor map

1st floor map

2 Display the 1st floor map and open the [Object] tab.
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3 Click [Stairs], then click the location of the stairs on the map.
A Stairs icon appears.

4 Right-click on the Stairs icon and select [edit].
The Stairs Settings screen appears.
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5 Select the presence or absence of a landing and the shape of the stairs in [Landing].

6 Enter the measured stair dimensions on the setting screen.

57

6

7 Enter a name in [Name] and click the [OK] button.
The Stairs settings are saved in the cloud.

Next, display the 2nd floor map and make the Stairs Settings for the 2nd floor as well.

8 On the [Layer] tab, right-click the 2nd floor map and select [Set to Current Map].
The 2nd floor map is displayed.
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9 On the [Object] tab, click [Stairs], then click the location of the stairs on the map.

10 Right-click on the Stairs icon and select [edit].
The Stairs Settings screen appears.
Since the stairs settings have already been entered on the 1st floor map, all you have to do is 
bring up the stair settings on the 2nd floor.
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11 Select the name of the stairs you entered earlier in [Select Stairs].

1112

12 Uncheck [Copy].

13 Click the [OK] button.
Stairs settings are finished.
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7.11.6 Defining motions
Add motions to ascend and descend the stairs based on the basic scenario.
Highlighted lines indicate added or changed motions.

Line No. Motion ASCENT behavior
1 charging-station Exit the Charging Station

2 load-map Load a map

3 path Move to a target

4 rotate-to-point Face the step

5 obstacle Drive over a step

6 path Move to a target

7 arm-joint Extend the manipulator

8 record-image Capture a still image

9 arm-joint Restore the manipulator

10 path Go to the stairs

11 align Face the stairs

12 stairs Climb the stairs

13 load-map Load the 2nd floor map

14 path Move to a target

15 record-audio Record surrounding sounds

16 path Move to the stairs

17 rotate-to-point Face the stairs

18 stairs Descend the stairs

19 load-map Load the 1st floor map

20 path Move to the Charging Station

21 rotate-to-point Turn around for docking

22 charging-station Dock in the Charging Station
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	■ Define the motion to move to the stairs
In line 10 of the original scenario, the path motion to return to the Charging Station will be changed to 
a path motion that moves to the bottom of the stairs.

1 Execute [Scenario Load] on the [Execute] tab of Scenario Maker.

2 Teleoperate ASCENT to move it to the target position on the 8th line (record-image) of the 
scenario.

3 Use Scenario Maker to start path recording from that position.
For details on path recording operations, see “7.4.3 Defining the motion from the Charging Station 
to the step” (page 7-27).

4 Teleoperate ASCENT to move it to the bottom of the stairs.

5 Stop path recording and save the path.

6 Click on [...] for the path motion in the 10th line of the scenario.

The motion property screen appears.
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7 Replace [Reference Path] with the path saved in step 5.

8 Click the [OK] button.
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	■ Defining a motion to ascend stairs
Use Stairs motions to ascend and descend stairs.
To move safely on the stairs, use an “align” motion to turn ASCENT to face the stairs.

 WARNING

	z ASCENT must be aligned to face the stairs.
If ASCENT attempts to climb stairs diagonally, it may lose its balance and topple over.
	z If a marker-like reflector or other marker is near a stairs marker, it will need to be removed.
When another marker or reflector is nearby, ASCENT may incorrectly detect its marker and 
collide, fall, or slip.

1 Add the motion after the path motion on the 10th line.

2 Select “align” from the list.
The motion property screen appears.

3 Select [line] for [Facing Target].
Select [line] to automatically detect linear structures such as a stair step, and rotate ASCENT to 
face it.



7-77 L5-59EU024 R00

Chapter 7 Creating a Simple Scenario

4 Click the [OK] button.

5 Add another motion after the align motion.

6 Select “stairs” from the list.
The motion property screen appears.

7 Click the [Object Selection] button, then click the stairs icon on the map.

8 Select [Climb].

9 Click the [OK] button.
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	■ Defining a motion to load the 2nd floor map
A floor map must be loaded whenever moving between floors.
After climbing to the 2nd floor, use the load-map motion to load the 2nd floor map.

1 Add this motion after the stairs motion.

2 Select “load-map” from the list.

3 Select the 2nd floor map from the list of map names.

4 Click [Select from Map] to set ASCENT’s initial position and attitude.
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5 Click the [OK] button.

	■ Add the 2nd floor movement and audio recording motion
On the 2nd floor, create a path motion to move to the target, a motion to record the sound around the 
target, then another return to the stairs.
First register the target where the audio is to be recorded, then add the motions in the following order.
	z path
	z record-audio
	z path
	z rotate-to-point

First register the target where the surrounding sound is to be recorded.

1 Open the 2nd floor map with Scenario Maker.
On the [Layer] tab, right-click the 2nd floor map and select [Set to Current Map].

2 On the [Object] tab, click [Target], then click where you want to record the audio.

3 Right-click on the target icon and select [edit].
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4 Enter the Target Name and click the [OK] button.

Next, create motions for the path and audio recording.

5 Record the path from the stairs to the target.

6 Add a new motion after the load-map motion and select “path” from the list.

7 Select the path recorded according to the steps in5.

8 Add another new motion after the path motion and select “record-audio” from the list.
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9 Click the [Object Selection] button, then click the target icon on the map.

10 Specify the recording time and volume, and click the [OK] button.

11 Record the path from the target to the stairs.

12 Add a new motion after the record-audio motion and select “path” from the list.

13 Select the path recorded according to the steps in11.

14 Click the [select from map] button for [Stopped Heading] and point the arrow at the stairs.

15 Click the [OK] button.

 WARNING

	z ASCENT must be aligned to face the stairs.
If ASCENT attempts to climb stairs diagonally, it may lose its balance and topple over.
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	■ Define a motion to descend the stairs
The motion to descend the stairs is defined just like that for ascending the stairs.
No align motion is available when descending stairs.

 WARNING

	z If a marker-like reflector or other marker is near a stairs marker, it will need to be 
removed.
When another marker or reflector is nearby, ASCENT may incorrectly detect its marker and 
collide, fall, or slip.

1 Add the motion after the rotate-to-point motion.

2 Select “stairs” from the list.
The motion property screen appears.

3 Click the [Object Selection] button, then click the stairs icon on the map.

4 Select [Descend].

5 Click the [OK] button.
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	■ Define motions to load the 1st floor map and move to the Charging Station
Drive ASCENT to the 1st floor and define the motions after descending the stairs.
First define a load-map motion to load the 1st floor map.
Then define the path motion from the stairs to the Charging Station.

1 Add a load-map motion after the descending stairs motion.

2 Select the 1st floor map in the motion properties.

3 Record the path from the stairs to the Charging Station.

4 Add a new motion after the load-map motion and select “path” from the list.

5 Select the path recorded in Procedure 3.
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6 Click the [select from map] button for [Stopped Heading] and set the arrow to point at the 
correct heading to enter the Charging Station.

7 Click the [OK] button.

Make sure the scenario you created is the same as the one shown in page 7-73.
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7.11.7 Test run the scenario
After creating a scenario, test it to ensure that it works.
See “7.7 Test Run the Scenario” (page 7-57) for details on how to execute the scenario.

 DANGER

	z When ASCENT is traversing stairs, stay away from the bottom of the stairs.
If ASCENT slips and hits you, there is a danger of serious injury, such as broken bones.

 WARNING

	z When testing a scenario, be sure that an attendant accompanies ASCENT to monitor its 
status.
	z When ASCENT is being driven on stairs, an attendant must ensure that ASCENT moves 
straight along the stairs.
If ASCENT enters stairs diagonally, it may lose its balance and fall or slip.
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7.12 Measuring the Pinpoint Temperature of a Heat 
Source Object

Measure the temperature at a pin-point target location.
In order to measure the temperature at a heat source correctly, the precise position of the heat source 
must be indicated by markers.

Temperature 
measurement target 
(heat source)
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Two types of markers are used to register a heat source object.
	z Positioning markers (2)
These markers accurately indicate the position of the heat source (temperature measurement 
target) so that it can be correctly imaged with the thermal imaging camera during automatic patrol. 
These are located within about two meters in front of ASCENT.
	z Heat source teaching marker (1)
This marker indicates the precise position of the heat source when registering the heat source 
object. It can be removed after registering the object.

Positioning marker Heat source teaching marker
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7.12.1 Considering where to capture an image of the heat source 
object

ASCENT has a thermal imaging camera on each side. When shooting with a thermal imaging camera, 
ASCENT should face sideways to the heat source.
To image a heat source object, consider where to stop ASCENT and whether to use the left or right 
thermal imaging camera.
Also, since positioning markers are required to accurately measure the position of the heat source 
object, confirm there is room for the markers to be placed in front of the imaging position. Check 
for other markers or reflectors near the positioning markers. If there are other markers or reflectors, 
ASCENT may misdetect the markers and be unable to make correct measurements.

Using the right-side thermal imaging camera Using the left-side thermal imaging camera
Marker

Direction of 
travel

Direction of 
travel

Marker

Heat Source Heat Source
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	■ About distances from the heat source and markers
Distance from heat source
The distance of the thermal imaging camera from the heat source should be about 2 to 3 m. At 
distances less than or greater than that, measurement can still be performed as long as the heat 
source is visible on the thermal imaging camera, but measurement accuracy will be lower if the heat 
source is farther away.
Distance to the markers
As a guide, the distance from the center of ASCENT to the markers should be about 2 m. If they 
cannot be installed at a distance of 2 m, install them within the range of 1 to 3 m.
Distance between markers
As a guide, the distance between the two markers should be about 0.5 m. If there are no other 
markers in the vicinity, the space may be wider. If there is another marker in the vicinity, it may be 
mistakenly recognized. When there are multiple markers, they will be detected in order starting with 
the nearest.

0.5 m

2 m

2 to 3 m
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7.12.2 Start creating the scenario
Modify the existing scenario to create a scenario similar to the following. Add a motion to measure 
pinpoint temperature near the end of the existing scenario (from line 18 onwards).
Line No. Motion ASCENT behavior

1 charging-station Exit the Charging Station

2 load-map Load a map

3 path Move to a target

4 rotate-to-point Face the step

5 obstacle Drive over a step

6 path Move to a target

7 arm-joint Extend the manipulator

8 record-image Capture a still image

9 arm-joint Restore the manipulator

10 path Go to the stairs

11 align Face the stairs

12 stairs Climb the stairs

13 load-map Load the 2nd floor map

14 path Move to a target

15 record-gas Measure gas concentration

16 path Move to the stairs

17 rotate-to-point Face the stairs

18 stairs Descend the stairs

19 load-map Load the 1st floor map

20 path Move to the heat source imaging position

21 record-thermal Measure the pinpoint temperature

22 path Move to the Charging Station

23 rotate-to-point Turn around for docking

24 charging-station Dock in the Charging Station

1 Open the [Project] tab in Scenario Maker.

2 Click [Open Scenario].

3 Select the scenario you created in  “7.11 Adding Stairs” (page 7-65), and click the [OK] 
button.
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7.12.3 Define a motion to move to the heat source imaging position

1 Execute [Scenario Load] on the [Execute] tab of Scenario Maker.

2 Teleoperate ASCENT to drive it to the bottom of the stairs (the position where the stairs 
motion of the existing scenario ends).

3 Start path recording with Scenario Maker.

4 Teleoperate ASCENT to drive it to the heat source object imaging position.

5 Stop path recording and save the path.

6 Click on [...] for the path motion in the 20th line of the scenario.

The motion property screen appears.

7 Change the reference path to the path saved in step 5.
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7.12.4 Register (teach) the heat source object

1 Open the [Predefined Motions (Navi)] tab on the Teleop screen.

2 Click the [Video] button under [360° optical camera] in the [Predefined Motions] panel.
The image of the 360° optical camera appears. The frames appearing in this image represent 
the fields of view of the thermal imaging cameras. Adjust the position of ASCENT so that the heat 
source is within a field of view.

3 Select [Thermal Image Teaching] in the [Predefined Motions] panel and click [Execute].

The [Thermal Image Teaching] screen appears.
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4 In [Heat source camera select], choose [Left] or [Right] according to the location of the heat 
source.

4

5

5 Select [360° Image] in [Distribution].
The 360° optical camera image on the side with the heat source is displayed. The frames 
appearing in this image represent the fields of view of the thermal imaging cameras.

Thermal imaging 
camera field of view

Next determine the position of ASCENT when imaging.
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6 Install two positioning markers.
The two markers are installed in front of ASCENT, where 3D LiDAR can catch them. Install the 
two markers as near as possible to 50 cm apart. Read “About distances from the heat source and 
markers” (page 7-89) for details about the installation position of the markers.

Temporarily place the markers, then confirm that each positioning marker appears as 1 or 2 in 
[Marker Information] on the [Thermal Image Teaching] screen, and if so, affix the markers.

12 12

8

10

If a marker number does appear on the [Thermal Image Teaching] screen, reposition the marker 
while checking the screen.
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7 Measure the distance between the thermal imaging camera and the heat source with a tape 
measure.

8 Enter the distance measured in [Distance between Camera and Temperature Measurement 
Point] on the [Thermal Image Teaching] screen.
Next, teach the temperature measurement point.

9 Place the thermal image teaching marker in front of the heat source.

Teaching marker
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10 Select [Thermal Image] in [Distribution].
The image from the 360° optical camera displayed in the [Predefined Motions (Navi)] tab changes 
to that from the thermal imaging camera. A green square appears at the center of the image.

Depending on the attitude of the sub tracks, one may obstruct the view of the thermal imaging 
camera, and the heat source may not be visible or the image may be distorted. In that case, click 
the [Down (5°)] button to lower the sub tracks on the thermal imaging camera side.

11 While watching the thermal camera image on the Teleop screen, press the D-pad keys on 
the gamepad to move the green frame on the screen to the position of the teaching marker.
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12 Click the [Teaching Settings] button.
The teaching settings are processed and the still images captured by the thermal imaging camera 
and the 360° optical camera are displayed. If teaching succeeded, a red cross will appear in the 
center of the teaching marker on the still image of the thermal imaging camera.
Also, XYZ coordinates appear for the [Teaching Result] on the [Thermal Image Teaching] screen.
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If the message “Teaching failed” appears
Change the size and position of the green frame and retry with the new teaching settings.
If you examine the teaching marker in the thermal image, the border appears dark with a slightly 
brighter inside area. When teaching, the teaching position settings are determined by the border and 
the brightness inside the border. If anything inside the green frame appears brighter than the area 
inside of the border, it may interfere and prevent correct detection. Therefore, if anything bright is in 
the green frame, reposition or reduce the size of the frame to exclude it.
The whole teaching marker does not need to be included in the green frame.

Failure Example Success Example

An object (human hand) appears brighter than 
the teaching marker in the green frame, so the 
teaching frame cannot be identified.

Reduce the size of the green frame to exclude 
bright objects. Although part of the teaching 
marker is outside of the green frame, there is no 
problem with teaching.
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Moving and resizing the green frame
Move the green frame using the D-pad keys on the gamepad.
Resize the green frame by changing the [Normalization Range] values on the [Thermal Image 
Teaching] screen. The [Normalization Range] specifies the coordinates of the upper left (U1, V1) and 
lower right (U2, V2) of the green frame. Change the values as needed and click the [Change Image] 
button. The position and size of the green frame will change.

For manual setting case

If teaching still fails after the above procedure, use the following procedure to manually specify the 
temperature measurement point.

1 Check [Temperature measurement point coordinates Manual setting].

2 Move the green frame with the D-pad keys on the gamepad so that the temperature 
measurement point is centered in the frame.

3 Click the [Teaching Settings] button.
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	■ Propagating teaching results to the heat source object

1 Open the Scenario Maker’s [Object] tab.

2 Click [Heat Source], move the mouse over the map, and place the icon on the heat source 
object.

3 Right-click on the heat source icon and select [edit].
The Heat Source Setting screen appears.
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4 Click [Teaching Result Acquisition].
The teaching results for the heat source object are acquired from the Teleop screen.

5 Select [New Registration] in the [Target Name] list and enter a name in the text box below.

6 Click the [OK] button.
A Target ID is assigned, and the target information is saved in the cloud.
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7.12.5 Defining motions
Add a record-thermal motion to the scenario and extend the scenario to return to and enter the 
Charging Station.

1 Add a new motion after the path motion (line 20).

2 Select “record-thermal” from the list of motions.
The motion property screen appears.

3 Click the [Object Selection] button, then click the Heat Source icon on the map.

4 Click the [OK] button.
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5 Record the path from the heat source object image capture location to the Charging 
Station.

6 Add a new motion after the record-thermal motion, and select “path” from the list.

7 Select the path recorded in Procedure 4.

8 Click the [select from map] button for [Stopped Heading] and set the arrow to point at the 
correct heading to enter the Charging Station.

9 Click the [OK] button.
Make sure the scenario you created is the same as the one shown in page 7-90.

7.12.6 Test run the scenario
After creating a scenario, test it to ensure that it works.
See “7.7 Test Run the Scenario” (page 7-57) for details on how to execute the scenario.

 WARNING

	z When testing a scenario, be sure that an attendant accompanies ASCENT to monitor its 
status.
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7.13  Scenario Creation Example for Areas Separated By 
Stairs/Steps

7.13.1 For areas separated by stairs
	■ Mapping procedure

This example creates maps for traveling on two floors with stairs in between, as shown in the figure 
below.

1F-a

2F
D

W

1F-b
Dimensional limits (W and 
D): at least 900 mm

1 Create and save a map of 1st floor “a” (1F-a).

2 Climb the stairs to the 2nd floor.

3 Create and save a map of the 2nd floor (2F).
Rotate in place and measure in all directions.

4 Descend the stairs to 1st floor “b” (1F-b).

5 Create and save a 1F-b map.
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	■ Scenario creation example

1F-a

2F

1F-b

Line No. Motion Contents
1 charging-station Exit
2 load-map Load the 1F-a map.
3 path Move to the bottom of the stairs (1)
4 rotate-to-heading Face the stairs (2)
5 stairs Ascend the stairs (3)
6 load-map Load the map of the 2nd floor (4)
7 path Move to the top of the stairs (5)
8 rotate-to-heading Face the stairs (6)
9 stairs Descend the stairs (7)
10 load-map Load the 1F-b map (8)
11 path Move on the 1F-b path (9)

Note
	z A load-map motion must precede the path motion. If a path motion is executed without a preceding 
load-map motion, a scenario execution error occurs. (“15.2.1 Scenario errors” (page 15-3))
	z If the stairs are narrow and do not need to be driven, the path motion of line 7 is unnecessary. The 
load-map motion on the 6th line and the rotate-to-heading motion on the 8th line are still required.
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7.13.2 When a floor is completely bisected by a step
	■ Mapping procedure

In the following case, create a map of each area (left and right) with the step in between.
If possible to make a single map by driving around without crossing the step, its unnecessary to create 
maps for the two areas.

1F-a

1F-b

Dimensional limit: no more 
than 200 mm high

1 Create and save a map of 1F-a.

2 Cross the step to move to 1F-b.

3 Create and save a map of 1F-b.
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	■ Scenario creation example

1F-a

1F-b

Line No. Motion Contents
1 charging-station Exit
2 load-map Load the 1F-a map.
3 path Move to the front of the step (1)
4 rotate-to-heading Face the step (2)
5 obstacle Cross the step (3)
6 load-map Load the map of 1F-b (4)
7 path Move along the path of 1F-b (5)
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7.13.3 When there is a ramp between areas
This example creates a scenario when there is a ramp between areas.
The maximum allowable height of the ramp is about one meter (depending on the environment).

1F

2F

Maximum 1 m

	■ Scenario creation example

Line No. Motion Contents
1 charging-station Exit
2 load-map Load the map of the 1st floor
3 path Move to the bottom of the ramp (1)
4 subtrack Set the sub track angles to 33 degrees in front and -33 

degrees in back (2)
5 path Move onto the ramp (3)

	y Set the end of the path to the end of the ramp
	y Turn off Obstacle Detection

6 subtrack Set the front and back sub track angles to 110 degrees 
(4)

7 load-map Load the 2nd floor map
8 path Move on the 2nd floor path
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This section describes the procedures for creating maps and registering objects using Scenario Maker.

Before creating a map, consider the inspection target locations and the patrol route.

To create a map, drive ASCENT around the patrol area.
The person operating Scenario Maker and the Teleop Terminal needs to work together with an attendant 
accompanying ASCENT around the patrol area. Maintain contact by mobile phone to confirm the situation 
around ASCENT.

8.1 Scenario Maker Screen Configuration

This section describes the screen configuration of Scenario Maker.
When launching Scenario Maker, the following screen appears.

Recover button,
Redo button

Project tab,
Execute tab,
Object tab Scenario status

Viewpoint Reset 
button

Layer tab, Scenario tab Map

Chapter 8 Creating a Map
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	■ Scenario status
The execution status of a scenario is displayed when the scenario is executed by Scenario Maker.

Status Description and Action
Waiting for scenario to 
load

No scenario is loaded in ASCENT. To execute a scenario in ASCENT, click 
the [Scenario Load] button to load the scenario.

Sending scenario The scenario is being sent to ASCENT.
Loading scenario ASCENT is loading the scenario.
Waiting for start After loading the scenario, ASCENT is ready to execute it.
Scenario running ASCENT is executing the scenario.
Scenario paused The scenario is paused in ASCENT.
Another scenario is 
running

ASCENT is running another scenario.

Robot communication 
not possible

Cannot communicate with ASCENT. Check the communication status.

Scenario data error There is an error in the scenario data sent to ASCENT. Hover the mouse 
over the scenario status to see the scenario error. For details, see “15.2 
Troubles Using Scenario Maker” (page 15-3).

Scenario ZIP error There is an error in the scenario ZIP data sent to ASCENT.
Error occurred An anomaly occurred while running the scenario.
Unknown error An unknown error occurred.

	■ [Viewpoint Reset] button
Switches the map perspective to directly overhead.

	■ [Project] tab
Use to start creating a scenario or map, or to open an existing scenario or map.
These tabs display menu buttons, maps, and scenario information.

Menu buttons

Button Description
Create New Scenario Starts creating a new scenario.
Open Scenario Opens an existing scenario.
Create New Map Starts creating a new map.
Open Map Opens a created map.
Save Scenario Saves the scenario being editing.
Options Sets whether to allow expert settings. It also displays the name of the 

connected robot and the version of Scenario Maker.
End Closes Scenario Maker.
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	■ [Execute] tab
Use when creating a scenario. For details on the operating method, see “Chapter 9 Creating a 
Scenario” (page 9-1).

	■ [Object] tab
Use to register an object on a map. For details on the operating method, see “8.5 Registering Objects” 
(page 8-9).

	■ [Layer] tab
Displays a map of each floor used in a scenario.
Click the [+] button to open a map.

	■ [Scenario] tab
Specify the motions to execute in the scenario, their order of execution, and the behavior of each 
motion.

	■ Map area
Displays the map being used in the scenario and indicates the location of ASCENT.
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8.2 Basic Procedure for Creating Maps/Scenarios

This is the basic procedure for creating a map/scenario. See the referenced chapters for details.
When creating maps and scenarios, ASCENT is controlled by teleoperation. Before operating 
ASCENT for the first time, read “Chapter 14 Basic ASCENT Operation” (page 14-1).
Also, before creating a map or scenario for the first time, read “Chapter 7 Creating a Simple Scenario” 
(page 7-1).

1 Start Scenario Maker and the teleoperation screen on the Teleop Terminal.

2 Click [Create New Scenario] to start creating a scenario.

3 Click [Create New Map] to start creating a map.

4 Create a map by teleoperating ASCENT. (See “8.3 Creating a Map” (page 8-5))

5 Name and save the map.

6 Click [Open Map] in Scenario Maker to open the created map.

7 Position object icons on the map. (See “8.5 Registering Objects” (page 8-9))
Position icons for the Charging Station, targets (inspection points), heat source objects, stairs, and 
steps.

8 Define ASCENT’s behavior as a series of motions to be performed. (See “9.4 Add a Motion” 
(page 9-12))
Define the motions by teleoperating ASCENT.

9 Test executing the created scenario. (See “9.6 Executing a Scenario” (page 9-45))
If a scenario is not yet complete, you can execute just selected motions.

10 Name the scenario and save it to the cloud.
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8.3 Creating a Map

Create a map by teleoperating ASCENT.

1 Click [Create New Map] on the [Project] tab of Scenario Maker.
The screen changes to Map Creation Mode.

2 Open the [Truck] tab on the Teleop screen, and drive ASCENT around the patrol route.
As ASCENT moves, the map is created on the Scenario Maker screen.
Drive around the patrol area and return to the Charging Station.
Map creation has succeeded if the shapes of the walls surrounding the area are clearly delineated 
on the map. Proceed to the next step to save the map.
If walls appear on the map as multiple or distorted lines, map creation has failed. Click [Clear Map] 
and try recreating the map.

3 Click [Store Map] in Scenario Maker.
A dialog to enter the name of the map appears.

4 Enter the name of the map and click the [Save] button.
The map is saved on the Teleop Terminal.

5 Click [End]
Map Creation Mode exits as the previous Scenario Maker screen reappears.

To patrol different floors, create a map of each floor.
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8.4 Key Points for Mapping Large Areas

This section provides some pointers for creating maps of large areas.
	z The starting point for map creation does not necessarily have to be near the Charging Station. It’s 
easiest to create a clear map by starting from a place like a corner with surrounding walls.
	z Begin creating a map by driving a peripheral lap route with the largest possible circumference up to 
about 300 m.

100m

5
0
m

: This route laps the periphery, then “fills” the central passage (described later)
: This route takes a small lap around the left half, then loops around the right half
: This route laps the right half, then fails to complete a full lap around the left half

Note
When mapping a large area, although the map may initially become misaligned during creation, 
you should continue driving without concern. There is no problem after the deviation is corrected 
(performed automatically) when map creation is finished (when saved).

	z When the area’s periphery is more than 300 meters in circumference, divide it into multiple mapping 
areas.

Area A Area B

Area C

	z First make a rough map of the entire area, then go into the details to complete the map.
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	z When creating a map by driving a lap route, include at least some overlap.

	z To drive on stairs or climb over a step of 200 mm or more, create separate maps for before and 
after the stairs or step. Do not drive on stairs or steps when creating a map.
	z While creating a map, drive as close as possible (within 5 m) to structures such as walls.

2
0

 m

	z Mapping success or failure is determined by the presence of double imaging of walls and corners. It 
is easy to determine if there is a misalignment by temporarily installing a partition screen as shown 
in the photos below. However, if the screen is too large, autonomous driving may be adversely 
affected when it is removed, so it should be no larger than 1.5 m3.

One mark or wall 
appears doubled
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Here is a sample map created at a location with about a 300-meter periphery. As mentioned above, 
the outer periphery was driven first, followed by inner details.

In the satellite image below, the mapped area is in the red frame.

Source: Google Map, Image © 2022 Google, © 2022 Digital Earth Technology, 
Maxar Technologies, Map Data © 2022
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8.5 Registering Objects

Place the Charging Station and targets to be monitored on the map. Objects placed on the map are 
used to create a scenario.
The types of objects that can be registered are as follows.

Charging Station Registers the Charging Station.

Target Registers an inspection target. This applies to still image capture, 
audio recording, and gas concentration measurement.

Heat Source Object Registers a location where pinpoint temperature is to be measured 
using a thermal imaging camera.

Stairs Registers stairs that ASCENT will traverse when patrolling.

Difference in level Registers a step that ASCENT will traverse when patrolling.

The location of an icon on the map is merely a guide. The precise position is specified later by actual 
teleoperation when creating the scenario.
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8.5.1 Basic object registration procedure
The procedure common to all objects is shown below.

1 Click [Open Map] on the [Project] tab of Scenario Maker.

2 Select a map and click [OK].

3 Open the [Object] tab.

4 Click the object type, move the mouse to the map, and click the desired placement location.

5 Right-click the icon of the placed object and select [edit].

6 Make appropriate settings in the object’s dialog box.
The object’s settings are saved in the cloud.

	■ To delete an object
Right-click on the icon on the map and select [delete].
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8.5.2 Charging Station placement
Click [Charging Station], move the mouse to the map, and click the desired placement location.
There are no setting items for the Charging Station, so registration is complete.

8.5.3 Target placement
Register a target location where you want to capture a still image, record audio, or measure gas 
concentration.

1 Click [Target], move the mouse to the map, and click the desired placement location.

2 Right-click on the target icon and select [edit].
The [Target Setting] screen appears.

3 Select [New Registration] in the [Target Name] list and enter a name in the text box below.

4 Click the [OK] button.
A Target ID is assigned, and the target information is saved in the cloud.

	■ Setting up a previously registered target
To use a target previously registered in another scenario, perform the following operations on the 
[Target Settings] screen.

1 Click the [...] button for the [Target Name] and select [Targets List Acquisition].

2 Select the target name from the [Target Name] list.

8.5.4 Heat source object placement
In order to register a heat source object, markers must be installed and teaching performed in 
advance.
For detailed instructions, see “7.12 Measuring the Pinpoint Temperature of a Heat Source Object” 
(page 7-86).
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8.5.5 Stairs registration
To have ASCENT drive on stairs, place the stairs object on the map and enter the actual measured 
dimensions of the stairs.
Measure the width, height and depth of the stairs, and landing dimensions in advance. Also install 
markers at the stairs. (→“5.3 Stairs and Steps Measurement” (page 5-11), “5.4 Stair Marker 
Installation” (page 5-15))
For details on ASCENT’s stair requirements, see“1.4 ASCENT Driving Performance” (page 1-6).

	■ New registration of stairs

1 Click [Stairs], move the mouse to the map, and click the desired placement location.

2 Right-click on the Stairs icon and select [edit].
The settings screen appears.

3 Enter the registration [Name] for the stairs.

4 Select the shape of the stairs in [Landing].

4

3

5

None Select for stairs without a landing.
I-shaped Select for in-line stairs with a bisecting landing.
L-shaped Select for stairs that turn left or right at the landing. Select [Left turn] or [Right turn] 

according to the (upwards) direction of the turn.
U-shaped Select for stairs having a U-shaped landing. Select [Left turn] or [Right turn] 

according to the (upwards) direction of the turn.
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5 Enter stairs dimensions in mm: [Stair 1], [Stair 2], and [Landing Dimensions].
[Stair 1] are for stairs going up to the landing, and [Stair 2] are for those going down from the 
landing. If there is no landing, enter only [Stair 1].
The dimensions to enter are:
	z The width of the stairs
	z First step height and depth
	z Last step height and depth
	z Middle step height and depth
	z Number of Steps

Also, enter the width and depth of the landing in [Landing Dimensions].

6 Click the [OK] button.
Stairs information is stored in the cloud.

	■ Using previously registered stairs
On the Stairs Settings screen, select the previously registered stairs name in [Select Stairs].

1 Click [Stairs], move the mouse to the map, and click the desired placement location.

2 Right-click on the Stairs icon and select [edit].
The settings screen appears.

3 Select the name of the previously registered stairs in [Select Stairs].
The dimensions of the selected stairs are entered.

3
4

4 Uncheck [Copy].

5 Click the [OK] button.
The registered stairs settings are used as is.
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	■ Create new stairs by reusing previously registered stairs settings
You can modify the settings of previously registered stairs to create new stairs.

1 Click [Stairs], move the mouse to the map, and click the desired placement location.

2 Right-click on the Stairs icon and select [edit].
The settings screen appears.

3 Select the name of the previously registered stairs in [Select Stairs].

3
4
5

6

4 Enter a new stairs (staircase) name in [Name].

5 Check [Copy].

6 Change the values for the stairs and landing as needed.

7 Click the [OK] button.
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	■ Add stairs and landings to previously registered stairs and register as new 
stairs

If there are more stairs or landings after previously registered stairs, you can add settings to the 
existing stairs and register them as new stairs.
Here, the original stairs are referred to as “stair_A” and the new stairs are referred to as “stair_B”.

1 Click [Stairs], move the mouse to the map, and click the desired placement location.

2 Right-click on the Stairs icon and select [edit].
The settings screen appears.

3 Select “stair_A” in [Select Stairs].

3
4

6

5

4 Enter “stair_B” in [Name].

5 Check [Connect to lower stairs] and select “stair_A” from the list below.
The dimensions of the selected stairs are displayed in [Stair 1]. [Stair 1] cannot be modified.

6 Enter the measured values for [Stair 2] and [Landing Dimensions].
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7 Click the [OK] button.
A new staircase (stair_B) is registered as a staircase that includes the original staircase (stair_A).

2F

1F

stair A

stair B

Note
To move from the 1st to the 2nd floor of the figure, select “stair_B” as the stairs motion object. It is 
not necessary to specify “stair_A”.
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8.5.6 Step registration
To register a step, measure the height (front and back sides in the direction of travel) and depth of the 
step in advance.

1 Click [Steps], move the mouse to the map, and click the desired placement location.

2 Right-click on the Step icon and select [edit].
The settings screen appears.

3 Enter the heights and depth.

Height A: Enter the height of the front side in the direction of travel.
Height B: Enter the height of the back side in the direction of travel.
Depth: Enter the depth of the step.

4 Click [OK].
Step information is saved in the cloud.

Note
For a step that only ascends, enter the value of Height A, and 0 for Height B and depth. For a step that 
only descends, enter the value of Height B, and 0 for Height A and depth.
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MEMO
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9.1 Scenario Creation Overview

A scenario is a sequence of instructions that define ASCENT’s behavior during automatic patrol.
All scenarios begin and end with undocking (Exit) and docking (Entry) from/to the Charging Station.
Between those events are defined ASCENT’s movements and target inspection actions (still and 
thermal image capture, sound recording, etc.).
Every action such as undocking/docking, movement, and inspection is defined by a command called a 
“motion”.

The standard scenario flow is as follows.

ASCENT behavior Motion
Exit Charging Station charging-station
Load the 1st floor map load-map
Move to a target path

rotate-to-point, etc.
Capture the target image record-image
Move to next target path

rotate-to-point, etc.
Measure pinpoint temperature record-thermal
Move to stairs path

align etc.
Climb the stairs stairs
Load the 2nd floor map load-map
Move to a target path

rotate-to-point, etc.
Record target audio record-audio
Move to stairs path

rotate-to-point, etc.
Descend the stairs stairs
Load the 1st floor map load-map
Return to Charging Station path

rotate-to-point, etc.
Dock at Charging Station (Entry) charging-station
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9.1.1 Motion list
Each operation such as docking /undocking, movement, and inspection is defined by a “motion” 
command.
Here are the types of motions:

Name Description Page
align Turn ASCENT to face an object (wall, stairs, etc.). 9-20
arm-delta Move the manipulator by specifying position or attitude deviation. 9-29
arm-joint Change the attitude of the manipulator. 9-26
charging-station Undock (Exit) and dock (Entry) from/to the Charging Station. 9-12
hand Open and close the manipulator hand. 9-31
led Switch the LED lighting on/off. 9-37
load-map Load a map. 9-13
move-to-point Move in a straight line to a specified point. 9-18
obstacle Drive over a step. 9-39
path Move on a specified path. 9-15
play-audio Play a sound source. 9-41
record-audio Record ambient sound. 9-36
record-gas Measure gas concentration. 9-35
record-image Capture a still image. 9-32
record-thermal Measure the pinpoint temperature. 9-34
rotate-to-heading Turn to face the specified direction. 9-20
rotate-to-point Turn to face the specified point. 9-19
stairs Ascend and descend stairs. 9-38
stop-audio Stop playing the sound source. 9-41
subtrack Change the angles of the sub tracks. 9-40
wait Wait for the specified number of seconds. 9-42
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9.2 Start Creating a Scenario

9.2.1 Creating a new scenario
To create a new scenario, click [Create New Scenario] on the [Project] tab in Scenario Maker.
To open a saved scenario, select [Open Scenario] on the [Project] tab.

9.2.2 Re-use an existing scenario
You can create a new scenario by re-using an existing scenario.
If you re-use an existing scenario, maps registered in the existing scenario can be used as-is. You can 
also add new maps.
To create a new scenario from an existing scenario, open the existing scenario with [Open Scenario] 
on the [Project] tab of Scenario Maker, and save it with a different name using [Save Scenario].
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9.2.3 Opening the map
Open the map(s) used in the scenario.
To open a map, select [Open Map] on the [Project] tab.
You can also open it by clicking the [+] button on the [Layer] tab.

[Layer] tab

To move on multiple floors, open the maps for all floors.
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9.2.4 Expert settings
Enable expert settings to make the following settings on the [Project] tab:

Item Function
Self-diagnostics (Perform before patrol/
Perform after patrol)

Set whether to perform self-diagnostics before or after the 
patrol.

Status Output Cycle Set how often the status is sent to the cloud during 
scenario execution.

Periodic Image Upload Set the interval for uploading images from the 360° optical 
camera to the cloud.

Angle Deviation Tolerance during Turns Set the turning angle tolerance.

To enable expert settings, set [Enable Expert Settings] to [Setting Enabled] under [Option] on the 
[Project] tab.
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9.3 Basic Motion Operations

Create a scenario on the [Scenario] tab. Define the motions that ASCENT will perform in the order of 
execution.
Two motions, charging-station undocking (Exit) and charging-station docking (Entry), are automatically 
set for any new scenario. All other motions are added between these.

9.3.1 [Scenario] tab screen configuration
The [Scenario] tab for creating scenarios has the following screen configuration.

Line No.

Motion name

Select a motion

Display the motion property screen

Add motion before

Delete motion

Add motion after

Map name

Motion content
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9.3.2 Add a motion
To add a motion, do the following:

1 Click one of the [+] buttons to the right of an existing motion.
Click the [+] button above a motion add it before the motion, or click the [+] button below a motion 
to add it after the motion.
Clicking adds a blank motion with no name.
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2 Click ▼ and select the desired motion name to be added from the list.

The setting screen for that motion appears.
For motions that do not require any settings, no setting screen appears.

3 Make the motion settings.
For each motion’s settings, see “9.4 Add a Motion” (page 9-12).

	■ Delete a motion
To delete a motion, click the [-] button at the right side of the motion.
The corresponding motion is deleted, and subsequent motions shift up.

	■ Change a motion
To change the execution order of motions, drag and drop them as needed.

Use the  (Undo) and  (Redo) buttons to undo or redo the most recent addition or motion edit.
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9.3.3 Motion grouping
You can group a series of motions. For example, you can make long scenarios easier to view by 
grouping first floor motions and second floor motions.
Grouped motions can be collapsed to show only the group name.

1 Right-click on a motion and select [Create Group].
A group containing only the selected motion will be created, and the group name can be entered.

2 Enter the group name.

Group name

3 To add other motions, drag and drop the motions you want to add into the group.



9-10L5-59EU024 R00

Chapter 9 Creating a Scenario

4 Drag and drop all of the motions you want to add into the group as in step 3.

	■ Collapse and display groups
Click the group name to collapse the motions in the group and display only the group name.
Click the group name again to see all of its motions.
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	■ Delete a group

1 Right-click on the group name to display the menu.

2 Click [Delete only group] or [Delete group and its contents].
	z Delete only group:  deletes only the group name and leaves the motions as they are. 

The execution behavior of the scenario is unchanged.
	z Delete group and its contents: deletes the group name and motions within the group.

Groups cannot be moved or copied.
One group cannot be created within another group.
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9.4 Add a Motion

This procedure describes how to add a motion to the scenario and define ASCENT’s behavior.

When creating a motion, you can test it. For details on how to do this, see “9.6 Executing a Scenario” 
(page 9-45).

9.4.1 Entry/Exit
Docking (Entry) and undocking (Exit) are predefined charging-station motions. Select either [Entry] or 
[Exit] in the motion properties.
The procedure for adding a new Entry/Exit motion is shown below.

1 Click the [+] button to add a motion.

2 Select “charging-station” from the list.
The motion property screen appears.

3 Select either [Entry] or [Exit] and click [OK].

Whenever a new scenario is created, undocking (Exit) and docking (Entry) Charging Station motions 
are automatically added.
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9.4.2 Loading a map
Load the floor map before traveling on a floor.
Map loading is defined by the load-map motion. Before a map can be loaded, it must be opened in 
Scenario Maker.
Load a map immediately after exiting the Charging Station, and after ascending/descending stairs 
to another floor. To move from one floor to another and back, maps need to be loaded three times: 
immediately after exiting the Charging Station, and immediately after going up and down stairs.

1 Click the [+] button to add a motion.

2 Select “load-map” from the list.
The motion property screen appears.

3
4

3 Select the map to load from [Map Name].
The list shows the names of currently open maps.

4 Set ASCENT’s initial position and attitude when the map is loaded.
Click the [Select from Map] button to move the mouse over the map and drag it to where ASCENT 
will be when the map is loaded. Move the arrow that appears so that its heading matches 
ASCENT’s heading, and then release the mouse button.

Numerical values are set for the [Initial Position Attitude].
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load-map motion properties

Item (units) Description
Map Name Select the map to load. You can select a map that has been opened in 

Scenario Maker.
Initial Position Attitude Set ASCENT’s position and attitude when the map is loaded. Click the 

[Select from Map] button to select a location on the map, and the values 
will be entered automatically.

X (m) Set ASCENT’s initial position on the XYZ axes.
Y (m)
Z (m)
Roll (deg) Set ASCENT’s initial attitude as roll, pitch, and yaw.
Pitch (deg)
Yaw (deg)
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9.4.3 Move to a target
The motion used to move to a target is described here.

	■ Create a path
Specify the path for ASCENT to travel. The path is defined by the path motion.
Drive ASCENT by teleoperation to record the path, and register the recorded path as a motion.
Drive ASCENT as far away from the walls as possible. The obstacle detection function may stop 
operation when running autonomously.

1 Stop ASCENT at the start of the planned path.

2 Click [Scenario Load] on Scenario Maker’s [Execute] tab to load the scenario you are 
creating into ASCENT.

3 Click [Robot Positions] and move the mouse to ASCENT’s location on the map. An arrow 
appears when you drag the mouse, so you can align the arrow with ASCENT’s heading, and 
release the mouse button.

4 Click the [Begin/end path recording] button on Scenario Maker’s [Execute] tab.
Path recording starts.
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5 Open the [Truck] tab on the Teleop screen to remotely drive ASCENT. Drive the planned 
path and stop at the end.

6 Click the [Begin/end path recording] button again.
Path recording ends.

7 In the Path Name dialog that appears, enter the Path Name and click the [Save] button.

The path information is saved with the specified name. This name is the Reference Path used for 
setting the path as a path motion.

8 Add the motion on the [Scenario] tab.

9 Select “path” from the list of motions.
The settings screen appears.

10 Select the path created earlier as the [Reference Path].

10

11

12

11 To change the start/end point of a path from the Reference Path, click [select from map] for 
[Start] or [End], then click the new location of the start or end point on the map.

12 To change ASCENT’s heading when it stops, click the [select from map] button for [Stopped 
Heading].
When you specify [Stopped Heading], ASCENT moves to the end point when the scenario is 
executed, then turns and stops with the specified heading.
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13 The arrow appears when you move the mouse on the map, so when the arrow points in the 
direction you want to stop, click the mouse.

14 Click the [OK] button.
When [Stopped Heading] is specified, a rotate-to-point motion is automatically added after the path 
motion to change the heading.

path motion properties

Item (units) Description
Reference Path Set a reference path. Click the [Edit] button to edit the selected path.
Speed (m/sec) Select the path movement speed.

	y 0.1 m/sec
	y 0.2 m/sec
	y 0.3 m/sec (about 1.2 km/h)

Start (m)
End (m)

Specify coordinates to change the start/end points of the reference 
path. Click the [select from map] button and click a point on the map to 
automatically enter its coordinates.
Click the [Reset] button to reset the settings and revert to the start/end 
points of the reference path.

Goal Discrimination 
Distance (m)

Enter the discrimination distance of the end point.

Obstacle Detection Enable/disable obstacle detection.
Stopped Heading (m) Specify the heading when stopped. Click the [select from map] button and 

click on the map to set the heading.
Turning Speed  
(deg/sec)

Set the turning speed for Stopped Heading motion.

Offset (deg) Specify the angle for fine tuning the Stopped Heading. Specify a positive 
value to turn counterclockwise, or a negative value to turn clockwise.
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	■ Specify a destination point and move in a straight line
A “move-to-point” motion can also be used to move ASCENT. The move-to-point motion moves the 
ASCENT in a straight line to the specified point.

To use a move-to-point motion, click the [Select from Map] button and click the destination point on the 
map. Click to set the [X] and [Y] coordinates of the destination.

move-to-point motion properties

Item (units) Description
Reference Point
	y X (m)
	y Y (m)

ASCENT moves to the point specified by the X-Y coordinates. You can 
specify a point on the map by clicking the [Select from Map] button.

Movement Speed  
(m/sec)

Specify the movement speed.
	y 0.1 m/sec
	y 0.2 m/sec
	y 0.3 m/sec

Turning Speed  
(deg/sec)

Specify the turning speed.
	y 10 deg/sec
	y 20 deg/sec
	y 30 deg/sec

Goal Discrimination 
Distance (m)

Enter the discrimination distance of the end point.



9-19 L5-59EU024 R00

Chapter 9 Creating a Scenario

9.4.4 Adjusting ASCENT’s heading
ASCENT can be turned to change its heading after moving.
The rotate-to-point and rotate-to-heading motions can be used to change the heading.
The align motion can also be used to turn ASCENT to face a staircase or wall.

	■ rotate-to-point motion
Specify a target point and turn to face that point.

To use a “rotate-to-point” motion, click the [Select from Map] button and drag the mouse over the map 
to specify the target point.
A rotate-to-point motion is automatically inserted when [Stopped Heading] is specified for a path 
motion.

Item (units) Description
Reference Point
	y X (m)
	y Y (m)

ASCENT moves to the point specified by the X-Y coordinates. You can 
specify a point on the map by clicking the [Select from Map] button.

Turning Speed  
(deg/sec)

Specify the turning speed.
	y 10 deg/sec
	y 20 deg/sec
	y 30 deg/sec

Offset (deg) Specify the angle for fine tuning the Stopped Heading. Specify a positive 
value to turn counterclockwise, or a negative value to turn clockwise.
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	■ rotate-to-heading motion
Rotates ASCENT to a specified heading.

To use a “rotate-to-heading” motion, click the [Select from Map] button and drag the mouse on the 
map to display an arrow. Adjust the arrow to point to the desired heading for ASCENT, then release the 
mouse button.

Item (units) Description
Heading (deg) Specifies the angle after turning. You can specify the angle on the map by 

clicking the [Select from Map] button.
Turning Speed  
(deg/sec)

Specify the turning speed.
	y 10 deg/sec
	y 20 deg/sec
	y 30 deg/sec

	■ align motion
Rotate ASCENT relative to a wall or staircase before a subsequent motion. Use when needed to face 
stairs and walls.
In the area specified in [Search Range], search for a flat surface such as a wall or a linear structure 
such as a stair step, and face it.
The height of the target structure should be at least 800 mm. If the target structure is too low, it cannot 
be detected.

After defining an align motion, try executing it several times to confirm the correct result.
If it does not face correctly, adjust the search range.
Target structures are easiest to find when 400 to 500 mm in front of ASCENT. If the distance between 
ASCENT and the target is too far or too near when executing the align motion, change the end point of 
the previous motion to adjust the distance to the structure.
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align motion properties

Item (units) Description
Turning Speed  
(deg/sec)

Select the turning speed.
	y 10 deg/sec
	y 20 deg/sec
	y 30 deg/sec

Facing Target Select the type of target to be faced.
	y line: A linear structure like a step or stair on a staircase
	y plane: A flat structure like a wall

Search Range X (m)
	y Min
	y Max

This is the range to search for the object on the X-Y-Z axes relative to 
ASCENT’s 3D LiDAR as the origin.

Search Range Y (m)
	y Min
	y Max

Search Range Z (m)
	y Min
	y Max

Maximum Relative 
Angle (deg)

Set the angle limit for the object and ASCENT.
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9.4.5 Editing a path
You can edit a created path.

1 On the [Object] tab of Scenario Maker, click [Edit Path].

The [Edit Path] screen appears.
The [Edit Path] screen can also be displayed by clicking the [Edit] button to the right of [Reference 
Path] on the path motion property screen.
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2 Select the target map with [Select Map], and select the path to edit with [Select path to edit].

The selected path is displayed on the map by a red line and arrows.
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3 Edit the path.
You can perform the following operations.

Drag an arrow to change the path
Hover the mouse cursor over an arrow to display a red circle at the base of the arrow.
Drag the circle to change the path.

Change the path by dragging the line connecting the arrows
Moving the mouse cursor over the line connecting the arrows changes that segment to a thick line.
Dragging the line adds a new arrow and changes the path.

Delete an arrow
Display a menu by hovering the mouse over an arrow and right-clicking with the red circle 
displayed.
Select [Delete] to delete the arrow. The front and back arrows are reconnected with a straight line.
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You can specify the range of an arrow by dragging it with the mouse while right-clicking. You can 
select [Delete] to delete an arrow at once.

The following commands can be selected from the right-click menu.

forward direction Point the arrow in the direction of travel. An arrow pointing in 
the direction of travel does not change.

backward direction Change the arrow to head opposite to the direction of travel.
change the last direction You can select this for the arrow at the end of the path. It 

changes the arrow’s heading at the end of the path. Select 
the command and drag the arrow to select a new direction.

4 Click the [Save] button on the [Edit Path] screen.
The path is overwritten and saved.

	■ Copying the original path to create a new path
If you do not want to overwrite the original path, copy the path to create a new path, then edit the new 
path.

1 Click the [Copy] button on the [Edit Path] screen.

2 Enter the name of the new path and click the [OK] button.
At this time, if you select [Reverse Path], you can create a path that heads opposite to the original 
path.

3 Edit the path.
Edit in the same way as the above procedure.
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9.4.6 Manipulator operation
Move the manipulator to a specified position.
Use the arm-joint motion for manipulator operation.
Move the manipulator to the target position by teleoperation, and record the angle at that time with 
[Acquiring Current Angle] of the arm-joint motion.

1 Click the [+] button to add a motion.

2 Select “arm-joint” from the list.
The motion property screen appears.

4

3 Open the [Manip.] tab on the Teleop screen and move the manipulator to the target position.
(See “14.8 Manipulator Operation” (page 14-21))

4 Return to Scenario Maker and click the [Acquiring Current Angle] button.
The angle is set.

5 Click the [OK] button.
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arm-joint motion properties

Item (units) Description
Reference number Specify the number to be used for referencing from another motion.

To reference the angles of an existing motion, specify the reference 
number set in that motion.

Acquiring Current 
Angle

Acquire the current angles of the manipulator and set them as the axis 
angle values.

Stowed Attitude Set the stowed (retracted) attitude angles.
Attitude 1 Set the Attitude 1 angles (manipulator extended forward).
Speed (deg/sec) Select the movement speed when changing the attitude.

	y Automatic (default: 15 deg/sec)
	y 1 to 15 deg/sec

S1 axis angle (deg) Set the angle of the S1 axis.
S2 axis angle (deg) Set the angle of the S2 axis.
E1 axis angle (deg) Set the angle of the E1 axis.
E2 axis angle (deg) Set the angle of the E2 axis.
W1 axis angle (deg) Set the angle of the W1 axis.
W2 axis angle (deg) Set the angle of the W2 axis.
Transiting Standby 
Attitude

When turned on, the manipulator transits through the standby attitude 
(whereby the manipulator does not hit ASCENT’s antenna, etc.) during 
attitude changes.

Run Asynchronously When turned on, the next motion starts without waiting for the attitude 
change to finish.

	■ About [Run Asynchronously]
When [Run Asynchronously] is turned on, the next motion starts without waiting for the manipulator to 
move to the target attitude. When off, the manipulator moves to the target attitude before starting the 
next motion.
You can also use a “wait” motion to wait for the manipulator to complete its operation.
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	■ Retracting the manipulator to its driving attitude (stowed attitude)
Before moving ASCENT after operating the manipulator, return the manipulator to its driving attitude.

 CAUTION

	z The manipulator must be stowed before moving.
If you drive without stowing the manipulator, it could hit and injure someone, or hit something 
and damage it.
Also, vibration may cause the manipulator to malfunction.

To return the manipulator to its driving attitude, add an arm-joint motion and click the [Stowed Attitude] 
button, then click the [OK] button.
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	■ Referencing the angles set in another arm-joint motion
The angles set in one arm-joint motion can be referenced from another arm-joint motion. In that case, 
select the [Reference number] of the arm-joint motion you want to refer to as the [Reference number] 
of the referencing arm-joint motion.

	■ Specifying manipulator movement as offsets from the current attitude
Use an “arm-delta” motion.
Specify the amount of movement from the current manipulator attitude. This is specified by movement 
values on the x-y-z axes, or rotation values of roll, pitch and yaw.

1 Click the [+] button to add a motion.

2 Select “arm-delta” from the list.
The motion property screen appears.

4

4

3
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3 Select [Hand Coordinate] or [Base Coordinate] for the [Coordinate System].
Hand coordinates apply to the manipulator’s hand. The direction the hand faces is the Z-axis.
Base coordinates apply to the manipulator arm’s mounting base. The front-back direction of 
ASCENT is the X-axis.

Hand Coordinate

Z

Z
X

Y

Yaw

Pitch

Y

Roll

X

Base Coordinate

4 Specify the amount of movement by position deviation or attitude deviation.
Position deviation moves the manipulator’s hand the specified distance.
Attitude deviation rotates the manipulator’s hand by the specified angle.

5 Click the [OK] button.

arm-delta motion properties

Item (units) Description
Translation Speed (mm/sec) Specifies the translation speed.

	y Automatic (default value: 100 mm/sec)
	y 1 to 100 mm/sec

Position Deviation x (mm) Specifies the translation distance on the X-axis.
Position Deviation y (mm) Specifies the translation distance on the Y-axis.
Position Deviation z (mm) Specifies the translation distance on the Z-axis.
Turning Speed (deg/sec) Specify the turning speed.

	y Automatic (default: 15 deg/sec)
	y 1 to 15 deg/sec

Attitude Deviation roll (deg) Specifies the roll movement angle.
Attitude Deviation pitch (deg) Specifies the pitch movement angle.
Attitude Deviation yaw (deg) Specifies the yaw movement angle.
Turn Center Offset (mm) Shifts the center point for turning motions.
Coordinate System Specifies the coordinate system to be the basis for movement.

	y Hand Coordinate
	y Base Coordinate

Run Asynchronously When turned on, the next motion starts without waiting for the 
attitude change to finish.
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9.4.7 Opening and closing the manipulator hand

NOTE

	z Do not use manipulator to grab sharp objects, objects hotter than 100°C or colder than 
0°C, or chemicals that erode rubber.
Otherwise, the rubber at the manipulator’s fingertips will be damaged.

The behavior of the manipulator hand in a scenario is not suitable for precise operations such as 
grasping objects or pressing buttons.
Use a “hand” motion to operate the manipulator hand. The hand motion specifies whether to open or 
close the hand.

Since the manipulator hand is normally open, first specify a motion to close the hand, then specify a 
motion to open it.

hand motion properties

Item (units) Description
Opening/Closing 
Direction

Select the hand action.
	y Close
	y Open

Run Asynchronously When turned on, the next motion starts without waiting for the hand 
opening or closing to complete.
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9.4.8 Target imaging
Use the record-image motion to capture a still image of a target.

1 Click the [+] button to add a motion.

2 Select “record-image” from the list.
The motion property screen appears.

4

5

3

3 Click the [Object Selection] button, then click the target icon on the map.
The target ID and target name are displayed.

4 Select the imaging camera with [Camera].
[Surveillance Camera], [360° optical camera], [Left Thermal Imaging Camera], or [Right Thermal 
Imaging Camera] can be selected as the imaging camera.
If you select [Surveillance Camera], you can set the [Surveillance Camera Settings].

5 Set the imaging mode in [Surveillance Camera Settings].
Set when [Surveillance Camera] is selected.
The [Surveillance Camera Settings] can be determined by taking a test shot on the [Predefined 
Motions (Navi)] tab on the Teleop screen.

6 Click [OK].
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record-image motion properties

Item Description
Target ID Select the target to be imaged. Click [Object Selection], then click the 

target icon on the map.
Target Name Displays the name of the selected target.
Camera Select the camera to use for imaging.

	y Surveillance Camera
	y 360° Optical Camera
	y Right Thermal Imaging Camera
	y Left Thermal Imaging Camera

Image Format Select an image format.
	y JPEG
	y BMP

Surveillance Camera 
Settings
Imaging mode

If you select the surveillance camera, select the imaging mode.
	y Auto: The exposure is determined automatically.
	y Dark area: Select exposure for dark areas.
	y Bright area: Select exposure for bright areas.
	y Auto Exposure: Determines exposure by measuring luminance in the 
metering area specified in Auto Exposure Zone Setting.

Lighting When on, the light turns on when imaging.
Auto Exposure Zone 
Setting

Specifies the metering area when Auto Exposure imaging mode is 
selected in Surveillance Camera Settings. Click the [Get Area] button to 
capture the metering area settings on the Teleop screen.

	■ Checking inspection results
Images taken during scenario execution can be checked on the [Inspection Summaries] or [Inspection 
History] screen in the cloud.
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9.4.9 Pinpoint temperature measurement
Use a “record-thermal” motion to measure pinpoint temperature at a target location.

On the record-thermal motion properties screen, click the [Object Selection] button, then click the heat 
source icon on the map.
For details on heat source object settings, see “7.12 Measuring the Pinpoint Temperature of a Heat 
Source Object” (page 7-86).

record-thermal motion properties

Item Description
Target ID Select the heat source for temperature measurement. Click the [Object 

Selection] button, then click the heat source icon on the map.
Target Name Displays the name of the selected target.

	■ Checking inspection results
Images taken during scenario execution can be checked on the [Inspection Summaries] or [Inspection 
History] screen in the cloud.



9-35 L5-59EU024 R00

Chapter 9 Creating a Scenario

9.4.10 Gas concentration measurement
Use a “record-gas” motion to measure gas concentration around a target.

On the record-gas motion properties screen, click the [Object Selection] button, then click the target 
icon on the map.

record-gas motion properties

Item Description
Target ID Select the measurement target. Click [Object Selection], then click the 

target icon on the map.
Target Name Displays the name of the selected target.

	■ Checking inspection results
To see the measurement results after executing a scenario, select the relevant target on the 
[Inspection History] screen of the cloud, and open the [Detail] tab.
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9.4.11 Target audio recording
Use a “record-audio” motion to record sound around a target.
Select the Target ID on the property screen.

On the record-audio motion properties screen, click the [Object Selection] button, then click the target 
icon on the map.

record-audio motion properties

Item (units) Description
Target ID Select the target to record. Click [Object Selection], then click the target 

icon on the map.
Target Name Displays the name of the selected target.
Recording Time (sec) Sets the recording time.

	y 1 to 50 sec
Volume (%) Specifies the volume.

	y 1 to 100%

	■ Checking inspection results
Inspection results can be checked on the [Inspection Summaries] or [Inspection History] screen in the 
cloud.
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9.4.12 LED lighting
Use an “led” motion to turn on/off the LED.

For the led motion, you can specify the following lighting patterns.
	z Extinguished
	z Lit
	z Blinks once
	z Blinks twice

When executing a lit or blinking LED motion, the LED will light or blink until the Off “led” motion is 
executed.

led motion properties

Item (units) Description
Pattern Select the on/off pattern.

	y Extinguish (off)
	y Lit (on)
	y Blink once
	y Blink twice

Luminance (%) Specifies the brightness of the LED.
	y 0 to 100 %
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9.4.13 Ascending and descending stairs
Use “stairs” motions to ascend and descend stairs.

1 Click the [+] button to add a motion.

2 Select “stairs” from the list.
The motion property screen appears.

3 Click the [Object Selection] button, then click the stairs icon on the map.

4 Select [Climb] or [Descend].

5 Click the [OK] button.

Stairs motion properties

Item Description
Stairs Name Select a name for the stairs. Click [Object Selection], then click the stairs 

icon on the map.
Direction Specify the direction of travel on the stairs.

	y Climb
	y Descend
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9.4.14 Crossing over a step
Use an “obstacle” motion to cross over a step.

1 Click the [+] button to add a motion.

2 Select “obstacle” from the list.
The motion property screen appears.

3 Click the [Object Selection] button, then click the step icon on the map.
Numerical values registered to the object are set on the property screen.

4 If the [Mounted Height] and [Lowered Height] are opposite to the direction of travel, click 
the [Swap] button.

5 Click the [OK] button.
You can also enter the step heights and depth directly.

obstacle motion properties

Item (units) Description
Object Selection Select the Step object. Click the button and select the step icon on the 

map to set the property values for the step object.
Mounted Height (mm) Specifies the height on the front side in the direction of travel.
Lowered Height (mm) Specifies the height on the back side in the direction of travel.
Depth (mm) Specifies the depth of the step.
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9.4.15 Change the sub track angle
Change the angles of the sub tracks according to the level difference or slope of the floor.
Use a “subtrack” motion to change the angles of the sub tracks.

1 Click the [+] button to add a motion.

2 Select “subtrack” from the list.
The motion property screen appears.

3

3 Enter the [Sub Track Target Angle].
By default, the front angle is 110 degrees and the back angle is 90 degrees. Use these values 
when driving.

subtrack motion properties

Item (units) Description
Reference number Specify the number to be used for referencing from another motion.

To reference the angles of an existing motion, specify the reference 
number set in that motion.

Sub Track Target Angle Specifies the angles for the front left (FL), front right (FR), back left (BL), 
and back right (BR) sub tracks.FL (deg)

FR (deg)
BL (deg)
BR (deg)
Operating Speed Specifies the angular operating speed of the front left (FL), front right (FR), 

back left (BL), and back right (BR) sub tracks.FL (deg/sec)
FR (deg/sec)
BL (deg/sec)
BR (deg/sec)
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	■ Referencing the angles set in another subtrack motion
You can reference the angles set in one subtrack motion for use in another subtrack motion. In this 
case, for the [Reference number] of the new subtrack motion, select the [Reference number] of the 
source subtrack motion you want to refer to.

9.4.16 Audio output
You can play an audio file that has been previously saved in ASCENT.
Use a “play-audio” motion for audio output.

1 Add the motion at the position where you want to play the audio file.

2 Select “play-audio” from the list.
The motion property screen appears.

3
4

3 Specify the sound source number and volume.

4 Select [Repeat] to play the audio file repeatedly.
If [Repeat] is off, the next motion will start when the audio file finishes playing.
If [Repeat] is on, the audio file plays repeatedly until a “stop-audio” motion is executed. To sound 
an alarm during an operation, add a play-audio motion before the operation starts, and a stop-
audio motion after the operation ends.

5 When [Repeat] is on, add a motion at the position where you want to end playback.

6 Select “stop-audio” from the list.
No property screen is displayed for the stop-audio motion because there are no settings.

play-audio motion properties

Item (units) Description
Audio Source Number Specify 1. There is no source other than 1.
Audio Volume (%) Specifies the volume.

	y 0 to 100%
Repeat When turned on, the audio source will play repeatedly.
Run Asynchronously When turned on, the next motion starts during audio output.
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9.4.17 Timing adjustment
Use a “wait” motion to adjust when the next motion executes.
This motion waits for the specified number of seconds, or for the manipulator or sub track operation 
started in the previous motion to complete its operation.

wait motion properties

Item (units) Description
Wait Time (sec) Specifies the wait time.
Wait for completion of 
asynchronous operation of 
manipulator and sub tracks

When on, waits for the manipulator or sub tracks running 
asynchronously in the previous motion to complete.
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9.4.18 About asynchronous execution
The [Run Asynchronously] option is available for subtrack, arm-joint, arm-delta, hand, and play-audio 
motions. Select the [Run Asynchronously] option to start the next motion without waiting for the current 
motion to complete.
If you turn on [Run Asynchronously] for each motion, a scenario error will occur if certain motions 
come next. The following motion combinations cause a scenario error when [Run Asynchronously] is 
turned on.

	■ subtrack motion
If the subsequent motion is one the following, an error will occur.
	z subtrack
	z stairs
	z charging-station
	z obstacle
	z record-audio

	■ arm-joint and arm-delta motions
If the subsequent motion is one the following, an error will occur.
	z arm-joint
	z arm-delta
	z stairs
	z charging-station
	z obstacle
	z record-audio

	■ hand motion
If the subsequent motion is one the following, an error will occur.
	z hand
	z stairs
	z charging-station
	z obstacle
	z record-audio

	■ play-audio motion
Any motion can be specified.
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9.5 Saving a Scenario

Save the created scenario in the cloud.
The scenario is saved in association with the plant name. Scenarios are not saved in the Teleop 
Terminal.

1 Click [Save Scenario] on the [Project] tab.

2 Select [Overwrite Scenario] or [Register as New Scenario] and click the [OK] button.

3 Click [Yes] when the message is displayed.

4 If creating a new scenario, enter its name and click the [OK] button.



9-45 L5-59EU024 R00

Chapter 9 Creating a Scenario

9.6 Executing a Scenario

Execute a scenario while editing. It is possible to execute only a specified line, or from a specified line 
to the end.
To execute a scenario, first load it into ASCENT.

1 Click [Scenario Load] on the [Execute] tab of Scenario Maker.

2 Click [Yes] when the message is displayed.
The scenario loads into ASCENT.
The scenario status changes from [Waiting for scenario to load] → [Sending scenario] → [Loading 
scenario] → [Waiting for start].

2 1 4 5 Scenario status

If ASCENT’s location as displayed on Scenario Maker’s map is different from its actual location, 
specify the current location on the map.

3 Click [Robot Positions] on the [Execute] tab and move the mouse on the map to ASCENT’s 
actual location. Drag to display an arrow, align the arrow with ASCENT’s heading, and 
release the mouse button.
ASCENT’s icon on the screen moves and reorients on the map based its 3D LiDAR data.

4 On the [Scenario] tab, select the line at which to start executing.
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Execute one line of the scenario

5 Click [Executed selected lines].

6 Click [Yes] when the message is displayed.
The motion of the selected line executes. If the motion executed normally, the scenario status will 
be “Waiting for start”.

To execute from the selected line to the end

7 Click [Execute to end].

8 Click [Yes] when the message is displayed.
The motions from the selected line to the last line are executed. If executed normally, the scenario 
status will be “Waiting for start”.

To stop executing the scenario, such as when a motion fails to execute normally, click [Stop].
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Register the date, time and frequency for executing a scenario in the cloud.
Adding or changing schedules requires administrator user privileges.

10.1 To Add a New Schedule

Log in to the cloud and register the schedule.

1 Enter the cloud URL in your Web browser.
The login screen appears.

2 Enter the administrator user ID and password, and click the [Sign In] button.
For user ID and password details, see “13.1 Logging Into the Cloud” (page 13-1).

3 Select [Schedules] from the menu.
The [Schedule List] screen appears.
For screen details, see “10.5 [Schedule List] Screen” (page 10-6).
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4 Click the [Add] button.
The [Schedule Registration] screen appears.

5 Select the [Plant] in which to execute the scenario.
A list of scenarios registered for the selected plant is displayed on the right side of the screen.

5
6
8

9
10

11
12

7

6 Enter the [Schedule Name].

7 Select the scenario to be executed in the scenario list.
Click on the scenario name column to pop up its map and patrol route.

8 Select the ASCENT to be used in [Robot].

9 Set the [Start Date].
Click the [Start Date] and [Start Time] fields, and specify the execution starting date and time.

10 Set the [Cycle].
Select the unit (year, month, week, day, hour) in the first list.
	z [Year], [Week], [Day], [Time]: Enter the cycle (frequency) numerically.
	z [Month]:  In addition to specifying a numerical value for once every few months, you can also 

specify the 10th of every month, the third Friday of every month, and the like.
	z [Week]: Specify the execution day of the week.

11 Specify when to end the scheduled executions with [End].
	z [No Expiration]: No expiration date is set.
	z [Expiration Date]: The schedule will not be executed after the specified date.
	z [Execution Count]:  The schedule will no longer execute after the specified number of 

executions.

12 Select [Plant] or [UTC] as the time zone.

13 Click the [OK] button.
The schedule is registered.
The scenario automatically executes at the execution start date and time.
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10.2 To Change a Schedule

Change a registered schedule.

1 Log in to the cloud as an administrator user.

2 Select [Schedules] from the cloud menu.
The [Schedule List] screen appears.

3 Specify the search conditions and click the [Search] button.
You can specify the plant name, scenario name, and next execution date and time as search 
conditions.
Schedules that match your search conditions are displayed in a list.

4

3

4 Click the [Edit] button for the schedule you want to change.
The [Schedule Registration] screen appears.

5 Change the setting items and click the [OK] button.
For details on the setting items, refer to the previous page.
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10.3 To Delete a Schedule

Delete a registered schedule.

1 Log in to the cloud as an administrator user.

2 Select [Schedules] from the cloud menu.

3 Specify the search conditions and click the [Search] button.
You can specify the plant name, scenario name, and next execution date and time as search 
conditions.
Schedules that match your search conditions are displayed in a list.

4

3

4 Click the [Delete] button for the schedule you want to delete.

5 When the message is displayed, click the [OK] button.
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10.4 To View a Schedule (general users)

General users can only view schedules. They cannot be registered or changed.

1 Log in to the cloud as a general user.

2 Select [Schedules] from the cloud menu.

3 Specify the search conditions and click the [Search] button.
You can specify the plant name, scenario name, and next execution date and time as search 
conditions.
Schedules that match your search conditions are displayed in a list.

3
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10.5 [Schedule List] Screen

Displays a list of registered schedules.
Search area

Schedule list

	■ Search area
Specify search conditions and click the [Search] button to display the schedules that match those 
conditions in the search results. Click ▼ to see additional search conditions.
You can specify the following search conditions:
	z Plant name
	z Scenario name
	z Next execution date and time
	z Schedule name (partial match)
	z Robot name

	■ [Add] button
Create a new schedule.
Not displayed for general users.
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	■ Schedule list
The following information is displayed in the list.
	z Enabled: A valid schedule is checked. If you uncheck it, it will be disabled.
	z Status: Indicates the execution status of the schedule.

: Running

: Waiting

: An error is occurring (will be cleared when the next schedule starts)
	z Plant name
	z Schedule name
	z Scenario name
	z Robot name
	z Next execution date and time
	z Execution cycle
	z Completion date and time

[Delete] button: Deletes the schedule. Not displayed for general users.
[Edit] button: Edits the schedule. Not displayed for general users.
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A scenario with a registered schedule will automatically start a patrol at the scheduled start time. This 
chapter describes auto patrol and how to check the status during auto patrol.

11.1 Scheduled Auto Patrol

At the scheduled operation start time, ASCENT will automatically start patrol.
At the start time, ASCENT first reboots its devices and loads the scenario. Therefore, it takes about 
five minutes for ASCENT to actually start moving.

The Status LED on ASCENT’s main unit changes from yellow (charging) to blinking yellow (exit), and 
then to blue (autonomous) when undocking is completed.
You can check the status of ASCENT during scenario execution on the Teleop screen or on the 
Dashboard.

If the internal pressure is insufficient (3 kPa or less) or the battery voltage is insufficient (25 V or less) 
at the start of auto patrol, auto patrol will not proceed.

Chapter 11 Auto Patrol
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11.2 Real-Time Monitoring on the Dashboard

ASCENT can be checked in real time on the dashboard. The dashboard is displayed in a Web browser 
(Chrome recommended) on your PC or tablet.
Follow the steps below to display the dashboard.

1 Log in to the cloud.
Both administrator users and general users can perform these operations.

2 Select [Robots] from the menu.
The [Robots] screen appears.

3 Specify the plant name and robot name, and click the [Search] button.
ASCENT’s that match your search criteria will be displayed in a list.

3

4

4 Click the [Dashboard] button for the ASCENT you want to check.
The dashboard is displayed.
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	■ Dashboard screen
The Dashboard screen configuration is shown below.

1 2 8 9

3

6

5

4

7

AT

1 Robot
Displays the robot name.

2 Current date and time
Displays the current date and time. The left is the date and time of the time zone set for the PC or 
tablet running the Web browser, and the right is the UTC date and time.

3 Error status
The color indicates ASCENT’s error status.
Green: Normal
Yellow: Warning
Red: Anomaly
Click to display the error status of each module. To check the error/warning details of a module, 
display the Teleop screen and check the error code of the applicable module in the [Status] panel.
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The displayed modules are as follows.

Display Description
Navcon Navigation controller
Syscon System controller board
Robot Robot
Teleop Teleoperation sensor
LiDAR Autonomous control sensor
Media Surveillance cameras, 360° optical camera, thermal imaging cameras, 

microphones, speaker
Subtrack Sub track
IMU IMU sensor
Main Track Main track
Charger Charging unit
Arm Manipulator
Gas Detector Gas detector

4 ASCENT status
Displays the status of ASCENT.
	z Starting up
	z Standing by
	z Teleoperation
	z Running Autonomously
	z Charging
	z Entering Chg. St. (docking)
	z Leaving Chg. St. (undocking)
	z Self-diagnosis
	z Powering Down
	z ERROR (An error is occurring)
	z Offline

5 Status last update at:
Indicates the date and time when the status was last updated.

6 Voltage
Displays the battery voltage.

7 Gas concentration
Displays information from ASCENT’s gas detectors.
Oxygen: Displays the oxygen concentration.
Carbon Monoxide: Displays the carbon monoxide concentration.
Combustible Gas: Displays combustible gas concentration.
Hydrogen Sulfide: Displays the hydrogen sulfide concentration.
Temperature: Displays the external temperature.
Gas Detector History: Displays the changes of numerical values of the gas detector in a graph.

8 Latest Inspection Image
Displays the latest image taken by ASCENT.
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9 Robot Location
Displays a map of the running scenario, with an arrow showing the current location of ASCENT on 
the map.

AT Periodic Image
Displays the 360° optical camera images that ASCENT periodically uploads to the cloud.
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The results of automatic patrols are saved in the cloud and can be checked on the management screen. The 
following confirmation methods are available:
	z Check each executed scenario ([Inspection Summary] screen)
	z Check each target ([Inspection History] screen)

12.1  Checking Scenario Execution Results (Inspection 
Summary)

12.1.1 Check execution results on the [Inspection Summary] screen
You can check the result of executing a scenario on the [Inspection Summary] screen in the cloud.

1 Log in to the cloud.

2 Select [Inspection Summaries] from the menu.
The [Inspection Summaries] screen appears.
For screen details, see “12.1.2 [Inspection Summaries] screen” (page 12-3).

3 Select a plant from the [Plant] list

4 Set the search conditions and click the [Search] button.
You can specify the following conditions:
	z Scenario name
	z Schedule name
	z Cycle

The patrol results that match the search conditions are displayed in order from the most recent.

3 4

5
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5 Click the [Detail] button in the row of the patrol results you want to display.
The [Inspection Summary] screen appears.

Image / Audio

Map

The Inspection Summary shows the patrol information, a map, and the images and sounds acquired 
during the patrol.
The map shows the patrol route and the imaging locations.

Click an image to enlarge it.
For audio recordings, a play button and control bar are displayed.
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12.1.2 [Inspection Summaries] screen
This section describes the contents displayed on the [Inspection Summaries] screen.
The execution results of a scenario are displayed in a list.

Inspection summaries

Search area

	■ Search area
If you specify the search conditions and click the [Search] button, the inspection summaries that match 
the conditions will be displayed in the search results.
You can specify the following search conditions:
	z Plant name
	z Scenario name
	z Schedule name
	z Cycle

	■ Inspection summaries
	z Plant name
	z Scenario name
	z Robot name
	z Execution time
	z Status: Indicates whether the inspection results are normal or abnormal.

[Detail] button: Displays the details of the patrol results on the [Inspection Summary] screen. You can 
also check the images and sounds.
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12.2  Checking Inspection Results of Each Target 
(Inspection History)

12.2.1 Check the inspection results on the [Inspection History] screen
On the [Inspection History] screen in the cloud, you can check past inspection results for each target.

1 Log in to the cloud.

2 Select [Inspection History] from the menu.
The [Inspection History] screen appears.
For screen details, see “12.2.2 [Inspection History] screen” (page 12-5).

3 Select the plant from the [Plant] list.

4 Specify the search conditions for the patrol results and click the [Search] button.
You can specify the following search conditions:
	z Scenario name
	z Cycle

You can also specify the following conditions by clicking the ▼ button to the right of the [Search] 
button.
	z Target name
	z Data type

The inspection results that match the search conditions are displayed for each target.

5 Click the line of the inspection results you want to check.
A list of acquired images and sounds is displayed on the right side of the screen.

3 46

5
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Click an image to enlarge it.
For audio recordings, a play button and control bar are displayed.

6 To check the detailed information at the time of inspection, click the [Detail] tab.
[Detail] tab

12.2.2 [Inspection History] screen
The history of inspection results is displayed for each target. For the selected targets, you can see the 
past inspection results for each.

Inspection History list

Search area

Preview

Detail

	■ Search area
If you specify the search conditions and click the [Search] button, the inspection summaries that match 
the conditions will be displayed in the search results. Click ▼ to see additional search conditions.
You can specify the following search conditions:
	z Plant name
	z Scenario name
	z Cycle
	z Target name
	z Data type (image/audio)
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	■ Inspection history list
[Trash] button: Puts the inspection history selected in the checkbox into the Inspection History Trash.
	z Checkbox: Select the history to delete.
	z Plant name
	z Scenario name
	z Acquisition time
	z Data type
	z Target name
	z Anomaly:

Select each line in the history to see its image in the preview field on the right. For audio, the play 
button and control bar are displayed.

	■ [Preview]
A preview image of the inspection history selected in the list is displayed. Click the image to enlarge it. 
Images taken in the past are also displayed.
For audio, the play button and control bar will be displayed so you can play the audio.

	■ [Detail]
Detailed information on the inspection history is displayed.
You can also check the measured values of the gas detectors here.
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12.2.3 Display inspection history from the target list
You can also view a list of targets to see the inspection history for each target.

1 Log in to the cloud.

2 Display [Plants] from the menu.

3 Click the number in the target number column of the plant.
Number of targets

The [Targets] screen appears.

4 Click the [Inspection History] button of the target for which you want to display the history.
The [Inspection History] screen appears.
For screen details, see “12.2.2 [Inspection History] screen” (page 12-5).

Inspection history
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This chapter describes cloud features not covered in previous chapters.

13.1 Logging Into the Cloud

This section describes how to log in to the cloud.
Use a Web browser to access the cloud website. We recommend using Chrome for the Web browser.

1 Enter the cloud URL (https://ex-rovr.com) in the PC’s Web browser.
The login screen appears.

2 Enter your User ID (email address) and password.

User ID Use the ID and password provided upon delivery when you first log in.
User IDs can be added. After adding, each person can log in with their user 
ID and password.Password

For user ID details, see “13.4 User Registration” (page 13-9).



13-2L5-59EU024 R00

Chapter 13 Cloud Management

3 Click the [Sign In] button.
The cloud management screen appears.
In the cloud, select an item from the menu on the left side of the screen.

Menu

	■ Logging out
Click [Sign out] from the menu.
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13.1.1 Cloud Menu
The cloud menu contains the following menu items.

Menu item Description Page
Plants Displays a list of registered plants. 13-7
Alerts Displays a list of alerts. 13-22
Robots Displays a list of registered ASCENTs. 13-15
Schedules Displays a list of scenario execution schedules. 10-6
Scenarios Displays a list of registered scenarios. 13-24
Inspection Summaries Displays the execution results of scheduled scenarios. 12-1
Inspection History Displays target inspection history. 12-4
Contract Information Displays contract information. 13-25
Users
(Administrator users only)

Manages user information. 13-12

Teleop Terminals
(Administrator users only)

Displays a list of Teleop terminals. 13-26

Charging Stations Displays a list of Charging Stations. 13-27
Signed in as Displays the logged-in user’s name. –
Settings Sets the display language. Select Japanese or English. –
Sign out Logs out of the cloud. –
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13.2 Plant User Management Overview

A plant is a building such as a factory or building within a factory that ASCENT patrols.
Upon delivery, one plant is registered per company. The factory and buildings to be patrolled are 
registered under this plant.
Each user and ASCENT is affiliated with the plant.
Users include administrators and general users. Administrator users can perform all operations of the 
software such as creating maps and scenarios, and registering schedules. General users can only 
view schedules and inspection results. Users affiliated with a parent plant can also work with its child 
plants.
An ASCENT can patrol within its affiliated plant. An ASCENT can be affiliated with only one plant.

Plant

Company

Factory

Factory

Outbuilding

Outbuilding

Administrator 
users

General 
users

ASCENT

EX ROVR is delivered with one plant registered per company, and one affiliated administrator user 
account affiliated with the purchased ASCENT. Additional plants and users can be registered to suit 
operational requirements.
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13.3 Plant Registration

The buildings (factory, outbuildings, etc.) that ASCENT patrols are registered as a plant.
A plant can be registered as a child of the parent plant registered at the time of delivery. Additional 
plants can be created as children of added child plants and managed hierarchically.
Each ASCENT can be registered with only one plant.

13.3.1 Adding a new plant

1 Log in to the cloud.

2 Select [Plants] from the menu.
The [Plants] screen appears.
For screen details, see “13.3.3 [Plants] screen” (page 13-7).

3 Click the [Add] button.
The [Plant Registration] screen appears.
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4 Set the plant information.

Item Description
Name Enter the plant name.
Parent Plant Select from the list the parent plant of the one being created.
Location (optional) Click on the map where the plant is located. Click to set the latitude 

and longitude in the box.
The Difference From 
UTC

Enter the time difference from UTC. Click the [Verify Time Difference] 
button to display a map showing the time difference.

5 Click the [OK] button.
The plant is registered.

13.3.2 Editing plant information
You can edit information such as the plant name and parent of the registered plant.

1 Log in to the cloud.

2 Select [Plants] from the menu.
The [Plants] screen appears.

3 Click the [Edit] button of the plant you want to edit.
[Edit] button

4 Edit the plant information on the [Plant Registration] screen.

5 Click the [OK] button.
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13.3.3 [Plants] screen
This section describes the configuration of the [Plants] screen.
A list of registered plants is displayed. The plant locations are also shown on a map.
Administrator users can add and edit plants.
General users can only view plant information.

	■ [Add] button
Add a new plant.
Only administrator users are displayed.

	■ [Show only Plants with Alert] button
Only plants where an alert has been generated are displayed in the list. Pressing this button changes 
it to the [Display All Plants] button.

	■ Plants
A list of registered plants is displayed. If  is displayed to the left of a plant name, you can click  to 
display the child plants in the hierarchy.
Selecting a plant in the list displays a map of the plant and a list of the robots registered in the plant at 
the right side of the screen.
The following information is displayed in the list.
	z Plant name
	z Alert: Indicates the status of the plant’s error by color. The color indicates the most severe error 
occurring in the plant.
: Alert
: Warning
: Info
Click  to display a list of alerts for that plant.
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	z Last inspection: Displays the plant’s last inspection date/time. Click to display the Inspection 
Summaries for that plant. (See “12.1.1 Check execution results on the [Inspection Summary] 
screen” (page 12-1))
	z Num. schedules: Displays the number of schedules registered for the plant. Click to display the 
schedule list. (See “Chapter 10 Registering a Schedule” (page 10-1))
	z Num. targets: Displays the number of targets registered in the plant. Click to display the list of 
targets. (See “12.2.3 Display inspection history from the target list” (page 12-7))
	z Num. scenarios: Displays a list of the scenarios registered for the plant.

[Edit] button: Edits the plant information. Only administrator users are displayed.
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13.4 User Registration

13.4.1 Administrator and general users
There are two types of users: administrator and general.
Only an administrator user can register another user.
The main privileges of the administrator and general users are as follows:

Software Function Administrator user General user
Teleop screen Teleoperation of ASCENT  –
Scenario Maker Map creation  –

Scenario creation  –
Cloud system Schedule Registration   (viewing only)

User Management  –
Plant management   (viewing only)
Verification of patrol results   (viewing only)

Dashboard Check ASCENT status  

13.4.2 Adding a new user
Create an account for the new user and register it with the plant. Each user can only register for one 
plant. When the plants are hierarchized, users registered in parent plants can also operate in the child 
plants.

1 Log in to the cloud.

2 Select [Users] from the menu.
The [User Management] screen appears.
For screen details, see “13.4.4 [User Management] screen” (page 13-12).
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3 Click the [Add] button.
The [User Registration] screen appears.

4 Set the user’s information.

Item Description

Email Address Enter their email address. The specified address will be the user ID at 
login.

Full Name Enter the name of the account user.
Password Initial password of the user. Passwords may contain single-byte 

alphanumerics, symbols, and blank characters.
Password (Confirm) Re-enter the password to confirm.
Plant Select the plant with which the user is affiliated.
Language Select a language.
User Type Select [Administrator] or [User].

5 Click the [OK] button.
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13.4.3 Changing user information
To edit user information such as passwords:

1 Log in to the cloud.

2 Select [User Management] from the menu.
The [User Management] screen appears.

3 Click the [Edit] button of the user whose information you want to edit.
[Edit] button

4 Edit the user’s information on the [User Registration] screen.

5 Click the [OK] button.

	■ Deleting users
To delete a registered user, click the [Delete] button for the user you want to delete.
To delete multiple users, select the users’ checkboxes and click the [Delete] button.
When the confirmation message is displayed, click the [OK] button.
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13.4.4 [User Management] screen
Displays registered users and adds, deletes, and edits users.
The [User Management] screen can be displayed only by administrator users. It cannot be displayed 
by general users.

Search area

User list

	■ Search area
You can specify search conditions and click the [Search] button to display only the users who match 
those conditions in the search results.
	z Plant Name
	z User Name
	z User Type (general/administrator)

	■ [Add] button
Adds a new user.

	■ [Delete] button
Deletes the user(s) with their checkbox(es) selected in the User List.
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	■ User List
The following information is displayed in the list.
	z Checkbox: Select the user for deletion.
	z Full Name
	z Affiliated Plant
	z Email Address
	z User Type (general/administrator)
	z Last Sign in

[Delete] button: Deletes users.
[Edit] button: Edits the user’s information.
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13.5 Changing ASCENT’s Affiliated Plant

13.5.1 Changing the affiliated plant
You can change which plant ASCENT is affiliated with.
If you want to patrol a newly created plant, change ASCENT’s plant affiliation.
To run a scenario, ASCENT must be affiliated with the same plant as the scenario.

1 Log in to the cloud.

2 Select [Robots] from the menu.
The [Robots] screen appears.
For screen details, see “13.5.2 [Robots] screen” (page 13-15).

3 Under [Plant], select the plant where ASCENT is registered, and click the [Search] button.
ASCENTs that match your search conditions will appear in the list. You can also narrow the search 
by robot name.

3 3

4

4 Click the [Edit] button.
The [Robot Registration] screen appears.

5 6 7
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5 Select the plant to change to in [Plant].

6 If necessary, edit the name of ASCENT in [Robot Name].

7 Click the [OK] button.

13.5.2 [Robots] screen
This section describes the configuration of the [Robots] screen.
It displays a list of ASCENTs registered in the selected plant.
Each ASCENT is displayed on the [Robots] screen.

Search area

Robots

	■ Search area
Select the search conditions and click the [Search] button to display ASCENTs that match those 
conditions in the search results. You can specify the following search conditions:
	z Plant name
	z Robot name
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	■ Robots
Lists the robots that match the search conditions.
	z Alert: Indicates ASCENT operating status by color.

Color State
Running Autonomously

Paused

Under teleoperation

Error Occurred

On standby

Offline

	z Robot name
	z Plant name
	z IMSI: Displays ASCENT’s SIM identification number.
	z Serial No.: Displays ASCENT’s serial number.

[Dashboard] button:  Launches the dashboard and displays the operating status of the selected 
robot. (See “11.2 Real-Time Monitoring on the Dashboard” (page 11-2))

[Edit] button:  Edit the information of the selected ASCENT. Only the plant name and robot 
name can be changed.

[Self-diagnosis] button: Performs ASCENT’s self-diagnosis.
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13.6 Issuing Alerts

13.6.1 Setting alerts
You can set conditions for alerts to be issued, such as gas concentration.
You can check issued alerts on the [Alerts] or [Plants] screens in the cloud.

	■ About alert conditions
The scope of alert conditions may apply to a specific target or to an entire plant. When a target is the 
scope of application, the judgment is made when an action such as capturing an image is performed 
at the target. When the plant is the scope of application, the inside of the plant is constantly monitored 
during inspection.
Some targets require normal/abnormal threshold settings for monitoring, and others are judged 
automatically.

Target to monitor Scope of coverage Method
Oxygen concentration Target, Plant Threshold
Hydrogen sulfide concentration Target, Plant Threshold
Carbon monoxide concentration Target, Plant Threshold
Combustible gas concentration Target, Plant Threshold
Temperature Target, Plant Threshold
Pinpoint Temperature Target Threshold
Rust (automatic) Target Auto
Leakage (automatic) Target Auto
Abnormal noise (automatic) Target Auto
Thermal image (automatic) Target Auto
White smoke (automatic) Target Auto
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Follow the steps below to set the alert issuance conditions.

1 Log in to the cloud.

2 Select [Alerts] from the menu.
The [Alerts] screen appears.

3

For screen details, see “13.6.3 [Alerts] screen” (page 13-22).

3 Click the [Alert Conditions] button.
The [Alert Conditions] screen appears.

4 Click the [Add] button.
The [Edit Alert Condition] screen appears.

5
6
7

8
9

5 Select [Plant] or [Target] in [Scope], and select the name of the plant or target.
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6 Select a target in [Target to monitor].
	z Oxygen concentration
	z Hydrogen sulfide concentration
	z Carbon monoxide concentration
	z Combustible gas concentration
	z Temperature
	z Pinpoint temperature
	z Rust (automatic)
	z Leakage (automatic)
	z Abnormal noise (automatic)
	z Thermal image (automatic)
	z White smoke (automatic)

7  When the selected [Target to monitor] is one of the following, set the normal/abnormal 
judgment threshold values.
	z Oxygen concentration
	z Hydrogen sulfide concentration
	z Carbon monoxide concentration
	z Combustible gas concentration
	z Temperature
	z Pinpoint Temperature

8 Select the status of the alarm to be issued (Alert, Warning, Info) for [Status].

9 Enter the title of the alert for [Title].

10 Click [OK].

Selectable regardless of whether [Target] or 
[Scenario] is selected

Only selectable when [Target] is selected
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13.6.2 Checking alerts
You can check issued alerts on the [Alerts] or [Plants] screens in the cloud.

	■ Check on the [Plants] screen
You can check the alert status by the color in the [Alerts] column of the plant list.
	z Red: Alert
	z Yellow: Warning
	z Green: Info

Click ● in the [Alerts] column to display the [Alerts] screen.
You can view only the plants that are issuing alerts by clicking [Show only Plants with Alert].

	■ Check the [Alerts] screen

1 Log in to the cloud.

2 Select [Alerts] from the menu.
The [Alerts] screen appears.

3 Select the plant from the [Plant] list.

4 Select the alert status (Alert, Warning, Info) to display.

5 Set the search conditions for the patrol results to be displayed.
	z Title (text included in the title)
	z Target name
	z Registered date time
	z Solved date time
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6 Click the [Search] button.
Messages that match your search conditions are displayed.

4
6

3 5

	■ Marking an alert/warning as solved
Check the contents of the message and clear the alert/warning if the problem has been addressed.
When marked as solved, the message remains on the [Alerts] screen, but it will not be reflected in the 
[Alerts] field on the [Plants] screen.
To clear, select the applicable message on the [Alerts] screen and click the [Marked as Solved] button.
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13.6.3 [Alerts] screen
Displays a list of alerts that have occurred.

Search area

Alerts

	■ Search area
If you specify the search conditions and click the [Search] button, alerts that match the conditions will 
be displayed in the search results.
You can specify the following search conditions:
	z Status (Info/Warning/Alert)
	z Title
	z Plant name
	z Target name
	z Registered date time
	z Solved date time

	■ [Marked as Solved] button
Clears the alert selected in the alert list.
Cleared alerts will appear in the alert list, but will not be reflected in the plant status.

	■ [Delete] button
Clears the alert selected in the alert list.

	■ [Alert Conditions] button
Set the conditions for generating alerts.
For details, see “13.6.1 Setting alerts” (page 13-17).
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	■ Alerts
The following information is displayed in the list.
	z Checkbox: Select the alert you want to mark as solved or delete.
	z Status: The status of the alert is indicated by color.
(Green): Info
(Yellow): Warning
(Red): Alert
	z Title
	z Plant name
	z Target name
	z Registered: Displays the date and time when the alert was registered.
	z Solved: Displays the date and time when the alert was cleared.
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13.7 Other Management Screens

13.7.1 [Scenarios] screen
Displays a list of registered scenarios.
Displayed by selecting [Scenarios] from the menu.

Search area

Scenario list

	■ Search area
If you specify the search conditions and click the [Search] button, alerts that match the conditions will 
be displayed in the search results.
You can specify the following search conditions:
	z Plant name
	z Included targets
	z Scenario name
	z Comment

	■ Scenario list
	z Plant name
	z Scenario name
	z Registered date time
	z Updated date time
	z Last execution date time
	z Comment
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13.7.2 [Contract Information] screen
Displays the EX ROVR contract plan, etc.
Displayed by selecting [Contract Information] from the menu.

The following information is displayed.
	z Company name
	z Plan
	z Number of robots
	z Number of plants
	z Starting date (displayed only for administrator users)
	z Completion date (displayed only for administrator users)
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13.7.3  [Teleop Terminals] screen (displayed only for administrator 
users)

Displays a list of Teleop terminals.
Displayed by selecting [Teleop Terminals] from the menu.
Only administrator users can view it.

	■ [Search] button
You can search by specifying the model name, registration date and time, and terminal name.

	■ List of Teleop terminals
The following information is displayed in the list.
	z Teleop terminal name
	z Model name
	z Company name
	z IMSI
	z Serial number
	z Registered date time
	z Update date time

Click the [Edit] button to edit the terminal name.
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13.7.4  [Charging Stations] screen (displayed only for administrator 
users)

Displays a list of Charging Stations.
Displayed by selecting [Charging Stations] from the menu.
Only administrator users can view it.

	■ [Search] button
You can search by specifying the model name, registration date and time, and Charging Station name.

	■ Charging Station
The following information is displayed in the list.
	z Station name
	z Model name
	z Company name
	z Serial number
	z Registered date time
	z Update date time

Click the [Edit] button to edit the Charging Station name.
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This chapter describes the basic ASCENT operating procedures using a Teleop terminal. ASCENT 
teleoperations are required to create scenarios and maps. If you are new to ASCENT, read this chapter to 
train and familiarize yourself with its basic operations.

ASCENT should be accompanied by an attendant during training. The attendant reports the movement and 
orientation of ASCENT and surrounding conditions to the teleoperator. The teleoperator should practice 
correct operation by referring to the attendant’s reports. The attendant should confirm the precautions noted 
in “4.2 ASCENT Teleoperator And Attendants” (page 4-4) while accompanying ASCENT.
Teleoperation of ASCENT for cases other than map/scenario creation should be performed by personnel with 
sufficient training and a certain level of skill in teleoperation.

 WARNING

	z Avoid teleoperation where radio connections are difficult or unstable.
ASCENT may behave unexpectedly or be unable to stop by teleoperation.
	z Avoid teleoperation when visibility is poor.
There is risk of collision or slipping.
If visibility is poor due to insufficient light, such as in the rain, turn on surrounding lights so that the 
surroundings are clearly visible before teleoperating.
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14.1 Exiting from the Charging Station (Undocking)

Ensure that ASCENT is in the Charging Station and that the status LED is lit yellow (charged).

1 Open the [Predefined Motions (Navi)] tab on the Teleop screen.

1

2
3

2 Select [Exit Charging Station] on the [Predefined Motions] panel.

3 Click [Execute].
The exit (undocking) process starts.
ASCENT starts moving after performing initialization and self-diagnostics.
ASCENT stops when it exits the Charging Station, and the status LED blinks green (teleoperation 
mode).
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14.2 Moving ASCENT

To move ASCENT, open the [Truck] tab on the Teleop screen.
To prevent ASCENT moving by mistake, you need to operate the joystick and buttons at the same time 
when using the gamepad.

To move ASCENT, press and hold the A button (or X or Y button) while operating the left joystick. The 
button determines the speed, and the left joystick determines the direction of movement.

High Speed

Medium Speed

Low Speed

ASCENT stops when you release either the button or the joystick.
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14.3 Checking Camera Images

Images from the cameras installed on ASCENT are displayed on the Teleop screen.
Use the camera images to check ASCENT’s surrounding conditions during teleoperation.

	■ Truck camera
Images from the cameras installed on ASCENT’s front and rear appear in the [Truck Camera (Front)] 
and [Truck Camera (Rear)] panels.

	■ Surveillance camera
The image from the surveillance camera on ASCENT’s manipulator is displayed in the [Surveillance 
Camera] panel on the Teleop screen. You can move the manipulator to view surrounding monitoring 
targets. For information on operating the manipulator, see “14.8 Manipulator Operation” (page 14-21).

Truck camera Surveillance 
Camera



14-5 L5-59EU024 R00

Chapter 14 Basic ASCENT Operation

14.4 Entering the Charging Station (Docking)

Use the Teleop screen to dock ASCENT in the Charging Station.

1 Open the [Truck] tab on the Teleop screen.

2 Move ASCENT to the front of the Charging Station, aiming at the dotted line on the 
Charging Station’s docking/undocking (entry/exit) guide plate. (Figure A)

3 Continue to advance, and stop when ASCENT is entirely over the guide plate. (Figure B)

4 Rotate ASCENT 180° to face away from the Charging Station. (Figure C)
To rotate, press and hold the A button on the gamepad and tilt the left joystick to the left or right.
When stopped in the correct position, ASCENT’s laser is reflected in the Charging Station’s 
stopper.

An attendant should ensure that ASCENT is stopped centered over the dotted line on the docking/
undocking guide plate.

NOTE

	z Enter along the dotted line of the guide plate.
If the entry angle is incorrect, ASCENT may crash into the Charging Station.

(A) (B) (C)

5 Open the [Predefined Motions (Navi)] tab on the Teleop screen.
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6 On the [Predefined Motions] panel, select [Enter Charging Station] and click [Execute].

6

ASCENT will automatically enter the Charging Station.
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14.5 Crossing a Step

ASCENT can cross over steps up to 15 cm high.
To cross a step, drive while raising and lowering the sub tracks according to the step.

14.5.1 To Raise and lower the sub tracks
With the [Truck] tab open on the Teleop screen, raise and lower the front sub tracks (L1 and L2 
buttons) and rear sub tracks (R1 and R2 buttons) on the gamepad.

Lower the rear sub track Lower the front sub track

Raise the rear sub track Raise the front sub track

14.5.2 Driving over a step
To drive over a step, align ASCENT to face it.
ASCENT’s teleoperator uses the guidelines in the truck camera image to check alignment with the 
step. An attendant should visually confirm ASCENT’s status.
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Also, while driving, check the pitch of ASCENT and the sub tracks on the Attitude panel on the Teleop 
screen. If the main body of ASCENT pitches too far forward or back, it could topple over. Adjust the the 
front and rear sub track angles to avoid excessive pitch.

 WARNING

	z ASCENT must be aligned to face the step.
If ASCENT attempts climbs the step diagonally, it may lose its balance and topple over.

1 Face ASCENT toward the step.
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2 Lower the front sub tracks to 45°, and slightly lower the rear sub tracks.
The back of the main body should be slightly raised.

3 Advance with that attitude.
The front sub tracks grab the step to climb.
As it proceeds, the main body pitches backwards, so lower the rear sub tracks little by little to keep 
the main body close to level.
The attendant should confirm that ASCENT has climbed onto the step, and inform the teleoperator.

4 As the main body of ASCENT advances forward, continue to lower the rear sub tracks so 
that the pitch of the main body remains near level.
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5 When the main body is fully on the step, lower the front sub tracks to -30°.

6 Advance until the front sub tracks touch the floor and the rear sub tracks get onto the step, 
then raise the rear sub tracks to 45°.

7 Advance further.
As the rear sub tracks grab the step, gradually descend.
Gradually raise the front sub tracks so that the main body does not pitch forward too much.
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8 After completely descending from the step, raise the front and rear sub tracks to return to 
the driving attitude.
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14.6 Ascending and Descending Stairs

To go up and down stairs, raise and lower the sub tracks as you proceed, just like for the step.
For information on raising and lowering the sub tracks, see “14.5.1 To Raise and lower the sub tracks” 
(page 14-7).

To drive on stairs, ASCENT must begin by facing them.
ASCENT’s teleoperator uses the guidelines in the truck camera image to check alignment with the 
step. An attendant should visually confirm ASCENT’s status.

Also, while driving, check the pitch of ASCENT and the sub tracks on the Attitude panel on the Teleop 
screen. If the main body of ASCENT pitches too far forward or back, it could topple over. Adjust the 
angles of the front and rear sub tracks while checking the pitch attitude.

An attendant should continually check the attitude of ASCENT while ascending and descending, and 
inform the operator of the situation.

 WARNING

	z ASCENT must be aligned to face the stairs.
If ASCENT attempts to climb stairs diagonally, it may lose its balance and topple over.



14-13 L5-59EU024 R00

Chapter 14 Basic ASCENT Operation

14.6.1 Climbing stairs

1 Align ASCENT to face the stairs.

2 Set the front sub tracks to 45° and the rear sub tracks to 0°.

3 Advance until the front sub tracks mount the first stair step.

4 Continue to advance.
ASCENT’s tracks grab the stairs as it advances.

The attendant should ensure that ASCENT is straight on the stairs.
OK NG



14-14L5-59EU024 R00

Chapter 14 Basic ASCENT Operation

5 Advance until ASCENT is fully on the stairs.
The teleoperator should ensure that the rear sub tracks have moved off the floor by checking the 
image from the rear truck camera.
The attendant should again ensure that ASCENT is heading straight forward on the stairs.

6 Climb the stairs as-is without changing the angles of the sub tracks.

7 Climb to the top.

8 When ASCENT’s front sub tracks have cleared the top stair, lower the front sub tracks.
The attendant should ensure that the front sub tracks have cleared the top stair, and tell the 
teleoperator.
If the attitude of the main body pitches backward when the front sub tracks are lowered, the front 
sub tracks have not cleared the top stair yet, so advance ASCENT further forward.
The attendant should ensure that the front sub tracks touch the floor. Once the front sub tracks 
touch the floor, do not lower them any further.
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9 Next, lower the rear sub tracks a little to lift the back of the ASCENT main unit.

10 Continue to advance slowly.
When ASCENT’s center of gravity is on the landing, raise both sub tracks and advance ASCENT 
further.
The attendant should ensure that the ASCENT’s center of gravity is on the landing.

11 When ASCENT is completely on the upper floor, raise the front and rear sub tracks to return 
to the driving attitude.
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14.6.2 Descend the stairs
When descending stairs, moving ASCENT’s center of gravity becomes important. If the center of 
gravity is high away from the stairs, ASCENT may lose its balance and slide down.

1 Align ASCENT to face the stairs.
The teleoperator should ensure proper alignment using the guidelines in the image from the front 
truck camera.
The attendant should ensure proper ASCENT alignment from behind.

2 Set the front and rear sub tracks to 0°.

3 Lower the front sub tracks slightly.
The front of the main body rises slightly.

4 Advance until the front sub tracks overhang the stairs and the main body becomes level.
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5 Set the front and rear sub tracks to -20°.
The front of the main body will be slightly lower.
If the front sub tracks are not in contact with the stairs, lower them until they are. The attendant 
should check the angle of the front sub tracks and report to the teleoperator if the sub tracks are 
not in contact with the stairs.

 WARNING

	z If the front sub tracks are not in contact with the stairs, ASCENT may lose balance and 
slip when it moves forward.

6 Continue to advance slowly.
As ASCENT descends the stairs, its main body tilts forward and the center of gravity rides on the 
front sub tracks.
In the truck camera image, the field of view drops sharply.
The attendant should ensure that the center of gravity is on the front sub tracks, and inform the 
teleoperator.

 WARNING

	z Lowering the sub tracks in this state may cause loss of balance and slipping.

7 Raise the rear sub tracks gradually to 0°.
If the main body moves when the rear sub tracks are raised, lower them back and advance a little, 
then raise them again.
The attendant should again ensure that ASCENT is heading straight forward on the stairs.
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8 Raise the front sub tracks to 0°.

9 Continue to advance.

10 When the front sub tracks touch the floor, raise the front and rear sub tracks a little.
The attendant should inform the teleoperator when the front sub tracks touch the floor.

11 Advance while raising the front and rear sub tracks little by little.

12 Raise the front and rear sub tracks to 30°.

13 Continue to advance, and when ASCENT is completely down, return to the driving attitude.



14-19 L5-59EU024 R00

Chapter 14 Basic ASCENT Operation

14.7 Changing Sub Track Angles

The four sub tracks can be changed all at once or separately.
For details on moving the front and rear sub tracks up and down, see “14.5.1 To Raise and lower the 
sub tracks” (page 14-7).

	■ Changing the angle of the front, back, left and right sub tracks all at once

1, 2 3

1 Press the D-pad keys in any direction.
The screen for selecting sub track attitude is displayed.

2 Use the D-pad keys to select the attitude to which you want to change.
	z Attitude 1: 90°
	z Attitude 2: 110°
	z Attitude 3: 0°
	z Attitude 4: 45°

3 Press the B button (attitude execution).
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	■ Moving the front, back, left and right sub tracks up and down independently

2 21, 3

2

1 Press and hold the BACK button (Function) while pressing the X button (Synchronous/
Independent) .
Operation changes to the independent mode.

2 Move the right joystick back and forth while selecting the sub track to move with the L1, L2, 
R1, or R2 buttons.

L1 Right rear sub track
L2 Left rear sub track
R1 Right front sub track
R2 Left front sub track

3 When the operation is finished, press and hold the BACK button (Function) while pressing 
the X button (Synchronous/Independent) as in step 1.
The operating mode returns to synchronous sub track operation.
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14.8 Manipulator Operation

Click the [Manip.] tab to operate the manipulator from the Teleop screen.

14.8.1 Extending the manipulator
You can extend the manipulator and point it forward, left, or right.

1 Open the [Manip.] tab on the Teleop screen.

2 Click [Attitude Change] on the [ManiInfo] panel.

2

3

3 Click [[B] Confirm].
The Attitude Change screen appears.
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4 Click Attitude 1 to Attitude 3 so that the manipulator is directed to the target location.

5 Click [[B] Confirm].

6 Click [Yes] when the message is displayed.
The manipulator angle changes.
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14.8.2 Adjusting manipulator orientation
You can move the fingertips of the manipulator up, down, left, and right, or back and forth.

1 Select [Gamepad Operation] on the [ManiInfo] panel, and click [[B] Confirm].

2 Adjust the orientation of the manipulator with the gamepad.
Press and hold the A button to reposition the fingertips while maintaining the attitude (posture) of 
the hand (position manipulation).
Press and hold the Y button to rotate the fingertips while maintaining the position of the hand 
(attitude manipulation).

Manipulator Movement Gamepad Operation
Move the tip back and forth, 
and left and right

A button (position manipulation) + left joystick front, back, left, 
and right

Move the tip up and down A button (position manipulation) + R2 button (up) or R1 button 
(down)

Point the tip to the left or right Y button (attitude manipulation) + left joystick left and right
Point the tip up or down Y button (attitude manipulation) + left joystick up and down
Rotate the tip Y button (attitude manipulation) + L2 button (left rotation) or  

R2 button (right rotation)
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14.8.3 Adjusting the angle of each axis
ASCENT’s manipulator has six axes of rotation. The angle of each rotation axis can be manipulated.

W2 axis E2 axis

E1 axis

W1 axis

S1 axis

S2 axis

1 Select [Gamepad Operation] on the [ManiInfo] panel, and click [[B] Confirm].

2 Press the X button (joint manipulation) on the gamepad and operate the left or right joystick 
while holding down the L1, L2, R1, or R2 button.

Axis of rotation Gamepad Operation
S1 axis X button + left joystick left (-) right (+)
S2 axis X button + right joystick left (-) right (+)
E1 axis X button + right joystick forward (-) back (+)
E2 axis X button + L1 button (-)/R1 button (+)
W1 axis X button + left joystick forward (-) back (+)
W2 axis X button + L2 button (-)/R2 button (+)
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14.8.4 Manipulating the hand

NOTE

	z Do not use manipulator to grab sharp objects, objects hotter than 100°C or colder than 
0°C, or chemicals that erode rubber.
Otherwise, the rubber at the manipulator’s fingertips will be damaged.

Hold down any of the A, B, or Y buttons and press the right side of the D-pad to close the hand. Press 
the left side of the D-pad to open the hand.

14.8.5 Returning to the stowed attitude (moving attitude)
When you finish operating the manipulator and want to move ASCENT, return the manipulator to the 
stowed attitude.

 CAUTION

	z The manipulator must be stowed before moving.
If ASCENT is moved without stowing the manipulator, it could hit someone or something and 
cause injury or damage.
Also, vibration may cause the manipulator to malfunction.

1 Click [Attitude Change] on the [ManiInfo] panel, and click [[B] Confirm].
The Attitude Change screen appears.

2 Select [Stowed Attitude], and click [[B] Confirm].

3 Click [Yes] when the message is displayed.
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14.9 Other Operations

14.9.1 Speaker output of audio data
The prerecorded sound source is output from the speaker. Use to emit sound for alerting.

1 Open the [Predefined Motions (Navi)] tab.

2 Select [Speaker Command] on the [Predefined Motions] panel and click [Execute].

2

The settings screen appears.

3 Select the audio data number and volume.

4 Click the [Playback] button.
Playback of the sound source starts.
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5 To stop playback, click the [Stop] button.
If you want to perform other operations while the sound plays, press the X button to close the 
[Speaker Playback] screen and choose another tab.
You can set the audio data number and volume in the properties of “play-audio” motion when 
creating a scenario.

14.10 Displaying the Gamepad Operation Guide

Press the gamepad’s help button to display the Gamepad Operation Guide on the Teleop screen.
Help button
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15.1 Troubles During Teleoperation

If a problem occurs with ASCENT during teleoperation, an error message appears on the Teleop 
screen. The error message displays the most severe error that has occurred.
To check the details, click [Error Code] on the [Status] panel on the Teleop screen.
Clicking [Error Clear] clears the displayed error.

Error MessageError Clear Error Code
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On the [Status] panel, the incident class is displayed under [Error Code], and the error code is 
displayed for each class.
The incident classes are shown below.

Incident Class Incident Error Description
Navi Scenario execution (autonomous control) anomaly
Auto Required autonomous control information anomaly
Media Camera, microphone, or speaker anomaly
Robo An anomaly occurred during ASCENT processing, or the stop button was pressed
Syscon System controller board power supply or related anomaly
Main Main track drive system anomaly, or CAN communication error with servo
Sub Sub track drive system anomaly, or CAN communication error with servo
IMU IMU sensor anomaly, or communication error with IMU sensor
Charge Charging device anomaly, or communication error with power reception unit
Gas Gas detector anomaly, or communication error with gas detector
Mani Manipulator controller or drive system anomaly, or CAN communication error with 

servo

There are three types of error codes, depending on their severity.

Error Code Anomaly Class ASCENT Status
200-255 Fatal anomaly Control stopped. If stopped on stairs or slopes, there is risk of 

slipping. The sub tracks may move by themselves.
100-199 Uncontrollable 

anomaly
Operation stops, but control continues. If stopped on stairs or 
slopes, it stays in that position.
The sub tracks stop at the set angle.

0-100 Warning Operation continues.

For more information on error codes, see “15.5.1 Error code list” (page 15-8).
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15.2 Troubles Using Scenario Maker

If there is an error in the scenario in Scenario Maker, “Scenario data error” is displayed for the 
Scenario Status, and hovering the mouse over the Scenario Status displays an error message.

Scenario status

15.2.1 Scenario errors

Message Contents
(Motion name) + Problem with asynchronous 
specification

The specification of the asynchronous motion is 
incorrect.

(Motion name) + An anomaly was found in the 
motion name

An undefined motion is specified in the scenario.

(Motion name) + An anomaly was found in the 
motion parameters

There is an anomalous motion parameter value.

(Motion name) + Not enough motion 
parameters

Insufficient number of motion parameters.

(Path name) + path motion before map loading A path motion was specified before loading a map.
Specify a load-map motion before the path motion.

The scenario is empty The scenario is empty.
Specify a valid scenario.

(Map name) + An anomaly was found in map 
data

An anomaly was found in the data.

(Path name) + An anomaly was found in path 
data

An anomaly was found in the data.
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15.3 Troubles During Auto Patrol

If an error occurs in ASCENT during auto patrol, the robot status on the dashboard is displayed in red. 
Click the Robot Status to view the status of each module, and which module has the error.

Robot Status

For error details, launch the Teleop terminal and check the [Error Code] on the [Status] panel of the 
Teleop screen.

You can also check ASCENT’s status in the [Alerts] section of the [Robots] screen in the cloud.
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15.4 Specific Cases

15.4.1 During scenario execution
	■ A different route is taken when executing a path motion

ASCENT may be unable to recognize its location correctly.
Do the following:

1 Stop ASCENT using the Teleop terminal.

2 On Scenario Maker’s [Execute] tab, click [Robot Positions] then click ASCENT’s current 
location on the map.

3 On the [Scenario] tab, select the appropriate path motion.

4 On the [Execute] tab, click [Execute to end] or [Executed selected lines] to resume the 
scenario.
If it reoccurs, change the path or recreate the map.

	■ When a path motion is executed, obstacle detection causes ASCENT to 
stop where there are no obstacles

ASCENT may consider itself an obstacle.
Ensure the sub track angle is 110 degrees. Also check for any obstructions around the LiDAR.

15.4.2 During teleoperation
	■ The manipulator camera image on the Teleop screen is interrupted

Communication may have been lost and could not recover.
Double-click on the panel of the manipulator camera image. Communication should be restored.

	■ Teleop not working even with ASCENT powered on
Too much time required to become ready for manipulator teleoperation with the gamepad or to create 
a scenario in Scenario Maker.
	z Battery charge may be insufficient. Wait until charging is completed.
	z If it does not work after waiting, turn the Teleop terminal’s power off and then on again. If it still does 
not work, move the ASCENT to a non-hazardous area and power it off and on again.
	z If communication conditions are poor, move to a better wireless location and try teleoperating again.
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	■ Gamepad operation behaves differently from that described in the 
instruction manual

The operation mode of the gamepad may have been changed. Check the following two places on the 
gamepad.
	z Is the MODE indicator light on the gamepad lit?
If it is lit, press the MODE button to turn off.

MODE button/indicator

	z Is the changeover switch on the back of the gamepad on the D side?
If it is on the D side, switch it to the X side.
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15.4.3 When docking (Entry) and undocking (Exit)
	■ ASCENT does not reverse to dock (Entry)
	z Docking was attempted by a method other than [Charging Station Entry] on the [Predefined Motions 
(Navi)] tab of the Teleop screen. To dock normally, use [Charging Station Entry] on the [Predefined 
Motions (Navi)] tab.

	■ ASCENT repeatedly goes in and out of the Charging Station when docking 
(Entry)

There are the following possibilities: Check and eliminate the cause.
	z The Charging Station’s MODE switch is set to PURGE.
	z The glass surface of the Charging Station or ASCENT is dirty. Clean them.
	z ASCENT has stopped in a place where it cannot dock.
	z Lifting is occurring when stopped
	z There is dirt or foreign matter on ASCENT’s running surfaces.
	z The rollers on the Charging Station floor do not rotate normally.

	■ The cylinder does not come out when ASCENT has stopped
There are the following possibilities: Check and eliminate the cause.
	z The air source is not supplying pressure.
	z The supply pressure setting is incorrect. Docking may not be possible due to insufficient cylinder 
pressure.
	z Air may be leaking due to damage to the hose or air delivery device. If you find any damage, 
contact your maintenance company.
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15.5 Error List

15.5.1 Error code list
The error codes displayed in the [Status] panel of the Teleop screen are described for each incident 
class.

	■ Navigation control errors (incident class: Navi)

Error Code Cause Recovery Method
31 Attempted to change the scenario during 

operation
	y The operation will continue with the 
warning.

41 Confirming temperature (exit)
42 Checking temperature (stairs): Stand by 

while main track motor temperature is 
80°C or higher

43 Rebooting LiDAR
51 Stopped due to obstacle
101 System Controller Error Detected 

(syscon output error 100 or higher)
	y Click [Error Clear].
	y If it reoccurs, move to a non-
hazardous area and turn power off and 
on again.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

111 Manipulator Controller Error Detected 
(manicon output error 100 or more)

121 System Controller Communication 
Error(communication response anomaly, 
receive timeout)

122 Manipulator Controller Communication 
Error (receive timeout)

123 Syscon Controller Area Network 
Communication Error (receive timeout, 
CAN receive data anomaly)

124 Discontinuity in System Controller 
Thermometer (output error 21 · 23 · 25 · 
27 · 29 · 31 · 33 · 35)

125 Autonomous Control Sensor Error (101, 
102, 103)

126 System Controller IMU Warning
131 Obstacle Detection (a certain period of 

time has passed since obstacle detected 
during path motion)

	y Remove the obstacle.
	y Set the sub track angles to 110 
degrees.
	y If the route is narrow, turn off the 
Obstacle Detection function.
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Error Code Cause Recovery Method
132 Own Position Estimate Failure (load_

map, path, etc.)
	y Reconfirm the location of the robot and 
its location on the map.
	y Move the robot to the correct location 
on Scenario Maker.
	y Recreate the map.

133 Robot Attitude Error (pitch ≥ 60 deg or 
roll ≥ 15 deg)

	y Click [Error Clear].
	y Check whether the robot is on top of 
something and remove the cause.

134 Path Error 	y Click [Error Clear].
	y The robot is too far from its target path. 
Remove the cause.

135 Scenario Error (scenario file read failure, 
asynchronous operation is continuous)

	y Click [Error Clear].
	y Check the contents of the scenario 
specified by Scenario Maker, and 
identify the motion that caused the 
problem.

136 Cannot operate in the current driving 
mode (motion during Charging Station 
Exit)

137 Step Detection Error (obstacle motion) 	y Click [Error Clear].
	y Check for a problem with the obstacle 
motion settings, such as set values 
different from the actual step.

138 Marker Detection Error 	y Click [Error Clear].
	y Ensure that no marker is obscured and 
is not too high.
	y Check the relative positions of the 
robot and the markers to see if they 
are too far apart.

139 Align Motion Error 	y Click [Error Clear].
	y Review the align motion setting values.

141 Entry/exit self-diagnostics: Battery 
voltage below 25V threshold

	y The battery is low. Click [Error Clear] 
and return the robot by teleoperation 
to the Charging Station to recharge.

142 Entry/exit self-diagnostics: System 
controller temperature measurement 
anomaly (20/22/24/26/28/30/32/34)

	y Robot temperature is rising. Wait until 
the temperature drops.

144 Entry/exit self-diagnostics: Gas detection 
error (Warning occurs)

	y Click [Error Clear].
	y If it reoccurs, move to a non-
hazardous area and turn power off and 
on again.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

151 Stairs self-diagnostics: Below battery 
voltage threshold

	y The battery is low. Click [Error Clear] 
and return the robot by teleoperation 
to the Charging Station to recharge.

152 Stairs self-diagnostics: Warning 42 has 
elapsed for 10 seconds

	y Robot temperature is rising. Wait until 
the temperature drops.
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Error Code Cause Recovery Method
160 Stairs Operation error (stairs motion 

ended abnormally)
	y Click [Error Clear] to switch to Teleop 
mode.
	y Ensure that the dimensions of the 
stairs are set properly and that 
the markers are within the robot’s 
detection range.
	y Ensure that the landing shape 
is correct and that climbing and 
descending are correctly set.
	y Resume the scenario and see how it 
behaves.

	■ Autonomous control sensor errors (incident class: Auto)

Error Code Cause Recovery Method
101 LIDAR 	y Click [Error Clear].

	y Dock the robot and execute the 
scenario again from the schedule.
	y If it reoccurs, move to a non-
hazardous area and turn power off and 
on again.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

102 ODOM
103 IMU

	■ Environment sensor errors (incident class: Media)

Error Code Cause Recovery Method
1 Microphone Device error 	y The operation will continue with the 

warning.2 Speaker Device error
3 Microphone/Speaker failure
4 Surveillance Camera error
5 360° optical Camera error
6 Left Thermal Image Camera error
7 Right Thermal Image Camera error
8 Communication error



15-11 L5-59EU024 R00

Chapter 15 Troubleshooting

	■ Robot errors (incident class: Robo)

Error Code Cause Recovery Method
10 Low Battery 	y The operation will continue with the 

warning. 75 Battery Charging Not Possible, Charging 
Initiation Failed

76 Battery Charging Not Possible, Charging 
Error Detected

77 Battery Charging Not Possible, docking 
error during charging

101 Stop Notification Received 	y Click [Error Clear].
102 Manipulator Emergency Stop Notification 

Received: Stop
	y Click [Error Clear].
	y Refer to the cause column to 
determine the cause.
	y Try again.
	y If it reoccurs, turn the power off and 
then on again in a non-hazardous 
area.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

120 Charging Station Entry Not Possible, 
Sub Track Operation Timeout

121 Charging Station Entry Not Possible, 
Charging Station Distance Anomaly

122 Charging Station Entry Not Possible, Too 
Many Retries

130 Charging Station Exit Not Possible, 
Union Limit Switch Timeout

131 Charging Station Exit Not Possible, Rear 
Proximity Sensor Distance Error

142 Battery Charging Not Possible, Docking 
error during charging

250 Emergency Stop Detected (Black 
Button), Notification Received 

	y Click [Error Clear].
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	■ System controller (power supply/temperature) errors (incident class: 
Syscon) 

Error Code Cause Recovery Method
20 Internal Measurement Thermistor #1: 

Abnormal Temperature Range
	y The operation will continue with the 
warning.

21 Internal Measurement Thermistor #1: 
Disconnected

22 Internal Measurement Thermistor #2: 
Abnormal Temperature Range

23 Internal Measurement Thermistor #2: 
Disconnected

24 Internal Measurement Thermistor #3: 
Abnormal Temperature Range

25 Internal Measurement Thermistor #3: 
Disconnected

26 Internal Measurement Thermistor #4: 
Abnormal Temperature Range

27 Internal Measurement Thermistor #4: 
Disconnected

28 Internal Measurement Thermistor #5: 
Abnormal Temperature Range

29 Internal Measurement Thermistor #5: 
Disconnected

30 Internal Measurement Thermistor #6: 
Abnormal Temperature Range

31 Internal Measurement Thermistor #6: 
Disconnected

32 Internal Measurement Thermistor #7: 
Abnormal Temperature Range

33 Internal Measurement Thermistor #7: 
Disconnected

34 Internal Measurement Thermistor #8: 
Abnormal Temperature Range

35 Internal Measurement Thermistor #8: 
Disconnected

70 System Controller Power Status Error
71 Branch Board Power Status Error 
98 Robot Internal Pressure Monitor 

Warning: Constant Monitoring
99 Robot Internal Pressure Difference 

Monitor Warning: Constant Monitoring
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Error Code Cause Recovery Method
150 Back Sonar Anomaly: Measured 

Value Exceeds Threshold Value 
(Disconnection) 

	y Click [Error Clear].
	y Refer to the cause column to 
determine the cause.
	y Try again.
	y If it reoccurs, turn the power off and 
then on again in a non-hazardous 
area.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

251 EEPROM Error (Parameter Storage) 
253 Controller Area Network Communication 

Error MAIN 

	■ Main track errors (incident class: Main)

Error Code Cause Recovery Method
91 Right Main Track Servo Warning 

(Warning_bit = ON)
	y The operation will continue with the 
warning.

94 Left Main Track Servo Warning 
(Warning_bit = ON)

	y Click [Error Clear].
	y Check the appearance of the main 
tracks for any anomalies.
	y Teleoperate with the gamepad.
	y If it reoccurs, turn the power off and 
then on again in a non-hazardous 
area.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

160 Right Main Track Motor Temperature 
(Disconnection/Temperature Anomaly)

161 Left Main Track Motor Temperature 
(Disconnection/Temperature Anomaly)

221 Right Main Track Servo Error 
224 Left Main Track Servo Error 
231 Right Main Track communication error 
234 Left Main Track communication error 
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	■ Sub track errors (incident class: Sub)

Error Code Cause Recovery Method
90 Right Front Sub Track Servo Warning 

(Warning_bit = ON)
	y The operation will continue with the 
warning.

92 Right Rear Sub Track Servo Warning 
(Warning_bit = ON)

93 Left Front Sub Track Servo Warning 
(Warning_bit = ON)

95 Left Rear Sub Track Servo Warning 
(Warning_bit = ON)

170 The difference from the potentiometer 
input value of the right front servo is 
abnormal.

	y Click [Error Clear].
	y Check the appearance of the sub track 
for any anomalies.
	y Teleoperate with the gamepad.
	y If it reoccurs, turn the power off and 
then on again in a non-hazardous 
area.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

172 The difference from the potentiometer 
input value of the right rear servo is 
abnormal.

173 The difference from the potentiometer 
input value of the left front servo is 
abnormal.

175 The difference from the potentiometer 
input value of the left rear servo is 
abnormal.

220 Right Front Sub Track Servo Error
222 Right Rear Sub Track Servo Error 
223 Left Front Sub Track Servo Error 
225 Left Rear Sub Track Servo Error
230 Right Front Sub Track communication 

error
232 Right Rear Sub Track communication 

error 
233 Left Front Sub Track communication 

error 
235 Left Rear Sub Track communication error

	■ IMU errors (incident class: IMU)

Error Code Cause Recovery Method
50 IMU RS232C communication error 	y The operation will continue with the 

warning.51 IMU Device error
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	■ Charging device errors (incident class: Charge)

Error Code Cause Recovery Method
80 Power reception unit: RS-485 

communication error
	y The operation will continue with the 
warning.

83 Power reception unit: Heatsink 100°C or 
higher (Error: 7)

84 Receive Unit, Over-Voltage (Error: 14)
85 Receive Unit, Over-Current (Error: 1)
86 Receive Unit, IrDA I/F Communication 

Error (Error: 12)
87 Receive Unit, Power Transmission Side 

Error (Error: 15)
89 Power reception unit: Current Error 

(error: 16)
181 Power reception unit: Non-volatile 

memory operation (Error: 31)
	y Click [Error Clear].
	y Check the appearance of the power 
reception unit for any abnormalities.
	y Re-enter.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

182 Power reception unit: Current Detection 
Circuit Error (Error: 6) 

188 Power reception unit: Charging Voltage 
5V or Less (Error: 18) 

245 Battery voltage: Out of Threshold Range 
Error 

	y Click [Error Clear].
	y If it reoccurs, turn the power off and 
then on again in a non-hazardous 
area.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

246 Battery current: Out of Threshold Range 
Error 

	■ Gas detector errors (incident class: Gas) 

Error Code Cause Recovery Method
60 Gas Detection Sensor: Communication 

Timeout (cycle: 7.5s)
	y The operation will continue with the 
warning.

61 Gas Detection Sensor: Overrange
62 Gas Detection Sensor, Sensor Error
63 Gas Detection Sensor: Main Unit Error 

Occurred (Error: 77)
64 Gas Detection Sensor: Sensor Anomaly 

(Error: 99)
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	■ Manipulator controller errors (incident class: Mani)

Error Code Cause Recovery Method
2 Mismatch between format and command 	y The operation will continue with the 

warning. 3 Command received cannot be handled in 
current mode

4 Invalid Command
8 S1 axis overspeed
9 S2 axis overspeed
10 E1 axis overspeed
11 E2 axis overspeed
12 W1 axis overspeed
13 W2 axis overspeed
15 Tip position overspeed
16 Tip attitude overspeed
17 S1 axis target over angle
18 S2 axis target over angle
19 E1 axis target over angle
20 E2 axis target over angle
21 W1 axis target over angle
22 W2 axis target over angle
36 The target value is in an uncontrollable 

zone (insufficient arm length)
37 Specified parameter value exceeds 

specifiable range
66 Socket generation failed
67 Socket and address binding failed
68 Listening failed
69 Acceptance failed
70 Socket transmission failed
72 Too many clients are connected
73 Parameter operating speed exceeds 

speed limit
74 Thermistor temperature warning
102 S1 axis over angle 	y Click [Error Clear].

	y Move the manipulator in the stowage 
direction by teleoperating each axis.

103 S2 axis over angle
104 E1 axis over angle
105 E2 axis over angle
106 W1 axis over angle
107 W2 axis over angle
109 Cannot enter RMRC control at the 

current position
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Error Code Cause Recovery Method
110 Automatically stopped when monitoring 

time exceeded
	y Click [Error Clear].
	y Enter and exit the Charging Station. 
The manipulator will be reset.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

111 Target value not reached
112 S1 axis synchronization error in each 

axis control
113 S2 axis synchronization error in each 

axis control
114 E1 axis synchronization error in each 

axis control
115 E2 axis synchronization error in each 

axis control
116 W1 axis synchronization error in each 

axis control
117 W2 axis synchronization error in each 

axis control
119 X-axis synchronization error in RMRC 

control
120 Y-axis synchronization error in RMRC 

control
121 Z-axis synchronization error in RMRC 

control
123 Abnormal fingertip attitude deviation in 

RMRC control 
125 Operation cannot be started or continued 

at the arm singular point
	y Click [Error Clear].
	y Move the manipulator in the stowage 
direction by teleoperating each axis.126 Operation cannot be started or continued 

at the arm singular point
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Error Code Cause Recovery Method
127 Motor 1 axis: Potentiometer Error 

(absolute angle detection error)
	y Click [Error Clear].
	y Enter and exit the Charging Station. 
The manipulator will be reset.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

128 Motor 2 axis: Potentiometer Error 
(absolute angle detection error)

129 Motor 3 axis: Potentiometer Error 
(absolute angle detection error)

130 Motor 4 axis: Potentiometer Error 
(absolute angle detection error)

131 Motor 5 axis: Potentiometer Error 
(absolute angle detection error)

132 Motor 6 axis: Potentiometer Error 
(absolute angle detection error)

133 Motor 7 axis: Potentiometer Error 
(absolute angle detection error)

134 Motor 8 axis: Potentiometer Error 
(absolute angle detection error)

144 Controller status error
145 T1 axis status error
146 T2 axis status error
147 T3 axis status error
148 T4 axis status error
149 T5 axis status error
150 T6 axis status error
151 T7 axis status error
152 T8 axis status error
155 Origin setting error
156 Control mode change error
157 Command transmission error
158 Set the origin
159 Power ON error
160 Power OFF error
161 Data reception error
201 Control not started: Uncontrolled state 

due to STO disconnection
202 Emergency stop button pressed = STO 

cutoff state 
	y ASCENT’s Emergency Stop button 
(black button) was pressed. Click 
[Error Clear].
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Error Code Cause Recovery Method
222 T1 axis communication error 	y Click [Error Clear].

	y Enter and exit the Charging Station. 
The manipulator will be reset.
	y If it recurs, write down the error 
number and contact the maintenance 
company.

223 T2 axis communication error
224 T3 axis communication error
225 T4 axis communication error 
226 T5 axis communication error 
227 T6 axis communication error 
228 T7 axis communication error
229 T8 axis communication error
230 Mode management error
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16.1 Cloud Screen Transition Diagram

Login Plants Plant Registration

Targets

Alerts Alert Conditions

Robots Dashboard

Schedule List Schedule Registration

Scenario List

Inspection Summaries Inspection Summary

Inspection History

Contract Information

User Management* User Registration

Teleop Terminals*

Charge Stations*

Settings

* Only administrator users can view
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